
 

 

SiteManager for Field Documentation 

Student Guide 

Release 3.6a 

February 2011 

 

Instructor Edition



 

 

SiteManager for Field Documentation 

Student Guide 

Release 3.6a 

February 2011 

 

Instructor Edition



 
 

 

AASHTO Trns•port, the AASHTO Trns•port logo, the AASHTOWare logo, BAMS/DSS, the Trns•port BAMS/DSS 
logo, CAS, the CAS logo, CES, the CES logo, Trns•port CRLMS, the Trns•port CRLMS logo, Trns•port Estimator, the 
Trns•port Estimator logo, Trns•port Expedite, the Trns•port Expedite logo, Trns•port FieldBook, the Trns•port 
FieldBook logo, Trns•port FieldBuilder, the Trns•port FieldBuilder logo, Trns•port FieldManager, the Trns•port 
FieldManager logo, Trns•port FieldPad, the Trns•port FieldPad logo, LAS, the Trns•port LAS logo, PES, the Trns•port 
PES logo, Trns•port Preconstruction, SiteManager, Trns•port SiteManager, the Trns•port SiteManager logo, Trns•port 
SitePad, the Trns•port SitePad logo, Trns•port SiteXchange, and the Trns•port SiteXchange logo are registered 
trademarks of AASHTO.  

Trns•port BAMS/DSS, Trns•port CAS, Trns•port CES, Trns•port Construction, Trns•port Estimation, Trns•port LAS, 
Trns•port Materials, Trns•port PES, Trns•port Preconstruction logo, Trns•port TRACER, the Trns•port TRACER logo, 
and web Trns•port are trademarks of AASHTO.  

AASHTO Trns•port, Trns•port BAMS/DSS, Trns•port CAS, Trns•port CES, Trns•port CRLMS, Trns•port Expedite, 
Trns•port LAS, Trns•port PES, Trns•port Preconstruction, and Trns•port SiteManager represent one or more proprietary 
products of AASHTO.  

AASHTOWare is a registered service mark and trademark of AASHTO. Other product and company names mentioned 
herein may be trademarks and/or service marks of their respective owners.  

© Copyright 2010 by the American Association of State Highway and Transportation Officials, Inc. All rights reserved. 
This document or parts thereof may not be reproduced in any form without written permission of the publisher. Printed 
in the United States of America. 
 

 

 



 Trns•port SiteManager® Learning Guide 
Objectives SiteManager for Field Documentation 

 

 

 iii 

Objectives 

In this course, you will learn the following: 

• Start and Exit SiteManager 

• Navigate in SiteManager 

• Open and control the display of multiple SiteManager 

components 

• Close SiteManager components 

• Change your password 

• Identify update and inquiry display 

• Use Open, New, and ‘Choose Keys’ 

• Use, Sort, Find, and Filter 

• View System Attachments 

• Identify Support Resources 

• Use Online Help 

• View the User Manual 

• Access Reports 

• Run a Process 

• Access TDOT Custom Reports 

• View an Active Contract 

• View Contract Milestones 

• View Contract Projects 

• View Contract Items 
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• View Contract Funding 

• View Stockpile Material Details 

• View Subcontracts 

• Download Data from the Server 

• Understand the Pipeline Process in SiteManager 

• Understand the Basic Concepts of Daily Work Reports 

• Enter Basic Daily Work Report Information  

• Enter Contractor Activity 

• Enter Contractor Equipment Activity 

• Enter Daily Staff Activity 

• Select and Record Work Items 

• Record Work on a DWR Template 

• Copy a Daily Work Report 

• Modify a Daily Work Report  

• Upload Data to the Server 

• View Pipeline Information 

• Create a new Diary 

• Preview a Daily Work Report 

• Authorize a Daily Work Report 

• Create a Charge Day 
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• View the Unauthorized DWR Report 

• View the Installed Work Report 

• Unauthorize and Correct a DWR Work Item Entry 

• View the History of Daily Work Reports 

• View the Installed Work Items Report 

• View the Item Quantity Report 

• View the Estimate Summary  

• View Estimate Discrepancies 

• View the Estimate Item Detail 

• View the Estimate Item Paybook 

• Generate the Summary To Contractor Report 

• Record the Actual Date of a Checklist Event 

• View a Key Date 

• Correct Quantities for Approved Progress Estimates 

• View QTY ADJ DWRs 

• Understand the rules and life cycle of Change Orders 

• View the Item Summary Window 

• Track Change Orders 

• View the Change Order Report 
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Learning Module 

 Section 1  Getting Started 
 for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Start and Exit SiteManager 

• Navigate in SiteManager 

• Open and control the display of multiple SiteManager 

components 

• Close SiteManager components 

• Change your password 

• Identify update and inquiry display 

• Use Open, New, and ‘Choose Keys’ 

• Use, Sort, Find, and Filter 

• View System Attachments 

• Identify Support Resources 

• Use Online Help 

• View the User Manual 

• Access Reports 

• Run a Process 

• Access TDOT Custom Reports 
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Using the Student Guide 

The student guides are divided into sections — learning modules. Each learning 
module consists of: 

• Objectives 

• Multiple Topics and Instructor-Led Exercises 

• Review 

• Summary Exercise 

Each section will begin with the objectives for the module. The module will be 
divided into topics roughly corresponding to the objectives of the module. Each 
topic will have a short description of the SiteManager function, one or more 
general procedures about how to perform an action in SiteManager, and an 
instructor-led exercise for the topic. Instructor-led exercises are easy to spot on 
each page. Instructor-led exercises are identified by the Bulldozer graphic 
illustrated below and are numbered sequentially. Instructor-led exercises are 
very explicit and detail the specific steps and data to be used in performing the 
action. 

 Exercise 5-2 
Instructor-led Exercises are identified by the Bulldozer graphic. 

Figure 1-1 

Each module will end with a review and a summary exercise. The review will 
summarize the main points and all of the SiteManager functionality covered in 
the module. The review pages may serve as an excellent reference for the 
summary exercise that follows the review. It may also server as a work aid for 
use back at the office. 

The summary exercise gives you the opportunity to practice the skills you 
learned in the learning module. The summary exercise instructions will provide 
you with the data to be used and general instructions. Remember that the module 
review on the pages immediately preceding the summary exercise is composed 
of the general procedures covered in the module. The review will serve as a 
good reference as you perform the summary exercise. 
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SiteManager Procedures, the steps you follow to access a component of 
SiteManager, vary depending on whether you have just entered the system or 
have been in some other component and have already selected a common 
variable. 

For instance, if you enter the application and navigate directly to the Contractor 
Payments component, the Estimate Summary window requires the selection of 
the desired Contract and Estimate. However, if you have been working in the 
Contract Records component, already have a Contact selected, and then navigate 
to the Contractor Payments component, the Estimate Summary window displays 
the Estimates for the Contract previously selected in Contract Records. 

The procedures in this manual describe how to access components of 
SiteManager as if you just entered the application. 

 

In TDOT, there are three Student Guides: 

• SiteManager for Office Documentation 

• SiteManager for Field Documentation 

• SiteManager for Management Personnel 

 

This is a very 
important 
concept. 
Stress it 
throughout 
the class. 
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Starting AASHTO SiteManager 
The AASHTO SiteManager Construction Management System will run on several 
different windows graphical User interfaces. For your operating system, you will 
start AASHTO SiteManager the same way you would any program on your 
computer. 

 
SiteManager Desktop Icon 

Figure 1-2 

 

The SiteManager Logon Dialog Box 

Figure 1-3 

 
The Group Dialog Box 

Figure 1-4 

Note. The only RTF template that TDOT uses is The Summary to Contractor Report, 
which is not needed in Standalone mode; therefore, the Download RTF Template check 
box should never be selected. 

 
 

This box 
only appears 
for Users in 
more than 
one group. 
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 Exercise 1-1 
In the following exercise, you will log on to SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Start button. 
2. Click the All Programs choice. 
3. Click the SiteManager Training choice. 
4. Click the SiteManager choice. SiteManager displays the 

SiteManager Logon dialog box. 
5. In the User ID field, type jj05753. 
6. Press the Tab key. 
7. In the Password field, type pass. 
8. Press Enter. SiteManager opens with the SiteManager Panel displayed. 

Shift-tab if user ID 
not highlighted. 
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Main Panel Folder Tab of SiteManager Panel 

After starting the SiteManager application, the Main Panel tab will display the 
components of the system as icons. The central functionality of SiteManager is 
divided into ten icons: Contract Administration, Daily Work Reports, Pipeline, 
Contractor Payments, Change Orders, Civil Rights, Materials Management, 
Accessories, System Administration, and Manuals. 

 

SiteManager Panel Window’s Main Panel Tab 

Figure 1-5 

 

The SiteManager Status Bar 

The SiteManager Status Bar at the bottom of the SiteManager window indicates 
your mode, connection, database region, logon group and individual ID. 

 
Status Bar 

Figure 1-6 

 

Available 
icons are 
specific to 
your security 
group. 

Everything is tracked by 
ID and Password.  
DON’T SHARE!  

Discuss training program. 
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Navigating in SiteManager Using the Main Panel 

The SiteManager Panel is used to navigate to the components of the 
SiteManager application. The highest level is the Main Panel tab that contains 
the different functional groups, with each group individually represented by an 
icon. Double-clicking the icon of a functional group brings up another folder tab 
consisting of the sub-groups or the actual windows contained within that 
functional group. As icons are selected, the next level’s folder tab appears next 
to the previous level. 

 

Navigating in SiteManager 

Figure 1-7 
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 Exercise 1-2 
In the following exercise, you will browse some of the components of SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

 
1. View the icons on the Main Panel. 
2. On the Main Panel, double-click the Contract Administration icon. 
3. On the Contract Administration panel, double-click the Contract Records 

panel. SiteManager displays the Contract Records panel. 
4. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
5. To go up a level, click the Contract Administration tab. 
6. Double-click the Contractor Management icon. SiteManager displays the 

Contractor Management panel. 
7. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
8. To go up two levels, click the Main Panel tab. 
9. Double-click the Daily Work Reports icon. SiteManager displays the Daily 

Work Reports panel. 
10. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
11. To go up a level, click the Main Panel tab. 
12. Double-click the Pipeline icon. SiteManager displays the Pipeline panel. 
13. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
14. To go up a level, click the Main Panel tab. 
15. Double-click the Contractor Payments icon. SiteManager displays the 

Contractor Payments panel. 
16. On the Contractor Payments panel, double-click the Estimate icon. 

SiteManager displays the Estimate panel. 
17. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
18. To go up a level, click the Main Panel tab. 
19. Double-click the Change Orders icon. SiteManager displays the Change 

Orders panel. 
20. On the Change Orders panel, double-click the Change Order Maintenance 

panel.  

Note some of 
the icons 
contained on 
each panel. 
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21. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
22. To go up a level, click the Main Panel tab. 
23. Double-click the Accessories icon. SiteManager displays the Accessories panel. 
24. Take note of the icons available from the panel. 

Now, let’s browse another panel. 
25. To go up a level, click the Main Panel tab. 
26. Double-click the Manuals icon. SiteManager displays the Manuals panel. 
27. Take note of the icons available from the panel. 

Now, to prepare for the next exercise, let’s navigate to the Contract Records panel. 
28. To go up a level, click the Main Panel tab. 
29. Double-click the Contract Administration icon. 
30. Double-click the Contract Records icon. SiteManager displays the Contract 

Records panel. 
31. In the Contract Records panel, double-click the Contracts icon. SiteManager 

displays the Select Contract window. 
32. In the Contract ID list box, scroll to and double-click CNB022C. SiteManager 

displays the Contracts window. 

TDOT Contract number naming convention: 

CN - required for finance system 

B - letting year  

 2003=B 

 2006=E 

 2007=F 

Example: CNE037=Contract 37 from 2006 letting.  

A, B, C on end is merely for training to create 
“snapshots” of contract in various stages of 
lifecycle. 
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 Exercise 1-3 
In the following exercise, you will identify the components of the toolbar. Place 
the mouse over the button and use the tool tip to identify each component. Then 
you will activate the “show text” option. Write the toolbar component name next 
to the appropriate letter below.  

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

 

The SiteManager Toolbar 

Figure 1-8 

A  H  

B  I  

C  J  

D  K  

E  L  

F  M  

G    

 
1. Place the mouse pointer on the toolbar. 
2. Use the right-click button to click the toolbar.  
3. In the Object menu, click Show Text. 

 

SiteManager Panel 

Close 

Delete

Save

Remarks

Toolbar 

Exit SiteManager 

Help Contents 

New 

Remarks are 
unlimited. 
Use a word 
processor for 
spelling. 

If the 
Remarks icon 
has lines 
across it 
(shown), that 
means there 
are remarks. 

Icons are grey 
when they are 
not available 
to select. 

 

Some buttons 
are available 
from all 
windows; 
others are 
window-
specific. 

Open 

Address

Generic Fields

Attachments
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Controlling the Display of Multiple 
SiteManager Components 

In many instances, you will be working in a 
SiteManager component and need to leave it 
temporarily to open another component. Having 
opened more than one component of SiteManager 
you may then need to control the display. 

 
The File Menu 

Figure 1-9 

Opening Multiple SiteManager Components 

While being in one SiteManager component, you may need to go to another 
component without closing the current one. 

 Exercise 1-4 
In the following exercise, you will open one component, while another component of 
SiteManager is open. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 

Now, let’s open another SiteManager component. 
1. Click the SiteManager Panel button.  
2. Double-click the Projects icon. SiteManager displays the Projects window. 
3. In the Project Number list box, scroll to and double-click 55019-

3220-94. 

Discuss Hot 
Navigation. 
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Using the Window Menu to Control the Display of Multiple 
SiteManager Components 
Having opened more than one SiteManager component, you can now use a variety 
of standard Windows methods to control the display of the components and your 
movement between them.  

CONTROLLING THE WINDOW DISPLAY USING TILE 
Tiling divides the screen into the number of SiteManager components that you 
have active. Typically, tiling is used to display two SiteManager components side 
by side horizontally to compare the entries in each or to return a single component 
to full screen once you have closed the other component. With three components 
of SiteManager active, tiling would give each component only one third of the 
screen. Unless you have a very large display, tiling with more than two 
SiteManager components open may not be very useful. 

The Window Menu 

Figure 1-10 

 
Two SiteManager Components Tiled 

Figure 1-11 

 Exercise 1-5 
In the following exercise, you will tile the two current components of SiteManager. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Window menu. 
2. Click the Tile choice. SiteManager tiles the windows. 
 

Stress to only have 
two components 
open when tiling. 
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CONTROLLING WINDOW DISPLAY USING CASCADE 
Cascading makes the number of SiteManager components that you have active 
an equal size and arrange each component in an overlapping offset window. 
Typically, cascading is used to display more than two open SiteManager 
components offset. When you have a need to navigate between more than two 
open SiteManager components, the Cascade choice may make it easier to move 
between them. 

 

Three SiteManager Components Cascaded 

Figure 1-12 
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 Exercise 1-6 
In the following exercise, you will open another SiteManager component, cascade the 
open components and navigate among the three. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the SiteManager Panel button. 
2. In the Contract Records panel, double-click the Categories icon. 

Now, let’s cascade the windows. 
4. Click the Window menu. 
5. Click the Cascade choice. SiteManager cascades the windows. 

Now, let’s navigate between the cascaded windows. 
6. Click the visible portion of the Projects window. 
7. Click the visible portion of the Contracts window. 
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CONTROLLING WINDOW DISPLAY USING LAYER 

Layering displays the SiteManager component that you have active in the most 
efficient full screen display. Typically, layering is used to give each active 
component a full window for display or to return a single active component to 
full display after you have closed the other components that were tiled or 
cascaded. 

 
The Window Menu with Three SiteManager Components Active 

Figure 1-13 

 Exercise 1-7 
In the following exercise, you will layer the three open components of SiteManager 
and move between them. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. Click the Window menu. 
2. Click the Layer choice. SiteManager layers the windows. 

Now, let’s navigate to another window. 
3. Click the Window menu. 
4. Click the Categories choice. SiteManager displays the Categories window. 

Now, let’s navigate to another window. 
5. Click the Window menu. 
6. Click the Projects choice. SiteManager displays the Project window. 

Notice shows active 
windows allow to 
move back and forth 
between windows. 
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Closing Versus Exiting in SiteManager 
While SiteManager is not document oriented like other common Windows 
applications, the same principle of closing versus exiting still applies. When you 
are in a SiteManager component and you wish to end your work in it, but still 
continue to perform other SiteManager activities, you should close. As with other 
applications, you only exit SiteManager when you are through with your 
activities. 

 
The File Menu 

Figure 1-14 

The SiteManager Toolbar 

Figure 1-15 

 Exercise 1-8 
In the following exercise, you will close a component of SiteManager and then exit 
the application. 

User ID: jj05753 Group: PJSUPS Contract: CNB022C 
1. To close a window, click the Close button. 
2. To exit SiteManager, click the Exit SiteManager button or click the File menu 

followed by the Exit choice. 

 

Demonstrate 
closing and 
opening Main 
Panel. 

2+ ways to 
close/exit contrast 
to MS Word. 
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Changing Your SiteManager Password 
In addition to your network logon identity, SiteManager also has password 
protection. Your SiteManager ID determines what information you have access to 
and whether you can update the data or not. If you have any questions regarding 
your SiteManager security access, contact your SiteManager System 
Administrator. 

 
The Change Password Dialog Box 

Figure 1-16 

 

Electronic Signature Law: Millennium 
Digital Commerce Act of 2000, digital 
technology is legally binding, 6-30-00, 
signed by Clinton.  If a statute, 
regulation, or other rule of law 
requires documentation in original 
form, an electronic record satisfies the 
rule. 
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IMPORTANT TIPS REGARDING YOUR USER ID: 

1. In TDOT, when a User ID is first assigned to a User, the default 
password is PASSWORD (all caps). The User must change the 
password before logging on to SiteManager.  

2. SiteManager User IDs for TDOT Criteria: 

• Seven characters in length.  

• The first two characters will be jj (in lowercase), followed by a 
randomly assigned 5-digit number. 

IMPORTANT TIPS REGARDING YOUR SITEMANAGER PASSWORD 
AND LOGON ATTEMPTS: 

1. It is important that you do not give out your password to anyone. 
SiteManager maintains a record of everything you do in 
SiteManager. These records are the same as your signature. 

2. If you have attempted to log on twice and have failed, close the 
SiteManager Logon window and start again. This will allow you to 
try to log on again without disabling your password. 

3. If you attempt to log on three times and fail, SiteManager will 
disable your password. Contact Regional Support if password is 
disabled. 

4. SiteManager Passwords for TDOT Criteria:  

• Four to eight characters in length 

• Case-sensitive - SiteManager can tell the difference between 
capital and lowercase letters. Type your ID and password 
precisely. 

• 90-day expiration 

• Cannot be the word “password” 

• Cannot contain symbols. 

 

Mention the 
importance of 
establishing an 
unbroken chain of 
custody when in a 
court of law. 

Everything is 
tracked by ID! 
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 Exercise 1-9 
In the following exercise, you will log on to SiteManager using another ID and 
change the password.  

User ID: jj05750 Group: PJSUPS Contract: CNB022C 
1. Double-click the SiteManager Training program icon on your 

desktop. 
2. To select the user ID, hold down the Shift key and press the Tab 

key. 
3. In the User ID field, type jj05750. 
4. To move to the next field, press the Tab key. 
5. In the Password field, type PASSWORD. 
6. Click the Change Password button. SiteManager displays the 

Change Password dialog box. 

Now, let’s change the password. 
7. In the Old Password field, type PASSWORD. 
8. Press the Tab key. 
9. In the New Password field, type pass. 
10. Press the Tab key. 
11. In the Confirm Password field, type pass. 
12. Click OK.  
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Security Overview 
Depending on your SiteManager security privileges, you may have: 

• Update rights to all SiteManager windows and data, 

• Inquiry rights only and be able to access data and print reports, but 
not update information, 

• Update rights on some SiteManager windows, inquiry only on 
other windows, and/or no access to other windows,  

• Update rights on some SiteManager data, inquiry rights on other 
data, and/or no access to other data, 

• Access to SiteManager in only a network mode, or 

• Access to SiteManager in both a standalone and network mode. 
When you have access to the window and the data, the field will appear with a 
white background. When you only have inquiry access, the data will appear but 
the fields will have a gray background. 

 

A SiteManager Window in Inquiry Only Mode 

Figure 1-17 
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Inquiry 

 Exercise 1-10 
In the following exercise, you will access an inquiry only window in server mode as 
well as log into the application in standalone mode to view the difference in security 
options. 

User ID: jj05750 Group: PJSUPS Contract: CNB022C 
1. How many icons are displayed on the Main Panel? ________________ 
2. Double-click the Contract Administration icon. 
3. Double-click the Contract Records icon. 
4. How many icons are displayed on the Contract Records panel? 

_________________________________________________________ 
5. Double-click the Categories icon. 
6. Double-click Contract CNB022C. 
7. Double-click Project Number 55019-3220-94. 
8. Does the screen display in inquiry or update mode?  ________ 
9. Click the Exit SiteManager button. 

Now, let’s log on using a different user ID and see how the access rights for that user 
affect the icons available. 

User ID: jj05753 Group: PJSUPS Mode: Standalone 
10. Double-click the SiteManager Training program icon. 
11. To select the User ID, hold down the Shift key and press the Tab key. 
12. In the User ID field, type jj05753. 
13. In the Connect to drop-down list, click the expand arrow to the right of the 

current selection and click the Training Standalone choice. 
14. In the Password field, type pass. 
15. Click the Logon button. 
16. How many icons are on the Main Panel? _________________________ 
17. On the Main Panel, double-click Contract Administration.  
18. On the Contract Administration panel, double-click the Contract 

Records icon. 
19. How many icons are displayed on the Contract Records panel? _______ 
20. Click the File menu. 
21. Click the Exit choice.  

Have the class note 
the look of inquiry 
mode. 

Five

Connect to: 
Training 
Standalone. 

Tip: Select mode 
in Connect to field 
before entering 
password to avoid 
logging on to 
incorrect mode 
accidentally. 

Seven 

Eight 

Twelve 

Mention that this is 
one of several ways to 
Exit SiteManager.  
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Now, to prepare for the next exercise, let’s log on using a different user ID. 

User ID: jj05754 Group: OSTAFF Mode: Server 
22. Double-click the SiteManager Training program icon. 
23. Hold down the Shift key and press the Tab key. 
24. In the User ID field, type jj05754. 
25. Press the Tab key. 
26. In the Password field, type pass. 
27. Press Enter. 
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Entering a SiteManager Window – Open, New, and 
Choose Keys 

When you have the authority and update rights and first enter a SiteManager 
window, you can: 

• Open for an existing record , or 
• Create a new record for data entry, 
• Choose keys to create a new record. 

In some instances, SiteManager will not even let you into the window without 
choosing the keys first. Choosing the keys identifies the initial values for the 
new or existing record. 

 
 

Opening an Existing Record 

When opening an existing record, it is not necessary to use the Choose Keys 
option. For some windows, a selection list will be automatically displayed to 
allow the User to select the appropriate record. For other windows, the User may 
access records by selecting the Open button and choosing the appropriate record. 

 Exercise 1-11 
In the following exercise, you will access a window and open an existing record that 
needs multiple keys. 

User ID: jj05754 Group: OSTAFF Contract: CNB022H 
1. On the Main Panel tab, double-click the Daily Work Reports icon. 
2. On the Daily Work Reports tab, double-click the Daily Work 

Reports icon. 
3. What security mode are we in (inquiry or update)? ______________ 
4. What Contract ID is displayed? _____________________________ 
5. On the toolbar, click the Open button. 
6. In the Contract list box, scroll to and double-click contract ID 

CNB022H. 
7. In the Inspector list box, scroll to and double-click user ID jj05751. 
8. In the Date list box, scroll to and double-click DWR date 04/20/05. 
9. When informed that the DWR will be opened in read-only format, 

click the OK button. 
10. When you want to open an existing record, do you use Open, New, 

or Choose Keys? _________________________________________ 

We are teaching 
instincts about using 
SiteManager. 

DWRs are read only 
when you are not the 
creator and or 
Authorized or 
Locked. 

Discuss hot navigation. 

Update 

None 

Note Authorized and 
Locked 

Open 
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Creating a New Record 

When creating a new record, the User will navigate to the appropriate window. 
For some windows, the window will open in New mode. For other windows, the 
User may create a new record by selecting the New button. 

 Exercise 1-12 
In the following exercise, you will access a window and identify the new record 
mode. 

User ID: jj05754 Group: OSTAFF Contract: CNB022H 
1. On the toolbar, click the New button. 
2. Note that you are ready to create a record for Contract CNB022H. 
3. What is the Inspector’s Name? ____________________________ 
4. What is the DWR date? __________________________________ 
5. What is the Contract? ____________________________________ 
6. When you want to create a new record, do you use Open, New, or 

Choose Keys? __________________________________________ 

Smith, Pat 

00/00/00 

CNB022H, same as the one you opened. 

New 
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Choosing Keys 

The Choose Keys choice displays a list of key field(s) to be selected. In many 
instances in SiteManager, the Choose Keys choice must be selected before a 
new record can be created. 

 
Choosing Keys 

Figure 1-18 

 

 Exercise 1-13 
In the following exercise, you will access a window that requires keys to be chosen 
and identify the new record mode. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 
1. Click the Services menu. 
2. Click the Choose Keys choice. SiteManager displays the Contract 

ID window. 
3. In the Contract ID list box, scroll to and click the CNB022C choice. 
4. Click the OK button. 
5. Note that you are ready to create a record for Contract CNB022C. 
6. When you want to create a new record for a DIFFERENT Contract, 

do you use Open, New, or Choose Keys? ______________________ 
7. Click the Close button. 
8. Click the No button when prompted to save changes. 
9. Click the Main Panel folder tab. 
 

Having chosen the 
correct key, only 
now are you ready to 
create a new DWR 
for a contract. 

New, then Choose Keys 

Key =Contract ID
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Using the Object Menu for Data Manipulation and 
Retrieval 
To make data entry and retrieval easier, SiteManager provides a Search, Filter, 
Find, and Sort capability throughout the application. The Filter and Find 
functions also provide Users with the ability to limit the data retrieved from the 
SiteManager database by specifying criteria using relational operators. The Clear 
button removes the current data retrieval choice in effect. The Show Filter/Sort 
choice shows the current criteria in effect for these choices. 

To invoke the Object menu, using the right mouse button, click in a field. 

 
The Object Menu 

Figure 1-19 

 

Criteria Window Buttons: 

Insert:  Inserts a blank row before the currently selected row.   

Add:  Inserts a blank row after the last row. 

Remove:  Deletes the selected row.  Remove deletes only one row at a 
time. 

Clear: Deletes all rows.  All rows must be deleted to return to the 
complete, unfiltered list. 

Load: Opens saved filter list.  Saved filter allows for loading and 
deleting of saved (and default) filters. 

Save: Opens filter name window to allow filter to be saved.  The 
Default check box allows a filter to be automatically applied every time 
the window is accessed. 

Stress important 
distinction 
between Remove 
and Clear.  
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Criteria Window Conditions: 

Using the Equal (=) condition: 

• Requires the specified value to be exact.  

• Only matching whole words will be included 

• Only matching capitalization will be included 

Using the Like condition: 

• Allows specified value to be imprecise 

• Wildcard % allowed – A wildcard is a value that matches any value 
– like the wild card when playing Uno. 

• SiteManager assumes value% when the Like condition is selected, 
including all data that start with the entered value 

• %value% allows partial data matches to be included  

• Only matching capitalization will be included 

When creating multiple conditions, AND joins will be executed before OR 
joins. 

INSTRUCTOR NOTE: 

Filters that are not saved remain active until the user exits 
SiteManager. 

Filters that are saved as Default filters remain for the user ID on the 
computer until they are removed.  To remove a default filter: 

1. Right click a row 

2. Select the Filter choice 

3. Click the Load button 

4. Select the default filter 

5. Click the Delete button. 
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Sorting 

When the window displays as a list, the Sort feature allows you to sort the list, 
based on specified criteria. Each time the window displays, the default sort 
criterion is automatically applied. As with the Filter function, only one default 
sort criterion can be in effect for a window at any given time. 

 
The Sort Window 

Figure 1-20 
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 Exercise 1-14 
In the following exercise, you will sort the Work Items records for a DWR for 
Contract CNB022E. 

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. In the Main Panel, double-click the Daily Work Reports icon. 
2. In the Daily Work Reports panel, double-click the Daily Work 

Reports icon.  
3. In the Daily Work Reports window, click the Open button on the 

toolbar. 
4. Click the No button in the Save Message. 
5. In the Contract ID list box, scroll to and double-click CNB022E. 
6. In the Inspector ID list box, scroll to and double-click jj05752, 

Sandy Gutierrez. 
7. In the DWR Date list box, scroll to and double-click 04/04/05. 
8. Click the OK button to the Read Only message. 
9. Click the Work Items folder tab. 

Now, let’s use the column headings to sort the Work Item list. 
10. Click the Description column heading. 
11. Click the Item Code column heading. 
12. Click the Instld column heading. 
13. Scroll to the bottom of the list to see the items that were reported 

installed on this DWR. 

Now, let’s use the Object Menu to sort. 
14. Position the pointer over the first record. 
15. Use the right-click button click the record.  
16. In the Object menu, click Sort. 
17. In the Sort Criteria window, click the Add button.  
18. In the Field drop-down list, click ProjectNumber 
19. Click the Add button, again. 
20. In the Field drop-down list, click Item Code. 
21. Click the OK button. 
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Finding 

When a window displays as a scrollable list, the Find choice allows the User to 
get to a specific row by selecting the appropriate value to find. 

 
The Find Criteria Window 

Figure 1-21 
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 Exercise 1-15 
In the following exercise, you will locate an item using the Find option.  

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. Position the selection pointer over the first record in the list at the top 

of the window. 
2. Using the right mouse button, click the record. 
3. From the object menu, click the Find choice. SiteManager displays the 

Find Criteria window. 
4. On the Find Criteria window, click the Add button. 
5. In the Field drop-down list, click Item Code. 
6. In the Condition drop-down list, click =. 
7. In the Value field, type 712-06. 
8. Click the Add button. 
9. In the Field drop-down list, click ProjectNumber. 
10. In the Condition drop-down list, click =. 
11. In the Value field, type 55019-3220-94.  
12. Click the Find button.  

AND for 
different fields, 

OR for same 
field. 
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Filtering 

The Filter choice allows you to specify filtering criteria for SiteManager fields 
and their limiting values using relational operators. Each time a window 
displays, the filtering criteria, marked as default, is automatically applied, 
thereby limiting the amount of data retrieved. Only one default filter criterion 
can be in effect for a window at any given time. 

 
The Filter Criteria Window 

Figure 1-22 

“Like” will find 
the word LIME 
as a part of any 
phrase. 

Capitalization 
counts. 

If you move the 
mouse while 
right clicking, 
you will default 
to the Find 
window. 

% = wild card 
only available 
with ‘like.’ 
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 Exercise 1-16 
In the following exercise, you will learn how to filter to display only the records 
meeting your condition.  

User ID: jj05754 Group: OSTAFF Contract: CNB022E 

Now, let’s filter the contents of this list. 
1. Position the selection pointer over a record in the list at the top of the 

window.  
2. Using the right mouse button, click the record. 
3. From the object menu, click the Filter choice. SiteManager displays 

the Filter Criteria window. 
4. Click No to the Save Changes prompt. 
5. In the Filter Criteria window, click the Add button. 
6. In the Field drop-down list, click Description. 
7. In the Condition drop-down list, click Like. 
8. In the Value field, type %CONCRETE%. 
9. Click the OK button. 
10. When informed that the specified filter will return a number of rows, 

click the Ok button.  The Work Items window displays the filtered 
results. 

% characters 
are variables.  

This step may not 
be necessary. 
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Clearing the Current Criteria 

Remember that the current data retrieval choice will stay in effect until cleared. 
The Clear button removes the current data retrieval choice in effect by deleting 
all of the rows of criteria, which returns unfiltered results. 

 Exercise 1-17 
In the following exercise, you will clear the current filter. 

User ID: jj05754 Group: OSTAFF Contract: CNB022E 
1. Position the selection pointer over a record. 
2. Using the right mouse button, click the record. 
3. From the object menu, click the Filter choice. SiteManager displays 

the Filter Criteria window. 
4. In the Filter Criteria window, click the Clear button. 
5. Click the OK button. SiteManager displays a message. 
6. When informed that the specified filter will return a number of rows, 

click the OK button. The Work Items window displays all of the 
rows without filtering the results. 

7. Click Yes to the Filter Message. 
8. Click the Close button on the toolbar. 
9. Click the Main Panel folder tab. 

Always. 
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System Attachments 
The System Attachments window allows URL links, Plug-In applications, and OLE 
attachments to be attached the SiteManager system without being attached to 
specific records.  Plug in and OLE attachments are detailed in other sections of this 
training manual. 

 

The System Attachments Window  

Figure 1-23 

 
The CMS File Management System Attachment 

Figure 1-24 

 

 
In TDOT, URL links are included as System Attachments. 

The CMS Contract File Management attachment will open the File 
Management system.  The URL this attachment opens is as follows.  

\\jj00wf080\cms\ 

These are 
internet 
websites – you  
may need to 
connect to the 
internet to 
access them. 
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 Exercise 1-18 
In the following exercise, you will view System Attachments. 

User ID: jj05754 Group: OSTAFF 
1. On the Main Panel, double-click the Accessories icon.  
2. Double-click the System Attachments icon.  
3. In the System Attachments list box, scroll to and click CMS 

Contract File Management. 
 

The System Attachments are not set up for the training environment.   
 
4. Click the Close button.  
5. Click the Main Panel folder tab. 
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Support Resources 

The following Support Resources have been developed for AASHTO 
SiteManager. Contact your SiteManager System Administrator to verify your 
Transportation agency policies regarding the availability and distribution of this 
material. 

• User Manual (.pdf) 
• SiteManager On-line Help 
• Learning Guides 
• Training Database 
 

TDOT SiteManager Support Personnel 

Location Name Email Phone 

Region 1 Matt Douglas G.Matthew.Douglas@tn.gov (423) 907-7512 

Region 2 Gail Hollis Gail.Hollis@tn.gov (423) 949-9202 

Region 3 Gwen Ward Gwen.Ward@tn.gov (931) 684-0797 

Region 4 Dan Robinson Dan.Robinson@tn.gov (731) 935-0220 

HQ Chris Hampton Chris.Hampton@tn.gov (615) 741-3542 

 

In TDOT, electronic documentation and on-line training material can be 
obtained from Support Personnel or downloaded from 
www.tdot.state.tn.us/construction/SiteManager.htm. 

 

Printed 
Documentation  
and additional on-
line training 
material can be 
obtained from 
SiteManager 
Support 
Personnel as 
needed. 
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Using Help 

The Help menu will contain standard Help choices — Contents, Search for Help 
on, and Glossary and, when accessed while a window is open, will also provide 
one non-standard choice, Current Window. Help in SiteManager will work like 
any other Windows Help. 

Using Help by Contents 

The Help menu’s Contents choice or the Help button 
displays an alphabetized list of Help Topics that can 
be browsed for the subject on which you need help. 

 
Help Contents 

Figure 1-25 

 
Help Button 

Figure 1-26 
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 Exercise 1-19 
In the following exercise, you will access Help from the Help menu. 

User ID: jj05754 Group: OSTAFF  
1. On the Main Panel, click the Help menu. 
2. Click the Contents choice. SiteManager displays the AASHTO 

SiteManager Help window. 
3. On the Contents page, scroll to the Contracts Panel section and 

click the Contracts Description Folder Tab topic. 
4. Click the Status-Contract Description tab link. Help displays a 

pop-up window. 

Now, let’s exit online Help. 
5. To close the Help window, click the File menu and click the Exit 

choice. 
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Using Help by Searching 

The Search for Help on choice displays a lengthy, alphabetized list of Help 
Topics that can be browsed or searched for the subject on which you need help. 

 
The Help Search 

Figure 1-27 

 Exercise 1-20 
In the following exercise, you will search for a topic.  

User ID: jj05754 Group: OSTAFF 
1. Click the Help menu and click the Search for Help on choice.  
2. Click the Search button.  
3. Type stockpiled materials. 
4. Click the Stockpiled Materials Panel topic. 
5. Click the Display button. Help displays the requested topic. 
6. To close the help window, click the File menu and click the Exit choice. 

Search opens 
correctly in 
production. 
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Using the Current Window Help 

With any SiteManager window active, the Help menu’s Current Window choice 
will access context sensitive help that includes Help on fields. 

 
The Help on a SiteManager Window 

Figure 1-28 
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 Exercise 1-21 
In the following exercise, you will access Help on the current window. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 
1. On the Main Panel, double-click the Contract Administration 

icon. 
2. On the Contract Administration panel, double-click the Contract 

Records icon. 
3. On the Contract Records panel, double-click the Contracts icon.  

Now, let’s open another contract. 
4. Click the Open button. 
5. In the Contracts list box, scroll to and double-click Contract 

CNB022C. 
6. Click the Help menu and click the Current Window choice 
7. Click the Next Page (>>) button (right arrow at the bottom center of 

window). 
8. In the Contract Description tab Field Names and Descriptions 

section, click Contract ID – Contract Description tab. Help 
displays a pop-up window. 

Now, let’s exit online Help. 
9. Click the File menu and click the Exit choice. 

Now, let’s prepare for the next exercise. 
10. To close the Contracts window, click the Close button. 
11. Click the Main Panel folder tab. 

SM help is not 
TDOT specific. 

Read it or print 
it out. 

Ask – why did 
CNB022E open? 

Hot navigation 
since open ‘E’ 
DWR. 
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Viewing the User Manual 

The SiteManager User Reference Manual is a reference document for users of 
the AASHTO SiteManager application.  The user should refer to this manual 
only when a question cannot be answered by referring to the SiteManager online 
help system.  This manual describes all of the SiteManager components, 
including their purpose, functions, and how to use them. 

 
The User Reference Manual in PDF 

Figure 1-29 
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 Exercise 1-22 
In the following exercise, you will access the on-line User Reference Manual.  

User ID: jj05754 Group: OSTAFF  
1. On the Main Panel, double-click the Manuals icon. 
2. Double-click the User Manual icon. 
3. Click the Next Page button. (At the bottom, this looks like a triangle.) 
4. Click the page number field at the bottom of the screen. 
5. Type 25. 
6. Press Enter.  

Now, let’s search the reference manual. 
7. Click the Search button.  (In the toolbar, this looks like binoculars.) 
8. In the Search for field, type Temperature. 
9. Click the Search button. 
10. Click the first result. 
11. Click additional results to browse the topic. 

Now, let’s exit the application. 
12. Click the File menu. 
13. Click the Exit choice. 

Now, let’s prepare for the next exercise. 
14. Click the Main Panel folder tab. 

First result 
links to 
page 386.
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Standard SiteManager Reports 

Below is a list of the standard SiteManager Reports and the SiteManager panels 
they may be selected from. 

Contract Administration: 

• Contract Status  

• Item Quantity 

• Item Work Report 

• Subcontract Value 

• Contractor Current Status 

• Past History – Work Completion 

Contractor Payments:  

• Summary To Contractor  

• Installed Work 

• Work Suspend/Resume Times 

Change Orders:  

• Change Order Report 

• Unapproved Change Order Aging Report 

• Time Extension Granted  

• Change Order/Reason Code Breakdown 

 

TDOT has created several custom reports in Crystal Reports. The custom reports are run from a 
separate application accessed through the intranet. 

http://boe.tdot.state.tn.us/businessobjects/Enterprise115/InfoView/  

                                                      

  This is run from the Process List window. 
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General Reporting Concepts 
Most reports follow these procedures. The user initiates the report from the 
correct report window.  

 

The Installed Work Report 

Figure 1-30 

To view and print a displayed report: 
1. To view, click the Next Page or Prior Page icons. 
2. Click the Zoom button to reduce the Zoom. 
3. To print, click the Copies button, setting the desired number of 

copies to print. 
4. Click the File menu and click the Print choice. 

To Export a report: 
1. Run the report (saved reports may not be exported) 
2. Click the Services menu Export choice. 
3. In the File Name field, type the file name. 
4. In the Save as type drop-down list, select the type of file: Text, 

Excel, or Lotus 1-2-3. 
5. Click the Save button. 

A Report can be saved for later retrieval. SiteManager saves the report using a 
.PSR extension.  To save a report: 

1. On the toolbar, click the Save button. 
2. In the File Name field, type the name for the file. 
3. Change the drive and directory as desired. 
4. Click the Save button.  
5. In the message box, click the OK button. 
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The View Saved Reports icon can be used to open a saved report. To open a 
saved report: 

1. On the Reports panel, double-click the View Saved Reports (PSR) 
icon. 

2. Change the drive and directory as needed to select the PSR file. 
3. Click the OK button. 

 Exercise 1-23 
In the following exercise, you will access a standard report and save a copy of the 
report.  

User ID: jj05754 Group: OSTAFF Contract: CNB022K 
1. On the Main Panel, double-click the Contractor Payments icon. 
2. On the Contractor Payments panel, double-click the Reports icon. 
3. On the Reports panel, double-click the Installed Work icon. 

SiteManager displays the Report Criteria window. 
4. In the list box, scroll to and double-click the CNB022K choice. 
5. Review the Report.  

Now, let’s save the report to your computer. 
6. Click the Save button. 
7. In the C:\SMTRAINS directory, double-click the SMFILES folder. 
8. Type INWK_CNB022K20061025. 
9. Click the Save button. SiteManager displays a dialog box to inform 

you about exporting the file. 
10. In the dialog box, click the OK button. 
11. To close the Installed Work window, click the Close button. 

Now, let’s view the report you saved to your computer. 
12. On the Reports panel, double-click the View Saved Reports (PSR) 

icon. 
13. Double-click the INWK_CNB022K20061025.PSR file. 

SiteManager displays the View Saved Reports (PSR) window. 

Now, let’s prepare for the next exercise. 
14. Click the Close button. 
15. Click the Contractor Payments tab. 

This example 
demonstrates how 
users could save a 
copy of a SM 
standard report 
that updates in 
real time. If 
addressing a 
question, saving 
the report will 
provide the User 
with a reference 
of the data.

Do not click the 
Generate Off-line 
file or Generate 
Off-line Print 
check boxes.
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Running a Process 
The Process List window in the Contractor Payments panel includes the 
Summary to Contractor Report.  This is the only SiteManager Process that TDOT 
users will need to run. 

A process is run from the Process List window by clicking on the named process, 
and choosing Run Process from the Services menu, or by clicking the named 
process and clicking the Run Process button or by double-clicking the process. 

 

The Contractor Payments Process List window 

Figure 1-31 
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 Exercise 1-24 
In the following exercise, you will run a process. 

User ID: jj05754 Group: OSTAFF Contract: CNB022P 
1. On the Contractor Payments panel, double-click the Process List 

icon. 
2. In the Process List, double-click the Summary to Contractor 

report. SiteManager displays the Confirm Process Submission 
window. 

3. Click the Parameters button. SiteManager displays the Process 
Submission Parameters window. 

4. On the Process Submission Parameters window, click the Generate 
Online check box (ON). A warning will appear, noting that the latest 
RTF objects were not downloaded from the Object Store. 

5. On the warning message, click OK. 
6. On the Process Submission Parameters window, click OK. 

SiteManager closes the window. 
 

STOP. Do not submit the process in SiteManager Training.  
 
7. Click the Cancel Button 
8. Click the Close Button. 

 
A copy of the report is saved at C:\SMTRAINS\SMFILES to view during training.  
 
9. Right-click the Start button at the bottom left of the screen. 
10. Click the Explore choice. 
11. Navigate to the C:\SMTRAINS\SMFILES folder. 
12. Double-click Estimate Summary to Contractor CNB022P.htm. 
13. After viewing report, click the Close button to close the browser window. 
14. Click the Exit button to exit SiteManager. 

This tells SM to 
run on this 
machine rather 
than the Server.  
When this option 
is selected, the 
data is up to date 
as of the last Basic 
Contract Data 
download. 

The steps to 
run a process 
in production 
are in the 
Review. 



Trns•port SiteManager® Learning Guide Accessing TDOT Custom Reports 
for Field and Office Documentation SiteManager Overview for TDOT 
 

 

50  

Accessing TDOT Custom Reports 

When accessing the TDOT Custom reports, Office Staff users may pick from 
the available reports. 

 
TDOT Office Staff available reports window - page 1 

Figure 1-32 
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TDOT Office Staff available reports window - page 2 

Figure 1-33 

 

TDOT Custom Reports are accessed through the following web address: 

http://boe.tdot.state.tn.us/businessobjects/Enterprise115/InfoView/ 
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Review for Section 1 
To start SiteManager: 

1. Double-click the SiteManager desktop icon. 
Or 
1. Click the Start button, click the Program 

choice, click the SiteManager choice, and 
click the SiteManager choice.  

2. Type your logon identification name. 
3. Press the Tab key. 
4. Type your password. 
5. If appropriate in the Connect to drop-down 

list, click the expand arrow to the right of 
the current selection and click the desired 
database choice. 

6. Press Enter.  
7. If appropriate, in the Available Group for 

… dialog box, click the group ID. 

To select a main panel component of SiteManager: 

1. Double-click the component’s icon 

To select up or down a level in SiteManager: 

1. Click the level’s folder tab. 

To open more than one component of SiteManager: 

1. Open the first component of SiteManager. 
2. Click the SiteManager Panel button. 

Or 
Click the File menu and click the Main 
Panel choice. 

3. Open the other component of SiteManager. 

To tile: 

1. Open the number of SiteManager 
components that you want to tile. 

2. Click the Window menu. 
3. Click the Tile choice. 

To cascade: 

1. Open the number of SiteManager 
components that you want to cascade. 

2. Click the Window menu and click the 
Cascade choice. 

3. Click the visible portion of the window you 
want to display. 

To layer: 

1. Open the number of SiteManager 
components that you want to layer. 

2. Click the Window menu and click the 
Layer choice. 

To move between multiple layered SiteManager 
components: 

1. Click the Window menu. 
2. Click the name of the SiteManager 

component from the list. 

To close a SiteManager component: 

1. Click the Close button. 
Or 
1. Click the File menu and click the Close 

choice. 

To exit SiteManager: 

1. Click the Exit button. 
Or 
1. Click the File menu and click the Exit 

choice. 

To change your password: 

1. Start SiteManager. 
2. On the logon screen, type your existing 

password. 
3. Click the Change Password button. 
4. Type your old password. 
5. Press the Tab key. 
6. Type your new password. 
7. Press the Tab key. 
8. Type your new password, again. 
9. Click OK. 
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To open an existing record:  

1. Double-click the window’s icon. 
2. Click the Open button. 
3. Scroll to and click the desired record. 
4. Click OK  

To create a new record:  

1. Double-click the window’s icon. 
2. Click the New button. 

To choose keys after you enter a window:  

1. Click the Services menu and click the 
Choose Keys choice. 

2. In the list box, scroll to and double-click 
desired value. 

3. Repeat step 2 until all initial values are 
selected. 

To sort records: 

1. Click the desired sort field at the top of the 
list. 

Or 
1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Sort choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Order drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. To add additional sorts, click the Add 
button. 

8. Repeat steps 4-7 until you have selected all 
sorts. 

9. Click OK.  

To find specific records: 
1. Position the selection pointer over a record.  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Find 

choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Condition drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. In the Value field, select the current entry 
and type the desired value. 

8. To add additional conditions, click the Add 
button. 

9. In the Join drop-down list, click the expand 
arrow to the right of the current selection 
and click the desired choice. 

10. Repeat steps 5-9 until you have selected all 
conditions. 

11. Click OK.  

To filter records: 

1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Filter 

choice. 
4. Click the Add button. 
5. In the Field drop-down list, click the expand 

arrow to the right of the current selection 
and click the desired field. 

6. In the Condition drop-down list, click the 
expand arrow to the right of the current 
selection and click the desired choice. 

7. In the Value field, select the current entry 
and type the desired value. 

8. To add additional conditions, click the Add 
button. 

9. In the Join drop-down list, click the expand 
arrow to the right of the current selection 
and click the desired choice. 

10. Repeat steps 5-9 until you have selected all 
conditions. 

11. Click OK.  
To clear a filter: 

1. Position the selection pointer over a record  
2. Using the right mouse button, click the 

record. 
3. From the object menu, click the Filter 

choice. 
4. Click the Clear button. 
5. Click OK.  
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To view System Attachments: 

1. Double click the Accessories icon. 
2. Double-click the System Attachments icon. 
3. Double-click the attachment you wish to 

run. 

To access Help by Contents: 

1. Click the Help menu and click the Contents 
choice. 
Or 
Click the Help button. 
Or 
In a SiteManager window, press the F1 key. 

2. In the topics list box, scroll to and click the 
desired topic. 

3. When finished, click the File menu and 
click the Exit choice. 

To access Help by searching: 

1. Click the Help menu and click the Search 
for Help on choice.  

2. Type the topic on which you need help. 
3. Click the topic. 
4. Click the Display button.  
5. When finished, click the File menu and 

click the Exit choice. 

To access Help on the current window: 

1. Display the SiteManager window for which 
you need help. 

2. Click the Help menu and click the Current 
Window choice. 

3. When finished, click the File menu and 
click the Exit choice. 

To access Help on a field: 

1. Display the SiteManager window that has 
the field for which you need help. 

2. Click the Help menu and click the Current 
Window choice. 

3. In the field list, scroll to and click the 
desired field. 

4. When finished, click the File menu and 
click the Exit choice. 

To access the User Manual documentation: 

1. On the Main Panel, double-click the 
Manuals icon.  

2. Double-click the User Manual icon. 

To generate any report: 

1. Double-click the desired report icon. 
2. Select the criteria. 
3. Click OK. 

To save a report: 

1. Click the Save button. 
2. Type the name for the file. 
3. Change the drive and directory as desired. 
4. Click Save. 
5. Click OK. 

To open a saved report: 

1. Double-click the View Saved Reports 
(PSR) icon on the Reports Tab. 

2. Change the drive and directory as needed. 
3. Select the PSR file. 
4. Click Open. 

To run a process: 

1. Navigate to the panel where the process is 
assigned. 

2. Double-click the Process List icon. 
3. In the process list, double-click the desired 

process. 
4. Click the Submit button. 

To access TDOT custom reports: 

1. Launch Internet Explorer.  
2. Access web address 

http://boe.tdot.state.tn.us/businessobjects/
Enterprise115/InfoView/  

3. Click the plus sign next to Public Folders.  
4. Click the plus sign next to SiteManager.  
5. Click the desired group name.  
6. Click the desired report name.  
7. Enter the desired prompt values.  
8. Click the OK button.  
9. Print or Save the report as appropriate.  
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Summary Exercise for Section 1 
In the following summary exercise, you will navigate through SiteManager. 

User ID: jj05754 Group: OSTAFF Contract: CNB022C 

1. Log into SiteManager as jj05754. 

2. Navigate to the Items window  
(Main Panel > Contract Administration > Contract Records > Items).  

3. Select the first project for Contract CNB022C, and then any of the available items. 

4. Are you in inquiry or update mode?  
___________________________________________________ 

5. Click the Close button to close the Items window.  

6. Navigate to the Item Master window  
(Main Panel > Contract Administration > Reference Tables > Item Master). 

7. Use the Find feature to find the Item Code 204-06 for Spec Year 2000.  

8. What is the Item Description? _____________________________ 

9. Filter for short description %CLEARING%. 

10. What is the first item retrieved? ____________________________ 

11. Clear the filter. 

12. Click the Close button to close the Item Master window.  

13. Navigate to the Milestones window (Contract Administration > Contract Records > Milestones). 

14. Access Help on the current window. 

15. Click the Close button to close the Milestones window. 

16. Navigate to the User Manual and find the Estimate Generation topic.  

17. Click the Close button to close the User Manual window.  

18. Navigate to the Contractor Payment Reports panel.   
(Main Panel > Contractor Payments > Reports) 

19. In Contractor Payment Reports, run an Installed Work Report for contract CNB022L. 

20. In Contractor Payments, navigate to the Process List. 

21. Exit SiteManager. 

INQUIRY 

BEDDING MATERIAL (PIPE) CLASS A 

201-01 Clearing and Grubbing 

Navigate means to close 
the window you are in 
and go to a different 
window 
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Learning Module 

 Section 2  Contract Administration 
for Field Documentation 

 

By the end of this module, you will be able to: 

• View an Active Contract 

• View Contract Milestones 

• View Contract Projects 

• View Contract Items 

• View Contract Funding 

• View Stockpile Material Details 

• View Subcontracts 
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New Contracts 

This module describes the Contract information available to you through 
SiteManager’s windows and data entry fields. New Contracts are typically loaded 
electronically from the pre-construction system at TDOT, PES and LAS, and 
given pending status by default.  

 

The Contract Records Panel 

Figure 2-1 

To begin tracking the progress of the Contract work in SiteManager, the 
Headquarters Finance Office will change the Contract’s status to active. 
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 Exercise 2-1 
In the following exercise, you will navigate to the Contract window.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Double-click the SiteManager Training program icon. 
2. In the User ID field, type jj05751. 
3. Press the Tab key. 
4. In the Password field, type pass.  
5. Press the Enter key. 
6. Double-click the Contract Administration icon. 
7. Double-click the Contract Records icon. 
8. On the Contract Records panel, double-click the Contracts icon. 
9. In the Contract ID list box, scroll to and double-click CNB022E. 

Shift-tab if user 
ID not 
highlighted. 
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Viewing a Contract 

The Description folder tab Contract of the Contract window displays the basic 
description data. This includes the Contract’s status, project number(s), 
administrative offices, and other descriptive information that determines how the 
system processes data for this Contract.  

Contract Time Charges 

In SiteManager, the three types of Time Charges for Contracts are: 

• Completion Date - Similar to TDOT “Calendar Days” contracts for non-
resurfacing and non-mowing contracts.  In SiteManager, TDOT Mowing, 
Litter Removal, and Sweeping & Drain cleaning contracts are 
Completion Date.    Time cannot be suspended on Completion Date 
Contracts. 

• Calendar Day - TDOT’s Resurfacing Contracts (Completion Date 
contracts with a working window) are Calendar Day in SiteManager, 
with a set number of bid days.  Time is started when the Notice to 
Proceed date is entered.   

• Working Days (Available Days) - TDOT does not use at this time. 

 
The Description Folder Tab 

Figure 2-2 

In TDOT, Spec Yr 
field does NOT 
reference a spec 
book.  This shows 
the items are from 
the 2000 Item 
Master. (2001 Item 
Master is Metric). 

Click the Remarks 
button for additional 
contract description 
information. 

In TDOT, all 
Contracts will 
show Federal in 
the Funding 
section.

All Contracts will 
show as Federal.  
This is NOT a 
true 
representation of 
the funding.  To 
view actual 
funding go to the 
Funding window. 

HQ Finance will 
activate if Fed 
Oversight 
Contract. Local 
Oversight will not 
be used.
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In TDOT, most of the fields on the Contract window are loaded from PES 
and LAS and will not be modified in SiteManager except by the 
Headquarters Construction and Finance Offices. 

TDOT will primarily use the Completion Date Contract Time Charge type. 

 

 Exercise 2-2 
In the following exercise, you will review the description for a new active 
Contract CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. What region and unit is this contract assigned to? 
_______________________________________________________ 

2. How is time calculated on this contract? ____________________________ 
3. What is the dollar value of this contract? ______________________ 

 

Region 4, Unit 042 

Completion Date 

$985.850.80 
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Viewing the Contract Location 

The Location folder tab displays the Contract location. Each Contract must have 
one county selected as the primary county. 

 

The Location Folder Tab 

Figure 2-3 

 Exercise 2-3 
In the following exercise, you will view the location for Contract CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the Location folder tab. 
2. What is the Primary County of Contract CNB022E? _________ McNairy 
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Viewing Contract Payment Data 

The Payment Data folder tab can be used to automatically calculate common 
construction computations. 

 

The Payment Data Folder Tab 

Figure 2-4 

In TDOT, the functions of this window will not be used. 

 Exercise 2-4 
In the following exercise, you will view the payment data for Contract 
CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the Payment Data folder tab. 

TDOT is not 
using Auto 
Liq. Dmg or 
any other 
function of 
this window. 
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Viewing Critical Dates 

The Critical Dates folder tab displays Critical Dates in the life of the contract. 
The Critical Date types were defined during system development and cannot be 
added or deleted. These dates are considered critical because SiteManager 
includes them in the standard Contract reports. When a new Contract is added 
from the pre-construction system, PES and LAS, SiteManager includes the 
Critical Date types defined in the Default Critical Date reference table. A few of 
the dates, such as Letting Date, come over from the pre-construction system.  

When an Actual Date is entered, the system can send notices to an individual 
recipient.  

In SiteManager, the Notice to Proceed Date is important because: 

• It must be entered before any Estimates may be generated 

• It starts charging time against the contract for Fixed Completion Date contracts 

Tip: The Notice to Proceed Date can only be entered when or after the 
Contract status is changed to active. Although the Notice to Proceed date is not 
required for Contract activation, it must be entered before any Estimates may be 
generated. 

 

The Critical Dates Folder Tab 

Figure 2-5 

In the TDOT, the Critical Dates folder tab is updated by the Headquarters 
Construction and Finance Offices. 

In TDOT, the Notice to Proceed is updated by the Headquarters Finance 
Office when the Starting Notice Report is received from the Office Staff. 
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SiteManager  
Critical Date Name 

TDOT Term (if applicable) 
 

Accepted Date Final Inspection Date 

Adjusted Completion 
Date 

Prorata Date – The original completion date altered 
by a Change Order (Supplemental) plus time 
adjustment for item overruns/underruns. 

Assigned to FM Date N/A 

Award Date Award Date  

Checked Out to Field Date System populated when the contract is pipelined out 
to standalone. Changed back to zero when checked 
back in. 

Commissioner Approved 
Completion Date 

The original completion date altered by a Change 
Order (Supplemental). 

Contract Archived Date N/A 

Contractor Bankruptcy 
Date 

N/A 

Contractor Default Date N/A 

Contractor Final Release 
Date 

Claim Expiration Date (Advertisement Due Date) 

Execution Date Accepted Date  

Letting Date Letting Date 

Notice to Proceed Date Effective Date or Work Begin Date (whichever is 
earlier). Time charges start on this date.  For SP 
108B Resurfacing, this is the begin date or at least as 
early as the number of days required before the 
original completion date. 

Open to Traffic Date N/A 

Original Completion Date The completion date established by the contract. 

Price Adjustments Base 
Date 

Auto-populated with first day of letting’s month 
(even if no price adjustment exists) 

Physical Work Complete 
Date 

N/A 

Signed Date Signed Date 

Substantial Work 
complete date 

Date to Stop Charging Time (for Completion Date 
contracts) 

Work Begin Date Date Work Actually Began (Starting Notice) 

The TDOT Equivalents to Default Critical Dates 

Table 2-1 

Note Dates in 
bold text. 
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 Exercise 2-5 
In the following exercise, you will view the Actual Date of a Contract Critical 
Dates for Contract CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the Critical Dates folder tab. 
2. In the Critical Date Description list box, scroll to and click Notice 

to Proceed Date. The data for the Notice to Proceed Date is 
displayed below the list. 

3. What is the Notice to Proceed Date? _________________________ 
4. What is the Original Completion Date? ______________________ 

4/14/05 
09/15/05 

Can do DWRs 
and Diaries 
without a 
Notice to 
Proceed Date, 
but you can’t 
generate an 
Estimate. 
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Viewing Contract Primary Personnel 

The Primary Personnel folder tab displays Contract’s primary State personnel. 
Every Contract must have a Project Manager and a Project Engineer. When a 
user is designated as the Project Manager and/or Project Engineer on the 
Contract, SiteManager adds that user to Contract Authority automatically. If 
primary personnel are later replaced, SiteManager starts authority for the new 
personnel and ends authority for the previous personnel.  

The terms Project Manager and Project Engineer are SiteManager terms and have 
no particular significance other than the fact that they are the first two to receive 
Contract Authority. 

 

The Primary Personnel Folder Tab 

Figure 2-6 

At TDOT, the Headquarters Construction Office will enter the assigned 
Project Supervisor in both the Project Manager and Project Engineer field.  

 Exercise 2-6 
In the following exercise, you will view the Project Manager and Project 
Engineer assignments for contract CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the Primary Personnel folder tab. 
2. Who is the Project Supervisor for Contract CNB022E? 

_________________________________________________ 
 

When primary personnel 
are added or removed on 
this panel, the system 
adds or removes them on 
the Contract Authority 
panel automatically. 

The User indicated 
here will receive 
system-generated 
messages about the 
Contract. 

Tracy Johnson 

When a contract is 
Pending the Project 
Manager/Engineer 
field would be blank 
or contain an “N”. 
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Viewing the Prime Contractor and Associates 

The Prime Contractor folder tab displays the Prime Contractor, the Prime 
Contacts, and the Prime Associates. At a minimum, SiteManager requires a 
Prime Contractor, Surety company, and Insurance company to be designated 

 
The Prime Contractor Folder Tab 

Figure 2-7 

Since TDOT does not record an insurance company for the prime contract 
the placeholder value, SiteManager Generic Insurance, is substituted for a 
real value. TDOT will record actual associates for: 

• Bonding 
• Surety 

 

 Exercise 2-7 
In the following exercise, you will view the Prime Contractor’s surety and insurance 
companies for Contract CNB022E. 

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the Prime Contractor folder tab. 
2. Who is the Prime Contractor? _______________________ 
3. Who is the Bonding Company? 

_______________________________________________ 
4. Who is the Surety Company? 

_______________________________________________ American Casualty Co. of Reading, PA 

BB&T – Thornton & Harwell 

Volunteer Bridge Construction, Inc. 
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Viewing the DBE Commitment Goal 

The DBE Commit folder tab displays the DBE commitments for a Contract. If 
the Prime Contractor is a DBE, the User can also enter the DBE Work Class on 
this folder tab. The system calculates the DBE commitment amounts displayed 
on this folder tab using values entered on the Subcontracts panel. 

 

The DBE Commitment Folder Tab 

Figure 2-8 

 Exercise 2-8 
In the following exercise, you will view the DBE goal.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the DBE Commit folder tab. 
2. What is the DBE Commitment Total Current Pct?    
3. Click the Close button. 

 

The Training Plan Folder Tab 

The Training Plan folder tab is grayed out because it is obsolete functionality 
deactivated by AASHTO. 

If the Contract has 
DBE commitments, 
this panel displays 
the Contract’s actual 
DBE commitment 
amounts, which are 
based on work done 
by Subcontractors.  

When you 
modify the DBE 
Goal Percent, the 
system 
recalculates the 
DBE Goal Value.

2.97% 
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Viewing Contract Milestones 

The Milestones window lets the Office Staff modify and delete Contract 
Milestones. Office Staff also enters the dates the milestone work was started and 
completed. 

TDOT is using this window as a record keeping of days charged for 
milestones. Liquidated Damages are to be assessed under the 
appropriate pay item. 

Milestone Time Charges 

In SiteManager, the three types of Milestone Time Charges for Contracts are: 

• Calendar Day and/or Completion Date Milestone:  These types of 
Milestones require the “Work Start” date and “Actual Completion” date 
be entered.  There will be no charge on the Diary Window Charge Tab for 
these types of Milestones. 

• Working Days (Available Days) –These types of Milestones require the 
“Work Start” date and “Actual Completion” date be entered.  It will also 
require days to be charged on the Diary Window Charge Tab for these 
types of Milestones.   
 
(Mowing Cycles will be the only Milestones using milestone “type” 
Working Days.) 

 

The Milestones Window 

Figure 2-9 

TDOT calls these ‘incentives,’ 
‘goals,’ or ‘phased 
construction.’ 
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7/15/05 

2 

8/15/05 

 

In TDOT, HQ Finance Office will create Milestones.  Office Staff will start 
Milestones by entering the Milestone Work Start Date and Completion Date.  
Milestones are used for such things as phased construction, mowing and 
litter cycle. 

TDOT will not auto generate disincentives or incentives.  These are applied 
with pay items.  The Milestone window is used as supporting documentation 
for these pay items. 

 Exercise 2-9 
In the following exercise, you will view a Milestone for contract CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. On the Contract Records panel, double-click the Milestones icon. 
2. How many milestones are currently listed for this contract?  
3. Click Milestone 01. 
4. What is the Original Milestone Compl. date?  
5. Click Milestone 02. 
6. What is the Original Milestone Compl. date?  
7. Click the Close button. 
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Viewing Contract Projects 

The Project panel displays data related to the Contract Projects. There must be at 
least one Project defined for each Contract. New Projects can be added while the 
Contract is in pending or active status. To add a Project to an active Contract, an 
authorized User can create the Project on the Project Description folder tab. 
Items must be added through a Change Order. 

The Project Description Folder Tab 

Figure 2-10 

 Exercise 2-10 
In the following exercise, you will review a Project Description for Contract 
CNB022E. 

User ID: jj05751  Group: INSP Contract: CNB022E 

1. On the Contract Records panel, double-click the Projects icon. 
2. How many Projects are on this Contract? _____________________ 
3. In the Project list box, scroll to and double-click Project 55019-

3220-94. 
4. What is the Project Description? ____________________________ 
5. What is the Route Nbr? _________________________ 224 

BRIDGE AND APPROACHES OVER LICK 
CREEK @ (L.M. 1.47) 

2 



Viewing Contract Projects Trns•port SiteManager® Learning Guide 
Contract Administration for Field Documentation Section 2  Contract Administration 
 

 

 73 

Viewing Project Counties 

The Counties folder tab displays project counties. For every county included in 
the Project, the User is shown the percentage of the Project work to be done in 
the county. The percentages for all counties must add up to 100%. 

 

The Project Counties Folder Tab 

Figure 2-11 

 Exercise 2-11 
In the following exercise, you will review the Project Counties folder tab for Contract 
CNB022E. Participants should be logged on using the jj05751 ID in the INSP group. 

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the Counties folder tab. 
2. What County is this project located in? _______________________ 
3. Click the Close button on the toolbar. 

MCNAIRY 
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Viewing Contract Items 

The Items panel displays Items on the selected Contract and Project.  

The Items Window 

Figure 2-12 

In TDOT, items known as “add-on” items are added to the contract before it 
is assigned to the Region. Add-On Items are denoted by Line Item Numbers, 
9000 thru 9499. These add-on items are the adjustment items appropriate 
for the items of that contract. Once the contract is activated, all additional 
items are added using the Change Order function. Change Order Items are 
denoted by Line Item Numbers 9500 thru 9999.  

Add-on Items will never have a Bid Quantity in the Contract Item window, 
because they are not bid on by the contractor. 

The Major Item Indicator will be checked for those items determined to be 
major items during the contract activation process.  

The Category 
field does not 
display 
properly in 
Inquiry mode. 
Since this is 
considered a 
minor bug, it 
will probably 
never be fixed. 
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 Exercise 2-12 
In the following exercise, you will review an item for Contract CNB022E. 
Participants should be logged on using the jj05751 ID in the INSP group. 

User ID: jj05751  Group: INSP Contract: CNB022E 

1. On the Contract Records panel, double-click the Items icon. 
2. In the Project list box, scroll to and double-click Project 55019-

3220-94. 
3. In the Contract Item, list box, scroll to and double-click Line Nbr 

9024, Category Nbr 0100. Item Code 109-01.01, Description PAY 
ADJUSTMENT FOR FUEL. 

4. What is the Unit Price? ____________________________ 
5. What is the Bid Quantity? _________________________ 
6. Click the Open button. 
7. In the Contract Item, list box, scroll to and double-click Line Nbr 

0500, Item Code 606-09.01, Description TEST PILES (PRECAST 
CONCRETE, SIZE 1). 

8. What is the Unit Price? ____________________________ 
9. What is the Bid Quantity? _________________________ 
10. Click the Close button. 

 

$1.00000 

.000 

$25.00000

120.000 

This is an add-
on item. 
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Viewing Contract Funding 

The Contract Funding panel lets the User view funding for the whole Contract 
and for the Contract’s Projects, Categories, and Line Items. The Contract 
Funding panel lists the current funding specifications in the top datawindow. 
Data for the selected funding record is displayed in the bottom datawindow. If 
the User adds funding that does not match the funding selection on the Contract 
Description folder tab (i.e., Federal, State/Province, or Both), SiteManager 
automatically updates the Contract Description folder tab. 

Active Contracts must be fully funded. For any part of the Contract funded by 
multiple sources, the combined funding must equal 100%. If more than one 
priority level is assigned, the combined funding for each priority level must equal 
100%. In addition, each funding source can be assigned a Cap amount. When the 
highest priority funding source reaches its Cap amount, the funding source with 
the next highest priority continues the funding. If the lowest priority level fund 
has a Cap amount, the Cap amount will be ignored until a lower level fund is 
added. 

 

The Contract Funding Window 

Figure 2-13 

In TDOT, the Contract Funding window is loaded from PES and LAS.  

The Category Number identifies the funding source and must be given 
attention when recording work in a DWR. 

 

This screen 
shot shows a 
more complexly 
funded contract 
than the one we 
viewed in 
training. Direct 
students to look 
at this screen 
shot. 
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 Exercise 2-13 
In the following exercise, you will view the Contract Funding window for 
Contract CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. On the Contract Records panel, double-click the Contract 
Funding icon.  

2. Examine Figure 2-13 above. 
3. Click the Close button. 
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Viewing Stockpiled Materials 

The Stockpiled Materials panel lets the User select materials to be stockpiled for 
the Contract, and view invoice data for the materials. The panel displays Contract 
Line Item data in the top window and stockpiled material data in the bottom 
window. This data is used during estimate generation to determine the amount to 
be paid for the Items installed. The estimate process enters the installed quantity 
and the amount paid to date on the Stockpiled Materials panel. The estimate 
process also closes out the stockpiled material balance when the remaining 
quantity is zero, or an authorized User can close out the balance manually. 

The Stockpiled Materials Window 

Figure 2-14 

 

In TDOT, the Project Supervisor and Office Staff will use the Stockpiled 
Materials window in SiteManager to track stockpiled materials.  

Stockpiled material reductions or additions to the pay amount in the 
estimate are calculated and applied automatically through SiteManager. 
Details regarding stockpiled materials that have been applied to an estimate 
can be seen on the Line Item Adjustment window. 
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$5,760.00 

$5,760.00 

604-04.01 Applied Texture Finish 

$128.000 

45.00 

 Exercise 2-14 
In the following exercise, you will view a stockpiled material record for Contract 
CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. On the Contract Records panel, double-click the Stockpiled 
Materials icon.  

2. In the Stockpiled Materials pick list, double-click, Project Number 
55019-3220-94, Category Number 0500, Line Item 0480, Invoice 
Number 28545. 

3. What is the stockpile description?      
4. What is the Unit Price of the material? ________________________ 
5. What is the invoice amount?       
6. What was the initial invoice payment?     
7. What is the remaining quantity of the stockpile? ________________ 
8. Click the Close button. 
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Viewing a Subcontract 

The Subcontract panel lets the User add, modify, and delete Subcontracts and 
Subcontract data. The panel also displays calculated DBE commitment amounts. 
The User can define both parent Subcontracts and lower level Subcontracts. 

The Subcontracts Description Folder Tab 

Figure 2-15 

In TDOT, HQ Construction will load all Subcontracts into SiteManager and 
enter the approval date.  The field office will add the equipment and 
personnel to the subcontractor’s DWR Master List for the Contract. 

 

Subcontract Descriptions 

The User enters the Subcontractor and DBE commitments on the Description 
folder tab. To be selected as a Subcontractor, a Contractor must first be entered 
as a vendor in the Vendor reference tables. When a new Subcontract is saved, the 
system adds the Subcontract amount to the total amount of uncompleted work for 
the Subcontractor. This value is displayed on the Vendors panel in Reference 
Tables (CA). The Contract’s Prime Contractor cannot be selected as a 
Subcontractor on the Contract. 

The percentage of the Subcontract that can be counted towards the Contract’s 
DBE goal depends on the Subcontract’s level, the Subcontractor’s DBE status, 
and whether or not the Subcontract includes Items. A Parent Subcontract with a 
DBE Subcontractor and Items is always counted 100% towards the Contract’s 
DBE goal. If the Subcontract has no Items (i.e., the Subcontractor is a 
supplier/hauler), the User enters the percentage counted towards the DBE goal. 
For nested Subcontracts, if a higher-level DBE Subcontract is counted 100% 
towards the DBE goal, the percentage of the nested Subcontract is always zero. 

If a Subcontractor is 
not associated with 
contract items and 
approved, the 
Inspector will not be 
able to give the 
Subcontractor credit 
for installing work 
items on the Daily 
Work Report.  

Nested subcontracts 
happen when a 
subcontractor 
subcontracts part of 
the work to another 
subcontractor. Nested 
subcontractors are 
referred to as 2nd, 3rd, 
etc. Tier Subcontracts 
at TDOT. 

SiteManager 
defines 
“commitment” 
as DBE 
Commitment. 
Subcontracts 
that are not 
DBE are not 
included in the 
Commitment 
data. 
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8 

04/15/05 

2 

 Exercise 2-15 
In the following exercise, you will view a Subcontract description for Contract 
CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the Contract Administration folder tab. 
2. On the Contract Administration panel, double-click the 

Contractor Management icon. 
3. On the Contractor Management panel, double-click the 

Subcontracts icon.  
4. How many subcontracts are there for this contract?    
5. How many subcontractors are DBE’s for this contract? ___________ 
6. In the Subcontract list box, scroll to and double-click Subcontract 

Number 01 APAC-MISSISSIPPI, INC. 
7. What is the approval date for this subcontract? _________________ 
8. Is this a “nested” subcontract? ______________________________ 

 

No, because the parent subcontract field is blank. 
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8 

Quantity: 546.0 Amount: $19,847.10 

Viewing Subcontract Items 

The Subcontract Items folder tab lets the User add, modify, and delete 
Subcontract Items. If the Subcontractor is a hauler or supplier only, the 
Subcontract will not have Items. If the Subcontract has no Items, the User must 
enter the Subcontract Amount manually. If the Subcontract has Items, the 
Subcontract Amount is the sum of all of the Item amounts and the User cannot 
modify it. 

 

The Subcontracts Items Folder Tab 

Figure 2-16 

 Exercise 2-16 
In the following exercise, you will view a Subcontract item for Contract 
CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. Click the Items folder tab. 
2. How many items are on this subcontract?     
3. What is the total quantity and dollar amount for Project Number 

55019-3220-94, Line Item 0110, Item Code 307-01.01, ASPHALT 
CONCRETE MIX?  

          
4. Click the Close button. 

 

If a Subcontractor is 
associated with a 
contract but not 
qualified for the 
work item, the 
Inspector will not be 
able to give the 
Subcontractor credit 
for installing the 
work item on the 
Daily Work Report. 
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Review for Section 2 
To view a Contract’s description: 

1. On the Main Panel, double-click Contract 
Administration icon.  

2. On the Contract Administration panel, 
double-click the Contract Records icon.  

3. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

4. Click the Open button. The Select Contract 
list is displayed. 

5. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

6. Click the Save button. 

To view a Contract location: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Location folder tab. 

To view a Contract’s payment data: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Payment Data folder tab. 

To view the Actual Date of a Contract Critical Date: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Critical Dates folder tab. 
5. In the Critical Date Description list box, 

scroll to and click the date. The data for the 
selected date is displayed below the list. 

To view Primary Personnel for a Contract: 

1. On the Contract Records panel, double-click 
the Contracts icon. The Contracts panel 
opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Primary Personnel folder tab. 

To view a Prime Contractor: 

1. On the Contract Records panel, double-click 
the Contracts icon. The Contracts panel 
opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Prime Contractor folder tab. 

To view the DBE goal for a Contract: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the DBE Commitments folder tab. 
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To view a Milestone: 

1. On the Contract Records panel, double-
click the Milestones icon. The Milestone 
panel opens and a Contract select list is 
displayed. 

2. In the Contract ID list box, scroll to and 
double-click the Contract. The Milestones 
for the selected Contract are displayed. 

To view a Project on a Contract: 

1. On the Contract Records panel, double-
click the Projects icon. The Projects panel 
opens. 

2. To select both a Contract and a Project, 
click the Open button. The Select Contract 
ID panel opens. 

3. In the Contract ID list box, scroll to and 
double-click the Contract. The Projects for 
the selected Contract are listed. 

4. In the Project list box, scroll to and click 
the Project. 

5. Click Ok. The Projects panel opens with the 
Description folder tab displayed and data for 
the selected Project displayed in the fields. 

To view a Project County: 

1. On the Contract Records panel, double-
click the Projects icon. The Projects panel 
opens. 

2. To select both a Contract and a Project, 
click the Open button. The Select Contract 
ID panel opens. 

3. In the Contract ID list box, scroll to and 
double-click the Contract. The Projects for 
the selected Contract are listed. 

4. In the Project list box, scroll to and click 
the Project. 

5. Click Ok. The Projects panel opens with the 
Description folder tab displayed and data for 
the selected Project displayed in the fields. 

6. Click the Project Counties folder tab. 

To view an Item on a Contract: 

1. On the Contract Records panel, double-
click the Items icon. The Items panel opens. 

2. Click the Open button.. 
3. In the Contract ID list box, scroll to and 

double-click the Contract. The Projects for 
the selected Contract are listed. 

4. In the Project list box, scroll to and click the 
Project. 

5. In the Item list box, scroll to and click the 
Item. 

6. Click Ok. The Items panel opens and 
displays data for the selected Item. 

To view Contract Funding: 

1. On the Contract Records panel, double-
click the Funding icon. 

2. In the Contract ID list box, double-click the 
Contract. 

3. Click Ok. 

To view Stockpile Materials 

1. On the Contract Records panel, double-
click the Stockpiled Materials icon.  

2. In the Stockpile Material pick list, double-
click the stockpile materials. 

To view a Subcontract: 

1. On the Contractor Management panel, 
double-click the Subcontracts icon. The 
Subcontracts panel opens. 

2. Click the Open button. The Select Contract 
panel opens. 

3. In the Contract ID list box, scroll to and 
double-click the Contract. 

4. In the Subcontract list box, scroll to and 
click the Subcontract. 

5. Click Ok. The panel displays data for the 
selected Subcontract. 

To view an Item on a Subcontract: 

1. On the Contractor Management panel, 
double-click the Subcontracts icon. The 
Subcontracts panel opens. 

2. Click the Open button. The Select Contract 
panel opens. 

3. In the Contract ID list box, scroll to and 
double-click the Contract. 

4. In the Subcontract list box, scroll to and 
click the Subcontract. 

5. Click Ok. The panel displays data for the 
selected Subcontract. 

6. Click the Items folder tab. 
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YES 

7/15/05 

Three 

Summary Exercise for Section 2 
In the following exercise, you will review Contract CNB022F.  

User ID: jj05751  Group: INSP Contract: CNB022F 

1. Navigate to the Contracts window. 

2. Open Contract ID CNB022F. 

3. What Region and Unit is this Contract assigned to? __________________________________ 

4. What is the Work Type for this contract? __________________________________________ 

5. What is the Execution Date of the contract? ________________________________________ 

6. What is the bonding company? __________________________________________________ 

7. Navigate to the Milestones window. 

8. What is the Original Milestone Completion date for Milestone 01 on CNB022F? _________ 

9. Navigate to the Projects window. 

10. How many projects are on this contract? ___________________________________________ 

11. Navigate to the Items window. 

12. Open Contract CNB022F, Project 55019-3220-94, Category 0500, Line Item Number 0540, 
Item Code 620-03.10 CONCRETE PARAPET. 

13. What is the Bid Quantity? _____________________________________________________ 

14. Is it on a Change Order? _______________________________________________________ 

15. Navigate to the Contract Funding window. 

16. How many categories on project 55021-3214-94 are listed? _____________________________ 

17. Navigate to the Contractor Management folder tab. 

18. Open the Subcontracts window and open Subcontract 02 on CNB022F.  

19. Who is the Subcontractor? _______________________________________________________ 

20. Is this Subcontractor a DBE? _____________________________________________________ 

21. Is this subcontractor approved to install Line Item 0610, Item Code 730-50?  
_____________________________________________________________________________ 

22. Navigate to the Main Panel. 

Bridge Constr (new, widening, reconstr) 

3/25/05 

BB&T – Thornton & Harwell 

254 

No 

Two 

Region 4, Unit 042 

No 

International Traffic Systems, Inc.
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Learning Module 

 Section 3  From Server to PM 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Understand the Pipeline Process in SiteManager 

• Download Data from the Server 
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Overview 

Pipeline is the process that automates the transfer of data. SiteManager provides 
the Pipeline processes because Contract data must be downloaded and uploaded 
often during the life of a Contract. In general, the data downloaded from the 
Server is the Contract plan data, which is primarily the Contract specifications. 
The data uploaded to the Server is the Contract activity data, which is the work 
done on the Contract. Pipeline automates the data flow from the: 

• Server to Standalone Mode (PM) 

• Standalone Mode (PM) to Server 

 

Pipeline The pipeline process transfers data files from one database to 
another. In SiteManager, the User uses the pipeline process to 
download data directly from the server’s database to the 
standalone workstation’s database, and to upload data directly 
from the standalone workstation’s database to the server’s 
database.  

 

PM = Standalone 
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The following table shows how the Pipeline panels are used to transfer data.  

Step Activity Process Pipeline Panel 

1 Download 
Basic Contract 
Data from the 
Server 

The User selects and downloads basic 
contract data from the server’s 
database to the standalone 
workstation’s database using the 
Server to PM Pipeline panel. The 
Pipeline process loads the data directly 
into the User’s standalone database. 
Before DWRs can be generated in 
Standalone mode, the User must 
download Basic Contract Data from 
the Server. 

Server to PM Pipeline panel 

2 Create Daily 
Work Reports 

The User creates and modifies DWRs 
on the contract to report the usage of 
Labor, Equipment, and Items on the 
Contract. 

As DWRs are created, they are 
listed on the DWR Select 
folder tab in the PM to Server 
window. 

3 Upload Daily 
Work Reports 
to the Server 

The User selects and uploads DWRs 
from the standalone workstation to the 
Server. 

PM to Server Pipeline panel 

4 View Pipeline 
History 

The User can view a history of 
Pipeline activity. 

Pipeline Information panel 

5 Download 
Basic Contract 
Data and Daily 
Work Reports, 
as needed. 

New data is added to the Contract on 
the Server only. The User downloads 
new Contract data as it becomes 
available. The new data updates the 
standalone database. The User can also 
download Daily Work Reports. 

Download Basic Contract Data 
and Daily Work Reports as 
needed. 

NOTE: Basic Contract Data 
includes all Change Order 
information. 

6 Release the 
Contract 

When the Contract work is done, the 
User uses Pipeline to release the 
Contract back to the Server. On the 
Pipeline Summary panel, select the 
Basic Contract Data check box. 

PM to Server Pipeline panel 

The Pipeline Process Table 

Table 3-1 

 

In TDOT, the Inspector must always check out Basic Contract Data when 
pipelining a contract to Standalone mode on his/her computer for the first 
time.  It is required that the Basic Contract Data be pipelined to Standalone 
mode a minimum of twice a week to ensure that the Standalone database 
has the most current contract information. 
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The Pipeline Panel 

When logging on to SiteManager, the User connects to either the standalone 
database or the server database, depending on which Pipeline function will be 
used. 

 

The Pipeline Panel 

Figure 3-1 
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Check Out — Downloading Data from the Server — PM 

The Server to PM Pipeline panel lets the User download (check out) data from 
the server’s database to the standalone workstation’s database. To download 
Contract data from the Server, the User must first select a Contract. 

To download Basic Contract Data, the User must check the Basic Contract Data 
box on the Server to PM Pipeline panel.  Basic Contract Data includes all Change 
Order information.  After the User has selected the data to download, the pipeline 
process is triggered by selecting the Pipeline Data menu option on the Services 
menu. For the data to download, the Contract must be in active status. 

Server to PM Pipeline Summary 

On the Server to PM Pipeline window’s Pipeline Summary folder tab, the user 
can view the number of Daily Work Reports, Diaries, Change Orders, Force 
Accounts, and Users selected. To see which ones are selected, the User clicks the 
appropriate folder tab. 

 

The Pipeline Summary Folder Tab 

Figure 3-2 

 
Note: TDOT will not use the Diary Select, Change Order Select, Force Account Select, or 
Users Select folder tabs.

The Basic Contract 
Data includes all 
Change Orders. 

The pipeline 
process loads the 
Contract  directly 
from the server 
database to the 
User’s standalone 
database. 

 

Contract work 
cannot be recorded 
in the field until the 
Basic Contract 
Data is 
downloaded. 

 

The standalone 
workstations 
depend on periodic 
downloads from the 
Server for current 
data such as the 
results of estimates. 

The Pipeline Status 
field shows the 
activity and 
complete status of 
the pipeline process.
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 Exercise 3-1 

In the following exercise, you will select Contract CNB022I, browse the Server 
to PM Pipeline panels, and download the basic contract data.  

User ID: jj05751 Group: INSP  Contract: CNB022I 

1. Double-click the SiteManager Training program icon on your 
desktop. 

2. In the User ID field, type jj05751. 
3. Press the Tab key. 
4. In the Password field, type pass. 
5. Press the Enter key. 

Now, let’s browse to the Pipeline panel and open a contract. 
6. On the Main Panel, double-click the Pipeline icon. 
7. On the Pipeline panel, double-click the Server to PM Pipeline icon. 

SiteManager displays the Server to PM Pipeline window. 
8. Click the Open button.  
9. In the Contract list box, scroll to and double-click Contract 

CNB022I. 
10. Click the DWR Select tab. 
11. Click the Change Order Select tab. 
12. Click the Pipeline Summary tab. 
13. On the Pipeline Summary tab, click the Basic Contract Data check 

box (ON). 
14. Click the Services menu and click Pipeline Data. The progress of the 

download is shown in the Pipeline Status field. A message confirms 
that the data is downloaded. 

15. Click the Close button. 

 

Basic Contract 
Data downloads 
all Change 
Orders and any 
other updates to 
the contract. 

Shift-tab if user 
ID not 
highlighted. 
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Selecting Daily Work Reports 

When the User clicks the DWR Select folder tab on the Server to PM Pipeline 
panel, the panel displays a list of DWRs for the selected Contract. The User 
selects one or more DWRs to download. 

 

The DWR Select Folder Tab 

Figure 3-3 

 

In TDOT, Inspectors may select DWRs from the DWR Select folder tab to 
download to Standalone mode for modification or review.  DWRs must be 
pipelined back up to the server as soon as modifications have been 
completed. 

Users who checkout an unauthorized DWR created by another user to 
his/her Standalone database must immediately check in the DWR so that it 
is available to the owner for modification, if necessary, or for inclusion in a 
Diary.  A “view only” copy of the checked out DWR will remain in the 
Standalone database. 
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Daily Work Report Applicability 

Daily Work Report data is transferred using the Pipeline function. To begin 
working on a Contract, the User must first download Basic Contract Data from 
the Server. ‘Basic Contract Data’ includes all of the Contract data required to 
process the DWRs, including Change Orders.  After Contract work is underway, 
the DWRs are uploaded to the Server.  

Pipeline is used to: 

• Download Basic Contract Data from the Server 

• Upload Daily Work Reports to the Server 
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Review for Section 3 
To download data from the server: 

1. When logging on to SiteManager, connect 
to the server database. 

2. On the SiteManager main panel, double-
click the Pipeline icon. 

3. On the Pipeline panel, double-click the 
Server to PM Pipeline icon. The Pipeline 
Summary folder tab is displayed. 

4. To select a Contract, click the Open button. 
5. In the Contract ID list box, scroll to and 

double-click the Contract. 
6. To download Basic Contract Data, click the 

Basic Contract Data check box (ON). 
7. To select Daily Work Reports, click the 

DWR Select folder tab. 
8. In the DWR list box, shift-click each Daily 

Work Report to be downloaded. 
9. Click the Add button. The selected Daily 

Work Reports are added to the Selected 
DWRs list. 

10. Click the Pipeline Summary folder tab. 
The panel displays the total number of 
Change Orders, Force Accounts, Diaries, 
Daily Work Reports, and Users selected. 

11. To download the selected data from the 
Server, click the Services menu and click 
the Pipeline Data choice. The progress of 
the download is shown in the Pipeline 
Status field. 
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Summary Exercise for Section 3 

In the following exercise, you will pipeline data from Contract CNB022K to 
Standalone mode.  

User ID: jj05751 Group: INSP Contract: CNB022K 

1. For Contract CNB022K, download the Basic Contract Data from the 
Server. 

2. Exit SiteManager. 
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Learning Module 

 Section 4  Daily Work Reports I 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Understand the Basic Concepts of Daily Work Reports 

• Enter Basic Daily Work Report Information  

• Enter Contractor Activity 

• Enter Contractor Equipment Activity 

• Enter Daily Staff Activity 

• Select and Record Work Items 

• Record Work on a DWR Template 



Trns•port SiteManager® Learning Guide Daily Work Reports I 
Section 4  Daily Work Reports I Field Reporting  

 

 

98  

Daily Work Reports I 

The User creates daily records of construction activity in Daily Work Reports.  
SiteManager lets the User create DWRs on the workstation in the field.  Before 
the Inspector can create the first DWR for a Contract in standalone mode, the 
Basic Contract Data must be downloaded from the SiteManager Server database 
to the User’s workstation.  After the User pipelines the Basic Contract Data onto 
the workstation’s local database, the User can begin creating DWRs in 
standalone.  Typically, for each Contract, each User submits one DWR per day. 
Only the User who creates the DWR may modify it. 

The Daily Work Report Select panel lets the User open a DWR.  The panel lists 
all of the DWRs stored on the workstation for the selected Contract and the 
selected User ID.  The User can only access the DWRs stored in the local 
database.  The User can open any DWR in the database, but the User cannot 
modify a report the User did not create.  The DWR opens as Read Only if the 
system finds one of the following:  

• The Daily Work Report has been transferred to the server or standalone 
database  

• The Daily Work Report has been authorized 

• The Daily Work Report was authored by another User 

 

 

Choose Keys 

When the User first enters the Daily Work Report window to create a new DWR, 
the User must first select Choose Keys from the Services menu. By selecting 
Choose Keys, the User is given a list of Contracts for which to create DWRs. If a 
User enters the Daily Work Report window to open an existing record, he or she 
must click the Open button and select the existing DWR. To create a new DWR 
for the same Contract as the existing DWR, the User must click the New button. 
To create a new DWR on a different Contract, the User must click the New 
button and then select Choose Keys from the Services menu to choose a 
Contract. 

SiteManager will 
not allow two 
DWRs to be created 
by the same User 
for the same 
contract on the 
same day. 
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The DWR Info Folder Tab 

Figure 4-1 

 

In TDOT, the Lead Inspector will complete a DWR for every day during 
the life of a project including weekends and holidays.   Other inspectors 
will create DWRs for any day they are on-site or reporting work.  DWRs 
may also be created by Office staff.  

DWRs created by Inspectors will be created in Standalone Mode and 
DWRs created by Office Staff will be created in Server Mode. 

Note: Inspectors should make sure the network cable is unplugged from the 
laptop when creating a DWR in Standalone Mode. 
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The Daily Work Reports window has the following folder tabs: 

DWR Info 

The DWR Info folder tab lets the User create a new DWR and collect 
information about the day for which the report was created. 

Contractors 

The Contractors folder tab lets the User enter daily data about the Prime and 
Subcontractor(s), Supervisor(s), and variable labor (by personnel type).  TDOT 
will not use the Supervisor section of the window. 

Contractors Equip 

The Contractor Equip folder tab lets the User document the daily presence and 
use of equipment on the job site for a selected Contractor. 

Daily Staff 

The Daily Staff folder tab lets the User enter daily information on state 
employees and consultants.  Each entry shows how many hours the staff member 
worked. 

Work Items 

The Work Items folder tab lets the User view and add daily usage data for 
installed Work Items. 

Force Accounts 

TDOT will not use this feature. 

 

Contractors folder tab 
includes the 
Contractor’s 
Supervisors/Foreman by 
name, which will not be 
used by TDOT.  

Personnel Type is not an 
employee name, but 
rather a job title - 
Electrician, Driver or 
Heavy Equipment 
Operator. TDOT will 
record 
superintendent/foreman 
as personnel types. 



Daily Work Reports I Trns•port SiteManager® Learning Guide 
Field Reporting  Section 4  Daily Work Reports I 

 

 

 101 

 Exercise 4-1 
In the following exercise, you will log on in Standalone mode as the Lead 
Inspector and navigate to the Daily Work Reports window.   

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022I 

1. Double-click the SiteManager Training program icon on your 
desktop. 

2. In the User ID field, type jj05751.  
3. Press the Tab key. 
4. In the Connect To drop-down list, click the expand arrow to the 

right of the current selection and click Training Standalone. 
5. In the Password field, type pass. 
6. Press Enter. 
7. On the Main Panel, double-click the Daily Work Reports icon. 
8. On the Daily Work Reports panel, double-click the Daily Work 

Reports icon.  
 

 

Jackie Warren 
(jj05751) is the Lead 
Inspector for all 
DWR/Diary exercises. 

Shift-tab if the user 
ID is not 
highlighted. 
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Entering Basic Daily Work Report Information 

The DWR Info folder tab lets the User create a new DWR and collect 
information about the day for which the DWR was created.  For example, the 
User enters the weather conditions and high and low temperatures for the day 
here.  The name of the author of this report is displayed in the Inspector field.  
The date covered by this report is displayed in the DWR Date field.  The Locked 
and Authorized fields indicate the state of the DWR.  A locked DWR has been 
transferred via pipeline to a standalone database and has not been transferred 
back to the server.  An authorized DWR has been approved for payment.  If 
either the Locked or Authorized field displays Yes, the User cannot modify the 
DWR. 

This folder tab has three check boxes — No Work Items Installed, No 
Contractors On Site, and No Daily Staff On Site — that indicate there is no data 
for the subject.  These boxes are checked by default.  When the User enters data 
for the subject on another folder tab, the corresponding check box is cleared 
automatically. 

General remarks are also recorded on this folder tab.  To record a remark, the 
User must first select a remark type.  If a remark has already been entered for the 
selected type, as indicated by a check mark next to the type, the remark appears 
in the Remarks field.  A remark does not have a size limit, and can be pasted to 
and from a word processor.   

 

The DWR Info Folder Tab  

Figure 4-2 

Emphasize that 
they do not have to 
click these off if 
they enter data on 
the folder tabs. 

Locked = piped 

DWRs paid on an 
estimate cannot 
be changed, 
although 
locked indicator 
will be N. 

Authorized = 
approved in Diary 
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In TDOT, field users are required to complete the DWR Date, 
Temperature, Weather Conditions, and appropriate Remarks (“Work 
Performed” at a minimum) on the project for the date of the DWR.  

For the Remarks type “Work Performed”, the field user should enter the 
contractor’s name, details regarding the item work progress, and the 
location where the work is performed. 

 

 Exercise 4-2 
In the following exercise, you will create a new DWR and complete the DWR Info 
folder tab for April 11, 2005 on Contract CNB022I.  

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. While on the DWR Info. folder tab, click the Services menu. 
2. Click the Choose Keys choice. 
3. In the Contract ID list box, scroll to and double-click Contract CNB022I. 
4. In the DWR Date field, type 041105. 
5. Press the Tab key.  

Now, let’s add the temperatures and conditions. 
6. In the High Temperature field, type 68 degrees. 
7. In the Low Temperature field, type 46 degrees. 
8. In the A.M. field, click the expand arrow to the right of the current selection and 

click Partially Cloudy.  
9. In the P.M. field, click the expand arrow to the right of the current selection and 

click Sunny. 

Now, let’s add a few remarks. 
10. In the Remarks Type list box, scroll to and click -Work Performed-.   
11. In the Remarks text box, type Volunteer Bridge Construction, Inc. - Clearing 

and Grubbing. 
12. In the Remarks text box, type International Traffic Systems, Inc. - Installed 

Construction Signs from BOP to EOP. 
13. In the Remarks Type list box, scroll to and click Visitor. 
14. In the Remarks text box, type Regional Director arrived on project at 10:00 

AM and advised installation of additional series signs at station 25+50 
intersection of Walnut Grove Rd. 

15. Click the Save button. 

If 
temperatures 
are not 
entered 
correctly, the 
high 
temperature 
will display in 
both fields. 

Same as now, 
equipment and 
personnel on next 
tabs. 
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Entering Contractor Activity 

The Contractors folder tab in DWR lets the User enter daily data on the 
Contractor and variable labor (by personnel type).  Equipment usage is recorded 
on the Contractors Equipment folder tab.  The User can select the Contractor 
from a drop-down list of Contractors and Subcontractors who are authorized to 
work on the Contract.  The Prime Contractor is always at the top of the drop-
down list. The User must select a Contractor before recording installed work 
items.  A minimum DWR that will impact an Estimate has a Contractor on-site 
and records installed work items. 

After the User selects a Contractor, the User can select Personnel Types 
associated with the selected Contractor from the drop-down lists in the Personnel 
Type area.  The records that appear on the drop-down lists are stored on the 
Contract’s Master Lists. To add a record (supervisor, equipment, etc.) that does 
not appear on a drop-down list, a User must first add it to the Contract Master 
List from the Vendor Master List. 

 
The Contractors Folder Tab 

Figure 4-3 

Only 
Subcontractors 
associated with 
the Contract and 
approved for 
specific work 
items are 
accessible from 
the Contractor 
drop-down list. 

This is a 
three-focus 
window. 

TDOT does not use 
the Supervisor/ 
Foreman Name 
section on the 
Contractor’s tab. 
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The Prime Contractor and Subcontractors 
The Contractor drop-down list will contain the Prime Contractor and any 
qualified Subcontractors.  The Prime Contractor will be the first contractor in the 
drop-down list. 

Subcontractors are qualified for specific work items in the Subcontract window 
of the Contract Administration component of SiteManager.  The Subcontractor is 
not available to select on a DWR prior to that subcontractor’s approval date for 
the contract. 
 

In TDOT, all Contractors (Prime Contractors and Subcontractors) on site 
should be indicated on the Contractors folder tab of the DWR window. If 
the Subcontractor is on site, the User must indicate the Subcontractor in 
the Contractor area of the Contractors folder tab. If the Subcontractor is 
not on the drop-down list for this Contract, contact the Field Office so it 
may be added. 

 Exercise 4-3 
In the following exercise, you will add a Prime Contractor and a Subcontractor to the 
DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. Click the Contractors folder tab 
2. On the Contractors folder tab, click the Contractor area. 
3. Click the New button. An empty row is added to the list. 
4. In the Contractor drop-down list, click the expand arrow to the right of the 

current selection and click Volunteer Bridge Construction, Inc 
5. Click the Save button. 
6. Click the New button. An empty row is added to the list. 
7. In the Contractor drop-down list, click the expand arrow to the right of the 

current selection and click International Traffic Systems, Inc. 
8. Click the Save button. 

Do not edit 
values in the 
Nbr of 
Supervisors 
or Nbr of 
Workers 
fields.  

If the 
Subcontractor 
does not have 
an approval 
date, it will 
not display.  
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The Contractor Supervisor 
In TDOT, you will NOT use the Supervisor/Foreman section of the 
window.  Instead all Supervisor/Foreman information will be recorded for 
each Contractor in the Personnel Type section of the Contractor folder tab. 
 
 
The Contractor Personnel  

The personnel drop-down list will contain personnel types added to the Contract 
Master List. 

In TDOT, the User will record all Personnel Types on site for each 
Contractor indicated on the Contractor list. The Hours Worked field is not 
a required field and should remain blank. If any additional details are 
required, the User will enter the information in the Remarks field. 

If the required Personnel Type is not on the drop-down list, contact the 
Field Office so it may be added to the DWR Master List. 
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 Exercise 4-4 
In the following exercise, you will add a personnel type to the contractor on site for 
the DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. On the Contractors folder tab, click the International Traffic Systems, 
Inc. contractor. 

2. On the Contractors folder tab, click the Personnel Type area. 
3. Click the New button. An empty row is added to the list. 
4. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Superintendent. 
5. In the Nbr of Persons field, type 1. 
6. Click the New button. An empty row is added to the list. 
7. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Foreman. 
8. In the Nbr of Persons field, type 1. 
9. Click the New button. An empty row is added to the list. 
10. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Truck Driver (2 axles). 
11. In the Nbr of Persons field, type 1. 
12. Click the New button. An empty row is added to the list. 
13. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Unskilled Laborer. 
14. In the Nbr of Persons field, type 3. 
15. Click the Save button. 

Now let’s add personnel for another contractor. 
16. On the Contractors folder tab, click the contractor Volunteer Bridge 

Construction, Inc. 
17. Click the Personnel Type area. 
18. Click the New button. An empty row is added to the list. 
19. In the Personnel Type drop-down list, click the expand arrow to the 

right of the current selection and click Foreman. 
20. In the Nbr of Persons field, type 1. 
21. Click the Save button. 

You would typically add more personnel and equipment for Volunteer 
Bridge at this point, but we will continue through the DWR for training 
purposes. 
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Modifying Personnel Type Master List 

The Master List of personnel types is maintained for each Contractor on each 
Contract. The Master Lists are maintained by HQ Construction Office, while the 
Contract Master List is maintained by the Field Office.   

As Subcontracts are added to the Contract, the Subcontractors personnel and 
equipment must be added to the master list to allow reporting of these in the 
DWR.  This process is included in the Contract Activation chapter of the Office 
Documentation Course. 
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Entering Contractor Equipment Activity 

The Contractor Equip folder tab lets the User document the presence and use of 
equipment on the job site for the selected Contractor.  The user enters the number 
of pieces of each equipment type on the site on this date and the number of pieces 
used. User must select a Contractor before entering equipment information for 
the Contractor.  

After the User selects a Contractor, the User can select Equipment IDs from the 
drop-down list in the Equipment ID - Description field.  The records that appear 
on the drop-down list are stored in the Contractor’s Contract Master List.  To add 
a record that does not appear on the drop-down list, the User must first add it to 
the Contract Equipment Master List from the Vendor Master List. 

 
The Contractor Equipment Folder Tab 

Figure 4-4 

 

In TDOT, the User will record the type of equipment, number of pieces, 
and number of pieces used.  TDOT will not use the “Hours Used” field. 

If an equipment selection is not available, contact the Field Office so it may 
be added to the DWR Master List. 

Do not edit 
values in the Nbr 
of Supervisors or 
Nbr of Workers 
fields. These 
fields are 
automatically 
populated. 
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 Exercise 4-5 
In the following exercise, you will add equipment to the contractor on site for the 
DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. On the Daily Work Reports window, click the Contractor Equipment folder 
tab.  

2. On the Contractors Equipment folder tab, click the International Traffic 
Systems, Inc.  

3. Click the Equipment ID-Description area.  
4. Click the New button. An empty row is added to the list. 
5. In the Equipment ID-Description drop-down list, click the expand arrow to the 

right of the current selection and click Pickup Truck. 
6. In the Nbr. of Pieces field, type 2. 
7. In the Nbr Used field, type 2. 
8. Click the New button. An empty row is added to the list. 
9. In the Equipment ID drop-down list, click the expand arrow to the right of the 

current selection and click Haul Truck. 
10. In the Nbr. of Pieces field, type 1. 
11. In the Nbr Used field, type 1. 
12. Click the Save button. 

Now let’s add equipment for another contractor. 
13. On the Contractors Equipment folder tab, click the Volunteer Bridge 

Construction, Inc. 
14. Click the Equipment ID-Description area.  
15. Click the New button. An empty row is added to the list. 
16. In the Equipment ID-Description drop-down list, click the expand arrow to the 

right of the current selection and click Pickup Truck. 
17. In the Nbr. of Pieces field, type 1. 
18. In the Nbr Used field, type 1. 
19. Click the Save button. 

 

May need to 
click in the 
Nbr of Pieces 
field first to 
activate drop-
down list. 
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Modifying the Equipment Master List 

A Master List of equipment is maintained for each Contractor on each Contract.  
The Master List is maintained by HQ Construction Office, while the Contract 
Master List is maintained by the field office. 

As Subcontracts are added to the Contract, the Subcontractors personnel and 
equipment must be added to the master list to allow reporting of these in the 
DWR.  This process is included in the Contract Activation chapter of the Office 
Documentation Course. 
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Entering Daily Staff Activity 

The Daily Staff folder tab lets the User enter daily information on state 
employees and consultants. Each entry shows how many hours the staff member 
worked. The User selects staff members from the drop-down list in the Staff 
Member field. The User may also enter remarks for each line of Daily Staff 
recorded. The Staff Members that appear on the drop-down list are stored in the 
Contract Master List.  Staff Members that do not appear on the drop-down list 
must first be added to the Contract Master List. 

 
The Daily Staff Folder Tab 

Figure 4-5 

 

In TDOT, the Project Supervisor will determine which user will record the 
name of the TDOT staff members on site, as well as the total number of 
hours each staff member was at the project site.  The total number of 
regular and overtime hours will be entered in the Reg. Hours column.  All 
other fields should be left blank.   

Users not designated by the Project Supervisor should not complete this 
folder tab. 

 

In TDOT, 
these five fields 
remain blank. 

Staff Hours 
Custom Report will 
show TDOT Staff 
and hours so you 
can transfer the 
data to the time 
card. Information 
regarding 
consultants can be 
viewed by running 
the Consultant 
Hours Custom 
Report. 
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 Exercise 4-6 
In the following exercise, you will add TDOT Daily Staff to the DWR on April 11, 
2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022I 

1. On the Daily Work Reports window, click the Daily Staff folder tab.  
2. Click the New button. An empty row is added to the list. 
3. In the Staff Member drop-down list, click the expand arrow to the right of the 

current selection and click Warren, Jackie. 
4. In the Reg. Hours field, type 7.5. 
5. Click the New button. An empty row is added to the list. 
6. In the Staff Member drop-down list, click the expand arrow to the right of the 

current selection and click Johnson, Terry. 
7. In the Reg. Hours field, type 7.5. 
8. Click the Save button. 
9. Click the Work Items folder tab. 
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Selecting and Recording Work Items 

The Work Items folder tab lets the User view and add daily usage data for 
installed Work Items. Before entering Work Item data, the Contractor responsible 
for the Work Item must be entered on the Contractors folder tab.  When the User 
first selects the Work Items folder tab, the Select Work Item list is displayed.  
The Record Work Item and Selects Work Item buttons let the User toggle between 
two different versions of the Work Items folder tab.  To enter usage data, the 
User first selects the Work Item and then selects the Record Work Item button (or 
the Record Work Item option on the Edit menu).  This displays the Record Work 
Items folder tab on which the User can view and add daily usage data. 

 
The Record Work Item and Selects Work Item Buttons 

Figure 4-6 

The User can toggle between two different versions of the Work Items folder tab.  
When the User first selects the Work Items folder tab, or when the Selects Work 
Item button is clicked, the Select Work Items folder tab lists Work Items for the 
selected Contract.  The Work Items are listed in ascending order by Project 
Number then Item Code.  The User can find, filter, and sort the list.  If an Item 
has installed quantities for the selected DWR, the Installed (Instld) check box is 
checked (ON).  

 
The Select Work Items Folder Tab  

Figure 4-7 

Contractor 
must be 
entered first. 

Since this 
training 
software was 
developed in 
an earlier 
version of 
SiteManager, 
this screen 
may look 
slightly 
different when 
you are 
actually 
working in the 
system.  For 
example, the 
Instld Column 
is now on the 
far left and 
there is a new 
Category 
Description 
column. 
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When the Record Work Item button is clicked, the Record Work Items window 
displays usage information on the selected Item for the DWR. The Record Work 
Items window allows the User to view existing data for the Work Item or add 
new usage data.  

 
The Record Work Items Folder Tab  

Figure 4-8 

The Record Work Items window displays the following Item information: 

• Qty Reported to Date – Total quantity reported on DWRs. 

• Qty Authorized to Date – Total quantity reported on DWRs that were 
authorized in Diaries. 

• Units Type - The unit of measure for the pay item. 

• Qty Installed to Date – Total quantity reported on DWRs that were 
authorized in Diaries and included in approved and pending estimates. 

• Qty Paid to Date – Total quantity reported on DWRs that were 
authorized in Diaries and included in an estimate of any status. This 
value will always be the same as the Qty Installed to Date for TDOT 
when all estimates are approved. 

• Current Contract Qty - Current contract quantity of the Contract line item 
including any Change Orders. Current Quantity is calculated by the sum 
of Bid Quantity and the net Change Order quantity. 

TDOT is not 
using Pay To 
Plan Qty. 

Again, this 
screen may 
look slightly 
different when 
you get back 
to your office.  
An As Built 
Qty field is 
now directly 
below Placed 
Qty which 
TDOT does 
not plan to 
use.  Also the 
Measured 
Indicator is 
displayed 
different. 
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In TDOT, it is important to select the appropriate Category when documenting installed quantities on 
an item if that item exists in more than one Category.  The table below defines the various Categories 
used by TDOT.  Participating Categories are those paid by the normal funding source for the project.  
Non-Participating Categories are those paid by other funding sources than the normal funding source 
for the project.  Descriptions of the funding sources can be found in the Contract Funding window 
located at Main Panel>Contract Administration>Contract Records>Contract Funding.  If there are any 
questions concerning funding or if a Category needs to be added, please contact the Headquarters 
Finance Office. 

In TDOT, on the Record Work Items folder tab, the Placed Quantity, Contractor and Location are 
required information for each location sequence number.  TDOT will NOT use the As Built Qty field.  
Only the Prime Contractor and subcontractors approved to work on the work item can be selected as 
the Contractor.  If more than one contractor (prime or sub) performs work on the same Placed 
Quantity, the contractor performing most of the work should be selected.  While subcontractors may 
perform work on Add-On Items (non-bid items added with a quantity of zero and a line item number 
of 9000-9499), these must be recorded against the Prime Contractor because they will not appear as 
subcontracted items.  If the Placed Qty is not editable, a DWR template is required.  The Station 
Number fields should be used (if appropriate) for that item. 

In TDOT, installed work items from the DWRs authorized in the Diary window are used by the 
Contractor Payments component of SiteManager as the basis for paying the Contractor in an 
Estimate.   

A minimum TDOT DWR in SiteManager that reports installed quantities must include: 

• The weather conditions 

• The Work Performed remark, including the name of the contractor performing the work 

• The Contractor reported on the site, including personnel and equipment 

• The quantities at the item level that were installed 

• The location where the items were installed 

 

 

Item Types Participating 
Categories 

Non-Participating 
Categories 

Roadway Items 0100 0110 - 0190 

Box Bridge Items 0300 0310 - 0390 

Bridge Items 0500 0510 - 0590 

Maintenance & Other Items 0700 0710 - 0790 

Utility Items 0900 0900 - 0990 

Alternate Bid Items >1100 

TDOT Categories 

Table 4-1 
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 Exercise 4-7 

In the following exercise, you will record the details of a work item for the Prime 
Contractor for the DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. Scroll to and select Project Nbr 55019-3220-94, Line Item Number 0020, 
Category Number 0100, Item Code 201-01, Description CLEARING AND 
GRUBBING. 

2. Click the Record Work Item button. SiteManager displays the info on the 
Work Items panel. 

Now, let’s enter the information about that work item. 
3. Click the New button.  
4. In the Placed Qty field, type 0.20 
5. In the Contractor drop-down list, click the expand arrow and click Volunteer 

Bridge Construction, Inc.  
6. In the Location field, type Grey Road.  
7. Click the Save button.  
8. Click the Selects Work Item button to return to the contract item list. 
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Selecting and Recording to a DWR Template 

DWR Templates are used to record contract activity data that cannot be entered 
on standard SiteManager panels. DWR Templates can also calculate values for 
work items and those values can be returned to populate the Placed Qty field of 
the Daily Work Report. If an item has an associated template for the contract that 
returns a value, then the Placed Qty field can only be populated by that return 
value and recording data to DWR Templates. The list of DWR templates 
available for the item may be accessed with the DWR Template button. 

Any DWR Templates associated to the selected Item are available from the DWR 
Template window for viewing or entering data.  The DWR Template panel is 
accessed with the DWR Template button.  If the item requires the use of a 
template, the DWR Template panel automatically displays when the work item 
location and contractor data is saved. 

 
The DWR Template Button 

Figure 4-9 

The DWR Templates panel displays a list of the DWR Templates available for 
use with this Work Item. The user chooses which DWR Template associated to 
the selected Item to view or record data to. Once the DWR Template has been 
chosen the User can enter data into the template. 

 

The DWR Template Panel  

Figure 4-10 

This screen does not 
match the data in 
the training exercise, 
but does reflect the 
use of the SM01 
template. 
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The DWR Template 

Figure 4-11 

 

TDOT has developed a number of SiteManager DWR Templates similar to 
the forms currently used for calculating and recording item quantities. 
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 Exercise 4-8 
In the following exercise, you will use a DWR template to record a placed 
quantity to the DWR on April 11, 2005 for Contract CNB022I.   

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. Scroll to and select Project Nbr 55019-3220-94, Line Item Number 0310, 
Category Number 0100, Item Code 712-06, Description SIGNS 
(CONSTRUCTION). 

2. Click the Record Work Item button. SiteManager displays the info on the 
Work Items panel. 

Now, let’s enter the information about the work item. 
3. Click the New button.  
4. Why is the Placed Qty field gray and un-editable for this item?  

_____________________________________________________________ 
5. In the Contractor drop-down list, click the expand arrow and click 

International Traffic 
6. In the Location field, type BOP to EOP.  
7. Click the Save button. SiteManager displays the DWR Template window. 
8. What is the title of the window that displayed when the save button was clicked?  

_______________________________________________________________ 
9. Double-click Template ID 22A - Aluminum Signs. 
10. In the Sign Schedule field, type 12B. 
11. In the Legend field, type General Robert R Neyland Bridge 
12. In the Size field, type 24” x 60”. 
13. In the Area of Each Sign field, type 10.00. 
14. In the # of Signs field, type 40. 
15. Press the Tab key. 
16. What is displayed in the Pay Quantity field? ______________ 
17. Click the Save button. 
18. Click the Close button. 
19. Click the Remarks button. 
20. In the Remarks box, type this is an example Remark. 
21. Click the Remark button to close the Remarks window. 
22. Click the Save button. 
23. Click the Selects Work Item button to return to the contract item list. 

DWR Template Required 

DWR Template  

400.0

Point out the lines 
displayed on the 
Remarks button.  

Template 22A has 
been revised since 
this training was 
originally developed.  
There are actual 
fields on this 
template now for 
remarks. 

This step 
demonstrates the 
Select Work Item 
button. 
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 Exercise 4-9 

In the following exercise, you will record the details of a work item for the Prime 
Contractor for the DWR on April 18, 2005 for Contract CNB022J.   

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022J 

First, let’s open an existing a DWR. 
1. On the Daily Work Reports window, click the DWR Info folder 

tab. 
2. Click the Open button. 
3. In the Contract ID select box, click the Contract ID button to 

change the focus of the window. 
4. From the Contract ID select list, double-click Contract ID 

CNB022J. 
5. From the Inspector select list, double-click User ID jj05751 

(Warren, Jackie). 
6. From the Date select list, double-click DWR Date 04/18/05. 
7. The DWR will open.  Review the details on the DWR Info folder 

tab.   

Now, let’s add a remark. 
8. In the Remarks Type list box, scroll to and click Work Performed.   
9. In the Remarks text box, type Volunteer Bridge Construction, 

Inc. -  Test pile driven at 2:30 PM. 
10. Click the Save button. 

Now, let’s review some more of the information on this DWR. 
11. Click the Contractors folder tab.  Was the Prime Contractor on-site? 

______________________________________________________ 
12. Click the Contractor Equip. folder tab.  How many pieces of 

equipment are listed on this DWR? ________________________  
13. Click the Daily Staff folder tab.  How many agency staff members 

were on site _____________________________________________ 

Exercise setup: It is one 
week later, and users are 
opening a DWR that was 
created earlier in the day 
to record placed quantity 
totals. 

Yes - Volunteer Bridge Construction, Inc 

Five types (7 total pieces) 

Five 

Note: changing  
to contract J 
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Now, let’s record a new work item. 
14. Click the Work Items folder tab. 

15. Scroll to and select Project Nbr 55019-3220-94, Line Item Number 
0500, Category Number 0500, Item Code 606-09.01, Description 
TEST PILES (PRECAST CONCRETE, SIZE 1). 

16. Click the Record Work Item button. SiteManager displays the info 
on the Work Items panel. 

Now, let’s enter the information about that work item. 
17. Click the New button.  
18. Why is the Placed Qty field gray and un-editable for this item?  

________________________________________________________ 
19. In the Plan Page Nbr. field, type 6. 
20. In the Contractor drop-down list, click the expand arrow and click 

Volunteer Bridge Construction, Inc.  
21. In the Location field, type Abutment #1, Column B, Footing A.  
22. In the Station From fields, type 5 + 25 LT 45. 
23. In the Station To fields, type 5+ 50 RT 45. 
24. Click the Save button. SiteManager displays the DWR Template 

window. 
25. What is the title of the window that displayed when the save button 

was clicked?  
________________________________________________________ 

26. In the DWR Template list box, scroll to and click Template ID SM05, 
05-TEST PILING (ENGLISH). 

27. Click the Record Template Data button.   

Now, let’s enter the structure information. 
28. In the Structure Type field, click the drop-down arrow and click 

Bridge. 
29. In the Bridge Number field, type 1. 
30. In the Substructure Type field, click the drop-down arrow and click 

Abutment. 
31. In the Abutment Number field, type 1. 
32. In the Station/Position field, type 5+35 / RT CL.  
33. What is automatically populated in the Location field?  

________________________________________________________ 

We need to save 
this information, 
but be prepared; 
clicking Save will 
open the DWR 
Template window. 

DWR Template  

DWR Template Required 

If using any of 
the station fields, 
the others may 
not be left blank. 

Provide enough detail 
in the Location field 
so that it is easy for 
others to interpret. 

Bridge 1 - Abutment  

The purpose of this 
exercise is to show 
a multi-line 
template as 
opposed to a 
regular template 
used in the 
previous exercise. 
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Now, let’s enter the survey information 
34. In the BM field, type 380.000. 
35. In the RR field, type 9.9. 
36. In the PCO field, type 381.50. 
37. Notice the Survey Info fields HI, RRGR, and OP fields were 

automatically populated. 

Now, let’s enter the pile information. 
38. In the Pile Number field, type 8.  
39. In the Initial Length (ft) field, type 55.0. 
40. In the Added Length (ft) field, type 0. 
41. Note the Pay Quantity field is automatically populated. 
42. In the Heat Number (Steel) field, type N/A – Concrete Pile. 
43. In the Load field, type 100. 
44. In the Required Bearing field, type 150. 
45. In the Remarks field, type #8 driven to 1.5 times req bearing. 
46. Click the Save button. 

Now, let’s record the pile penetration below P. C. O. as 0 feet 0 inches to 24 feet 
0 inches.  

47. Under the (ft) label, verify 0. 
48. Under the (in) to label, verify 0. 
49. Under the (ft) label, type 24. 
50. Under the (in) label, verify 0. 
51. In the Refusal? field, verify the No radio button is selected (ON). 
52. Click in the Hammer Type field and click P+H/Pre-Drilled P+H. 
53. Click the Save button. 

Remaining portion of 
template exercise is in 
detail section of the 
template.  Remind 
students to be careful of 
place holder zeros.  

Users MUST TYPE THE 
ZEROS like in the 
number ten even if it 
appears that the zeros are 
there already.   

Remind users to 
press the Tab key to 
move between fields. 

Users need to click 
the New button each 
time they enter a 
new data set. 
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Now, let’s continue the driving log: 
54. Click the New button. 
55. In the (ft) field, type 24. 
56. In the (in) to field, verify 0. 
57. In the (ft) field, type 25. 
58. In the (in) field, verify 0. 
59. In the Refusal? field, verify the No radio button is selected (ON). 
60. In the Hammer Type field, click the expand arrow and click Single Action. 
61. In the Hammer Weight, W (lbs) field, type 3800. 
62. In the Hammer Stroke, H (ft) field, type 7.5.  
63. Press the Tab key. 
64. What is automatically populated in the Penetration (in) field? ______________ 
65. In the Number of Blows column, type 100. 
66. What is automatically populated in the Bearing (tons) field? ________________  
67. Click the Save button. 
68. What is the Pay Quantity? ___________________________________________ 

Now, let’s view the results of using the template. 
69. Click the Close button. 
70. What has been populated in the Placed Quantity field? _________________  
71. Click the Save button. 
72. Click the DWR Info. tab. 
73. To prepare for the summary exercise, click the New button. Set up for 

summary 
exercise: to 
prevent students 
from getting the 
“copy” message. 

129.545 

12.000 

55.0 

55.0 
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Review for Section 4 
To access the Daily Work Report window: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon. 

To enter basic DWR Info folder tab: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. In the High Temperature field, click the 
spin button to advance to or type the correct 
temperature. 

5. Press the Tab key. 
6. In the Low Temperature field, click the 

spin button to advance to or type the correct 
temperature. 

7. Press the Tab key. 
8. In the A.M. field, type the prevailing 

weather conditions for the A.M. hours of the 
work period. 

9. Press the Tab key. 
10. In the P.M. field, type the prevailing 

weather condition for the P.M. hours of the 
work period. 

11. To enter a remark, in the Remark Type list 
box, scroll to and click the desired remark 
type. Then type the remark in the Remarks 
field. 

12. Click the Save button. 

To enter Contractor activity: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Enter or modify basic DWR Info. 
5. Click the Save button. 
6. Click the Contractors folder tab. 
7. Modify the Contractor data appropriately. 
8. Click the Save button. 

To add a personnel type to a Daily Work Report: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Enter or modify basic DWR Info. 
5. Click the Save button. 
6. Click the Contractors folder tab. 
7. If there is more than one Contractor listed, 

click the Contractor who employs the 
worker. 

8. Click the Personnel Type field and click 
the New button. An empty row is added to 
the list. 

9. In the Personnel Type drop-down list, click 
the expand arrow and click the desired 
personnel type. 

10. Press the Tab key. 
11. In the Nbr of Persons field, type the 

number of workers of this Personnel Type 
who worked on this date. 

12. Click the Save button. 
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To add equipment to a Daily Work Report: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Enter or modify basic DWR Info. 
5. Click the Save button. 
6. Click the Contractors folder tab. 
7. Add the contractor who supplied the 

equipment. 
8. Click the Save button. 
9. Click the Contractor Equipment folder 

tab.  
10. If there is more than one Contractor listed, 

click the Contractor who supplied the 
equipment. 

11. Click the Equipment ID field and click the 
New button. An empty row is added to the 
list. 

12. In the Equipment ID drop-down list, click 
the expand arrow and click the desired 
equipment ID. 

13. Press the Tab key. 
14. In the Nbr of Pieces field, type the number 

of pieces of this equipment present on this 
date. 

15. Press the Tab key. 
16. In the Nbr Used field, type the number of 

pieces of this equipment used on this date. 
17. Click the Save button. 

To add Daily Staff to a Daily Work Report. 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Click the Daily Staff folder tab. 
5. Click the New button on the toolbar. 
6. In the Staff Member drop-down box, click 

the name of the staff member you want to 
add.  

7. In the Reg. Hours field, type the number of 
hours the staff member worked.  

8. Click the Save button. 
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To select and record a Work Item: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon.  

3. Open an existing unauthorized, unlocked 
DWR created by you or create a new DWR. 

4. Enter or modify basic DWR Info. 
5. Click the Save button. 
6. Click the Contractors folder tab. 
7. Add the contractor who installed the work 

item(s). 
8. Click the Save button. 
9. Click the Work Items folder tab.  
10. In the Work Item list box, scroll to and 

click the work item whose installation needs 
to be recorded. 

11. Click the Record Work Item button.  
12. Click the Location Installed field and click 

the New button.  An empty row is inserted 
on the Record Work Item List.   

13. In the Placed Qty field, type the quantity of 
the item installed at this location. 

14. Press the Tab key. 
15. In the Plan Page Nbr field, type the page 

number of a reference to the installed item. 
16. In the Contractor drop-down list, click the 

expand arrow and click the name of the 
Contractor responsible for the installed item. 

17. Press the Tab key. 
18. In the Location field, type the location 

where the item was installed. 
19. In the From Station field, type the Station 

ID that identifies where the installation of 
this Work Item starts. 

20. Press the Tab key. 
21. In the From Station Offset field, type the 

offset from the Station ID that identifies 
where the installation of this Work Item 
starts. 

22. Press the Tab key. 
23. In the From Station Distance field, type the 

offset distance from the Station ID that 
identifies where the installation of this Work 
Item starts. 

24. Press the Tab key. 
25. In the To Station field, type the Station ID 

that identifies where the installation of this 
Work Item ends. 

26. Press the Tab key. 
27. In the To Station Offset field, type the 

offset from the Station ID that identifies 
where the installation of this Work Item 
ends. 

28. Press the Tab key. 
29. In the To Station Distance field, type the 

offset distance from the Station ID that 
identifies where the installation of this Work 
Item ends. 

30. Click the Save button. 
31. Repeat steps 12-31 for additional locations 

where the work item was installed on this 
workday. 

32. When complete, click the Select Work 
Item button to select additional items for 
recording or return to the current DWR. 

To Record Work Item Data to DWR Templates: 

1. To invoke the DWR Template window click 
on the DWR Template button or select 
Edit/View Work Item Template Data 
from the Services menu. 

2. The DWR Template ID window displays the 
Templates available for use with the 
selected Work Item. Choose a DWR 
Template to record data to and click the 
Record Template Data button or choose 
Record Template Data from the Services 
menu. The DWR Template is displayed. 

3. Enter the appropriate data into the fields of 
the DWR Template. 

4. Click the Save button or select Save from 
the File menu when the data is fully entered 
into the Template. 

5. Click the Close button or select Close from 
the File menu to return to the Record Work 
Item window. The Placed Qty field is now 
populated with the value from the DWR 
Template and the Templt Used box is 
checked. 

 

 

 

Key to recording DWR data is 
accuracy.  The placed quantity 
recorded in a DWR is the 
quantity that will be paid on an 
estimate, barring any test report 
or other adjustments. 

“Garbage in = garbage out” 
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10.6 

Summary Exercise for Section 4 
In the following exercise, you will create a DWR for April 19, 2005 for Contract CNB022J using 
the information provided below. 

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

Weather conditions: 
• High - 70 degrees 
• Low - 49 degrees 

• AM -Partially Cloudy  
• PM - Partially Cloudy 

Remarks: 
• Work Performed: Volunteer Bridge installed 18” RCP at station 16+75 RT 

Centerline. 
Personnel:   

• Foreman – 1 
• Class “B” Operator – 2 

• Class “D” Operator – 1 
• Truck Driver (3/4 axels) – 2 

Equipment (on site and used)  
• Backhoe/Hydraulic Excav - 1 
• Pickup Truck – 3 
• Bull Dozer – 1 

• Bobcat – 1 
• Haul Truck – 2 

Daily Staff  
• Warren, Jackie – 7.5 hours • Johnson, Terry – 7.5 hours 

Items: 
1. Item Code 204-07, BEDDING MATERIAL (PIPE) CLASS B (Project 55021-3214-94, 

Line Item Nbr 0643, Category Number 0100): 
• Plan Page Nbr: 4A 
• Contractor: Volunteer Bridge 

Construction, Inc. 
• Location: Station 16+75 RT 

Centerline 
• Template SM10E 

• Culvert Type: Concrete Pipe 
• Pipe Diameter (in): 18 
• Length (ft): 50.000 

What is the pay quantity for this 
item?__________________________________________________ 

2. Item Code 607-39.02, 18” PIPE CULVERT (Project 55019-3220-94, Line Item Nbr 
0200, Category Number 0100): 

• Contractor: Volunteer Bridge 
Construction, Inc. 

• Location: Station 16+75 RT 
Centerline 

• Placed Quantity: 50 

When complete, navigate to the Daily Work Reports panel. 
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Learning Module 

 Section 5  Daily Work Reports II 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Copy a Daily Work Report 

• Modify a Daily Work Report  
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Copying a Daily Work Report 

After creating the first Daily Work Report for a new Contract, it is easier to copy 
an existing DWR rather than creating a new one from scratch.  A copied Daily 
Work Report copies the following data to a new Daily Work Report. 

• Contractor 

• Personnel (Including number of persons) 

• Equipment (Including number of pieces and number used) 

• Daily Staff (Including hours) 

A copied DWR will not include the following data from the original Daily Work 
Report: 

• Basic DWR Info 

• Installed Work Items and Templates 

To copy a DWR, the user simply changes the date on any existing DWR. This 
prompts the user to confirm the contractor data should be copied to the new 
DWR date.  You may use the calendar to indicate the new DWR date, or you 
may type the new date over the existing date in the date field. 

Tip: The User copying it must have authored the DWR being copied. 

The DWR Info Folder Tab  

Figure 5-1 

In TDOT, the following must be entered on the DWR Info folder tab on a 
copied DWR: 

• Date 
• Temperature 
• Weather Conditions  

• Work Performed Remarks, 
including contractor name 

• Appropriate Remarks 

To copy a 
DWR, the user 
simply changes 
the date on any 
existing DWR. 
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 Exercise 5-1 
In the following exercise, you will copy an existing DWR for April 18, 2005 to create 
a new DWR for April 20, 2005 on Contract CNB022J. 

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022J 

First, open the DWR you wish to copy from (4/18/05): 

1. On the Daily Work Reports panel, double-click the Daily Work Reports icon. 
2. Click the Open button. SiteManager displays the Contract ID window. 
3. In the Inspector list box, scroll to and double-click jj05751. 
4. In the Date list box, scroll to and double-click the DWR Date 04/18/05. 

SiteManager displays the Daily Work Reports window. 

Now, let’s copy the contractor information from the 4/18/05 DWR to a new DWR for 
4/20/05.  

5. In the DWR Date field, type 042005. 
6. On the keyboard, press the Tab key. SiteManager displays a message prompting 

you to confirm your desire to copy the contractor information. 
7. In the message, click the Yes button. 
8. Click the Save button. 

Now, let’s enter the temperatures and conditions for 4/20/05. 
9. In the High Temperature field, type 71. 
10. In the Low Temperature field, type 52. 
11. In the A.M. drop-down list, click the expand arrow to the right of the current 

selection and click Sunny. 
12. In the P.M. drop-down list, click the expand arrow to the right of the current 

selection and click Sunny. 

Now, let’s enter a remark for 4/20/05. 
13. In the Remarks Type list box, scroll to and click Work Performed. 
14. In the Work Performed text box, type Volunteer Bridge driving Production 

Piling. 
15. Click the Save button. 
 

Users may 
also use the 
calendar to 
pick a date. 

Stress this! 

To be 
prompted 
to copy 
contractor  
info, after 
typing or 
choosing 
the new 
date, Tab 
out of the 
DWR Date 
field, save  
or click into 
another 
field. 
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Modifying a Copied Daily Work Report 

Once a Daily Work Report is copied, the User may modify the Contractors, and 
Personnel Types, Equipment, and Daily Staff on the new DWR to reflect the 
activities of the day.  

The Contractors Folder Tab 

The Contractors (Prime and Sub), and Personnel Types as well as the number of 
workers may be modified on the Contractors folder tab.  

 

The Contractors Folder Tab 

Figure 5-2 

Auto 
populated – 
DON’T 
ENTER. 



Modifying a Copied Daily Work Report Trns•port SiteManager® Learning Guide 
Field Reporting  Section 5  Daily Work Reports II 

 

 

 133 

 Exercise 5-2 
In the following exercise, you will modify the contractors, supervisors, and personnel 
types for a copied DWR on April 20, 2005 for Contract CNB022J.  

User ID: jj05751 Group: INSPST Mode: Standalone Contract: CNB022J 

1. On the Daily Work Reports window, click the Contractors folder 
tab.   

2. Click the Contractor Volunteer Bridge Construction, Inc.  

3. Click the Personnel Type area select the Unskilled Laborer 
personnel type. 

4. In the Nbr of Persons field, type 5 (overwriting  the 4). 

5. Click the Save button.  

Now, let’s add a subcontractor. 

6. Click the Contractor area. 

7. Click the New button.  An empty row is added to the list. 

8. In the Contractor drop-down list, click the expand arrow to the right 
of the current selection and click WMC Contracting Company, Inc.  

9. Click the Save button.  

Now, let’s add personnel type for that subcontractor. 

10. Click the Personnel Type area. 

11. Click the New button. An empty row is added to the list. 

12. In the Personnel Type drop-down list, click the expand arrow to the 
right of the current selection and click Class “D” Operators. 

13. For the Class “D” Operators personnel type, in the Nbr of Persons 
field, type 1. 

14. Click the Save button.  

Now, let’s add another personnel type for that subcontractor. 

15. Click the New button. An empty row is added to the list. 

16. In the Personnel Type drop-down list, click the expand arrow to the 
right of the current selection and click Foreman. 

17. For the Foreman personnel type, in the Nbr of Persons field, type 1. 

18. Click the Save button.  

Users are 
modifying the 
number of 
Laborers on 
the DWR. 
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Now, let’s add another personnel type for that subcontractor. 

19. Click the New button. An empty row is added to the list. 

20. In the Personnel Type drop-down list, click the expand arrow to the 
right of the current selection and click Unskilled Laborer. 

21. For the Unskilled Laborer personnel type, in the Nbr of Persons 
field, type 4. 

22. Click the Save button.  

Now, let’s add another personnel type for that subcontractor. 

23. Click the New button. An empty row is added to the list. 

24. In the Personnel Type drop-down list, click the expand arrow to the 
right of the current selection and click Truck Driver (2 axles). 

25. For the Truck Driver (2 axles) personnel type, in the Nbr of Persons 
field, type 1. 

26. Click the Save button. 
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The Contractor Equip. Folder Tab 

The contractor’s equipment, number of pieces and the number of pieces used 
may be modified on the Contractor Equipment folder tab. 

 

The Contractor Equip Folder Tab 

Figure 5-3 
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 Exercise 5-3 
In the following exercise, you will modify a Contractor’s equipment list for a copied 
DWR on April 20, 2005 for Contract CNB022J.  

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. On the Daily Work Reports window, click the Contractor Equip 
folder tab.   

2. In the Contractor area, click WMC Contracting Company, Inc.  
3. Click the Equipment ID-Description area. 
4. Click the Save button.  

Now, let’s add an equipment type for that subcontractor. 
5. Click the New button.  An empty row is added to the list. 
6. In the Equipment ID-Description drop-down list, click the expand 

arrow to the right of the current selection and click Farm Tractor.  
7. In the Nbr of Pieces field, type 1.  
8. In the Nbr Used field, type 1. 
9. Click the Save button.  

Now, let’s add another equipment type for that subcontractor. 
10. Click the New button.  An empty row is added to the list. 
11. In the Equipment ID-Description drop-down list, click the expand 

arrow to the right of the current selection and click Haul Truck.  
12. In the Nbr of Pieces field, type 1.  
13. In the Nbr Used field, type 1. 
14. Click the Save button. 

Now, let’s add another equipment type for that subcontractor. 
15. Click the New button.  An empty row is added to the list. 
16. In the Equipment ID-Description drop-down list, click the expand 

arrow to the right of the current selection and click Pickup Truck.  
17. In the Nbr of Pieces field, type 2.  
18. In the Nbr Used field, type 2.  
19. Click the Save button. 
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Now, let’s delete a piece of equipment type for the Prime Contractor. 
20. In the Contractor area, click Volunteer Bridge Construction, Inc. 
21. In the Equipment ID-Description list, click the Crane.  
22. Click the Delete button. 
23. Click Yes to the delete message. 
24. Click the Save button. 
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The Daily Staff Folder Tab 

The Daily Staff and the hours on site may be modified on the Daily Staff folder 
tab.  

 

The Daily Staff Folder Tab 
Figure 5-4 

 Exercise 5-4 
In the following exercise, you will modify the Daily Staff for a copied DWR on April 
20, 2005 for Contract CNB022J.  

User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. On the Daily Work Reports window, click the Daily Staff folder 
tab.   

2. In the Staff Member area, click Miller, Chris.  
3. Click the Delete button. SiteManager displays a message to confirm 

deletion. 
4. In the message, click the Yes button. 
5. In the Staff Member area, click Roberts, Jan.  
6. Click the Delete button. SiteManager displays a message to confirm 

deletion. 
7. In the message, click the Yes button. 

Now, let’s modify the hours for the daily staff. 
8. In the Staff Member area, click Johnson, Terry. 
9. In the Reg Hours field, type 7.5. 
10. In the Staff Member area, click Warren, Jackie. 
11. In the Reg Hours field, type 9. 
12. Click the Save button. 
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The Work Items Folder Tab 

Work Item details do not copy from one DWR to another.  Work item details for 
the new Daily Work Report may be recorded on the Work Items folder tab.  

The Work Items Folder Tab 

Figure 5-5 

 Exercise 5-5 
In the following exercise, you will record work item details for a copied DWR on 
April 20, 2005 for Contract CNB022J.  
User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022J 

1. On the Daily Work Reports window, click the Work Items folder 
tab. 

2. Scroll to and select Project Number 55019-3220-94, Line Item 
Number 0520, Category Number 0500, Item Code 606-09.03, 
Description PRECAST CONCRETE PILES (SIZE 1). 

3. On the toolbar, click the Record Work Item button. 
4. Click the New button. 

Now, let’s record the details about the work item. 
5. In the Plan Page Nbr field, type 9. 
6. In the Contractor drop-down list, click the expand arrow and click 

Volunteer Bridge Construction, Inc. 
7. In the Location field, type Bent to 10+90 Column A, Footing D. 

Now, let’s choose a template. 
8. Click the Save button. SiteManager displays the DWR Template list 

box. 

This exercise will 
demonstrate the use 
of a detail multi-line 
template to record 
pile driving data and 
determine the placed 
quantity of the item. 

Again, this 
screen may 
look slightly 
different when 
you get back 
to your office.  
An As Built 
Qty field is 
now directly 
below Placed 
Qty which 
TDOT does 
not plan to 
use.  Also the 
Measured 
Indicator is 
displayed 
different. 
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9. In the DWR Template list box, click SM07 - 07 CONCRETE/ 
TIMBER PRODUCTION PILING (ENGLISH). SiteManager 
displays a DWR Template window. 

10. Click the Record Template Data button. 
Now, let’s enter the structure data. 

11. In the Structure Type drop-down list, click the expand arrow and 
click Bridge. 

12. In the Bridge Number field, type 1. 
13. Click in the Substructure Type drop-down list and click Bent. 
14. In the Bent Number field, type 2. 
15. Note that the Location field is automatically populated. 
16. In the Station/Position field, type 10+90 Column A, Footing D.   
17. In the Length Set field, type 35.0. 
18. In the Required Bearing field, type 90.0. 
19. Click the Save button. 

Now let’s enter the pile information. 
20. In the Pile Number field, type 1. 
21. In the Initial Length (ft) field, type 35.0. 
22. In the Pile Stripped for Seismic? (-2’) field, click the Yes radio button 

(ON). 
23. In the Cut-Off (ft) field, type 4.0. 
24. In the Refusal? field, select the Yes option. 
25. Click the Save button. 
26. What is the Total Pay Quantity? ______________________________   

Now, let’s review the results. 
27. Click the Close button. 
28. Note the Placed Qty field has been populated. 
29. What was the total placed quantity? ___________________________ 

Remaining 
portion of 
template exercise 
is in detail section 
of the template.  
Remind students 
to be careful of 
place holder 
zeros. 

29.0 

29.0 
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Creating and Using Attachments 
The Attachment functionality of SiteManager allows URL links, Plug-In 
applications, and OLE attachments to be attached to certain SiteManager records.  

Attachments are activated by clicking the attachment button, then double-
clicking the attachment. 

Creating an OLE Attachment 

The Microsoft Windows’ Object Linking and Embedding standard (OLE) allows 
Windows programs like SiteManager to access the functionality of other OLE-
compliant Windows applications.  The Attachments feature choice will work 
with any properly-installed, OLE-compliant Windows application.   

When you use the OLE functionality to create a new attachment, you are actually 
embedding the data and the connection to the application’s functionality in the 
SiteManager database.  Even though the OLE object is assigned a name, the data 
does not actually exist as an external file on your network or workstation hard 
drive.  It only exists as a named object in the SiteManager database.  Anyone 
with access to the record can assess the embedded data if the application that 
created the data is installed on their workstation. 

 

Insert Object Dialog Invoked by the New OLE button 

Figure 5-6 
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TDOT field Office Staff will use the Plug-In Attachment function in the Contracts 
window to run the plug-ins that adjust the estimate.  

TDOT will use the URL Attachment function in the System Attachment window to 
access additional resources such as the TDOT File Management system.  

TDOT field Office Staff and Inspectors will use the OLE Attachment function in the 
DWR window to attach an Excel or Word document to a recorded work item.  An 
example would be when work has begun on an item before the Change Order 
adding that item has been approved in the system.  In this case, work will be 
tracked using the SiteManager Loose Leaf Forms stored in File Management 
(accessible via a URL link in the System Attachments window). Once the Change 
Order item has been added to the contract, a “catch-up” quantity should be placed 
on the item and all supporting SiteManager Loose Leaf Forms should be attached to 
the quantity.   

The OLE Attachment function should not be used to attach .jpg, .bmp or other 
picture file types.  These should be saved in the File Management System.   

When selecting security groups for attachments, it is recommended to choose “Add 
All” to add all security groups to the attachment.   

Entering a Remark such as “View Attachment” will indicate to users when viewing 
reports that an attachment exists.  
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 Exercise 5-6 
In the following exercise, you will create an attachment on a DWR Work Item on 
DWR date 4/20/05 on Contract CNB002J.  

User ID: jj05751       Group: INSP      Mode: Standalone  Contract: CNB022J 

1. Click the Attachments button on the toolbar.   
2. Click the New OLE button on the toolbar.   
3. Click the Create From File folder tab.   
4. Click the Browse button.   
5. Select the file to be attached: 

C:\SMTRAINS\SMFILES\Attachment.xls 
6. Click the Open button.   
7. Click the OK button.   
8. In the Name field, type Example. 
9. In the Description field, type Calculations. 
10. In the Attachment Security box, click the Add All button.   
11. Click the Add button.   
12. Click the Attachments button.  
13. Click the Save button. 
14. Click the Remarks button.  
15. In the Remarks field, type View Attachment. 
16. Click the Remarks button to close the Remarks window. 
17. Click the Save button. 
18. Click the Attachments button. 
19. Click the Run Attachment button.  
20. In the Excel worksheet, click the Exit button to close the attached 

document and program. 
21. Click the Save button. 

Now, let’s prepare for the Summary Exercise. 
22. Click the DWR Info folder tab. 

The Excel file may 
be minimized at the 
bottom of your 
computer, on the 
task bar. 

The Description 
field is important 
for identifying the 
contents of the 
attachments. 
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Review for Section 5 
To create a new Daily Work Report using the copy 
function: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon. 

3. Click the Open button. 
4. In the Contract ID list box, scroll to and 

double-click desired Contract. 
5. On the Inspector list box, scroll to and 

double-click your User ID.   
6. On the Date list box, scroll to and double-

click desired DWR Date.  It may not be a 
locked or authorized DWR. 

7. Double-click the Date field.  The calendar 
appears. 

8. Advance to the correct month and click the 
correct date for the new Daily Work Report. 

9. Click Ok.   
10. Click the Yes button for the message box 

asking if Contractor information should be 
copied. 

11. Click the Save button. 
12. Click the desired folder tab. 
13. Modify the data appropriately. 
14. Click the Save button. 
 

To attach a file to a record: 

1. Click the Attachment button. 
2. Click the New OLE button. 
3. Click the Create from File folder tab. 
4. Click the Browse button. 
5. Select the drive and file name for the file to 

be attached. 
6. Click the Open button. 
7. Click Ok.   
8. In the Name field, type the name for the 

document. 
9. In the Attachment Security box, click the 

Add All button to add all groups to the 
Access box. 

10. Click the Add button. 
11. Click the Attachment button.. 
12. Click the Save button. 
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Summary Exercise for Section 5 
In the following exercise, you will modify a copied DWR for Contract CNB022L. 
User ID: jj05751 Group: INSPST Mode: Standalone  Contract: CNB022L 

Use the Daily Work Report from Jackie Warren (jj05751) for Contract CNB022L on 11/21/05 to 
copy and create a new DWR for 11/22/05.  Be sure to copy the Contractor information for use in the 
following steps. 

Temperature and Weather conditions: 
• High - 59 degrees 
• Low - 36 degrees 

• AM -Partially Cloudy  
• PM - Clear 

Remarks: 
• Work Performed: International Traffic Systems, Inc Installed permanent 

signs. 
Personnel for Prime Contractor, Volunteer Bridge Construction, Inc. (update the record as 
necessary):   

• Class “A” Operators – 1 
• Unskilled Laborer – 4 

• Sweeping Machine (Vacuum) – 1 
• Truck Driver (3/4 axles) – 1 

 
Personnel for Subcontractor, International Traffic Systems, Inc. (update the record as 
necessary):   

• Foreman – 1 
• Unskilled Laborer – 4 

• Skilled Laborers – 3 
• Truck Driver (2 axles) – 1 

 
Equipment for Volunteer Bridge Construction, Inc. (update the record as necessary):   

• Pickup Truck – 2 
• Backhoe – 1 

• Haul Truck – 1 
• Sweeping Machine – 1 

 
Equipment for International Traffic Systems, Inc. (update the record as necessary):   

• Pickup Truck – 2 • Haul Truck – 1

Exercise continues on the next page. 
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Daily Staff  
• Warren, Jackie – 9 hours • Johnson, Terry – 9 hours

Items: Record the following information for Line Item Nbr 0310 Project 55019-3220-94, Item 
Code 712-06:

• Plan Page Number: 16 
• Contractor: International 

Traffic Systems, Inc. 

• Location: BOP to EOP 
• Template: SM22A 

Record the following information for template SM22A:
• Sign Schedule #: 12B 
• Legend: General Robert 

R. Neyland Bridge 

• Size: 24” x 60” 
• Area of Each Sign: 10.0 
• # of Signs: 4

What is the placed qty for this item at this location? ___________________ 

Exit SiteManager.  
 

40.0 
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Learning Module 

 Section 6  From PM to Server 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Upload Data to the Server 

• View Pipeline Information 
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Overview 

Pipeline is the process that automates the transfer of data. SiteManager provides 
the Pipeline processes because Contract data must be downloaded and uploaded 
often during the life of a Contract. In general, the data downloaded from the 
Server is the Basic Contract Data, which is primarily the Contract specifications. 
The data uploaded to the Server is the Contract activity data, which is the work 
done on the Contract. Pipeline automates the data flow from the: 

• Server to Standalone Mode (PM) 

• Standalone Mode (PM) to Server 

 

Pipeline The pipeline process transfers data files from one database to 
another. In SiteManager, the User uses the pipeline process to 
download data directly from the server’s database to the standalone 
workstation’s database, and to upload data directly from the 
standalone workstation’s database to the server’s database.  

 

The Pipeline Panel 

When logging on to SiteManager to Pipeline data, the User connects to the server 
database. 

 

The Pipeline Panel 

Figure 6-1 

PM = Standalone 

Think of PM as 
Personal Machine 

Upload contract data 
on a regular basis to 
avoid problems if 
somebody leaves near 
the end of a contract. 
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The following table shows how the Pipeline panels are used to transfer data.  

Step Activity Process Pipeline Panel 

1 Download 
Basic Contract 
Data from the 
Server 

The User selects and downloads basic 
contract data from the server’s database to 
the standalone workstation’s database using 
the Server to PM Pipeline panel. The 
Pipeline process loads the data directly into 
the User’s standalone database. Before 
DWRs can be generated in Standalone mode, 
the User must download Basic Contract Data 
from the Server. 

Server to PM Pipeline panel

2 Create Daily 
Work Reports 

The User creates and modifies DWRs on the 
contract to report the usage of Labor, 
Equipment, and Items on the Contract. 

As DWRs are created, they 
are listed on the DWR 
Select folder tab in the PM 
to Server window. 

3 Upload Daily 
Work Reports 
to the Server 

The User selects and uploads DWRs from 
the standalone workstation to the Server. 

PM to Server Pipeline panel

4 View Pipeline 
History 

The User can view a history of Pipeline 
activity. 

Pipeline Information panel 

5 Download 
Basic Contract 
Data and Daily 
Work Reports, 
as needed. 

New data is added to the Contract on the 
Server only. The User downloads new 
Contract data as it becomes available. The 
new data updates the standalone database. 
The User can also download Daily Work 
Reports. 

Download Basic Contract 
Data and Daily Work 
Reports as needed. 

NOTE: Basic Contract Data 
includes all Change Order 
information. 

6 Release the 
Contract 

When the Contract work is done, the User 
uses Pipeline to release the Contract back to 
the Server. 

PM to Server Pipeline panel

The Pipeline Process Table 

Table 6-1 

 

In TDOT, the Inspector must always check out Basic Contract Data when 
pipelining a contract to Standalone mode on his/her computer for the first 
time.  It is required that the Basic Contract Data be pipelined to Standalone 
mode a minimum of twice a week to ensure that the Standalone database has 
the most current contract information. 

 

 



Trns•port SiteManager® Learning Guide Check In — Uploading Data from PM to the Server 
Section 6  From PM to Server Field Reporting  
 

 

150  

Check In — Uploading Data from PM to the Server  

The PM to Server Pipeline panel lets the User upload (check in) data from the 
standalone database to the server. When logging on to SiteManager, the User 
must connect to the server database. The pipeline process transfers the selected 
data directly from the User’s standalone database to the server database. 

To upload Contract data to the server, the User must first select a Contract and 
then select the Daily Work Reports to upload.  

To release the Contract when the Contract work is completed, and all DWRs 
have been pipelined to the server, the User checks the Basic Contract Data box. 
After the User selects the data to upload, the pipeline process is triggered by 
selecting the Services menu Pipeline Data option. 

PM to Server Pipeline Summary 

The PM to Server Pipeline Summary folder tab shows the number of Daily Work 
Reports selected. When the User selects the Services menu Pipeline Data option, 
the selected data is extracted from the standalone workstation. 

 

The Pipeline Summary Folder Tab 

Figure 6-2 

In TDOT, the User should pipeline DWRs to the server as soon as possible 
or as needed for an estimate. It is required that the Daily Work Report 
Data be pipelined to Server mode a minimum of  twice a week to ensure 
that the Server database has the most current contract information. 
In TDOT, at the end of the contract, the User should pipeline the  
Basic Contract Data from the standalone database back to the Server. 

The pipeline process 
loads the data directly 
from the User’s 
standalone database to 
the server database. 

 

To include current 
data in an estimate, 
make sure all DWRs 
have been uploaded 
before generating the 
estimate.  

The Basic Contract 
Data check box 
releases the 
contract when all 
work is done. 

The DWR folder 
tab is identical to 
the one in the 
Server to PM 
Pipeline window.

The Check In Status 
field displays the 
activity and complete 
status of the pipeline 
process. 

Why do you Pipeline 
Basic Contract Data? 
To keep the Contract 
Select list small. 
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 Exercise 6-1 
In the following exercise, you will navigate  to Server Pipeline panel and select 
Contract CNB022N. 

User ID: jj05751 Group: INSP  Mode: Server  Contract: CNB022N 
1. Double-click the SiteManager Training program icon on the desktop. 
2. In the User ID field, type jj05751. 
3. In the Password field, type pass. 
4. Click the Logon button. 

Now, let’s open the Pipeline panel and select a contract. 
5. On the Main Panel, double-click the Pipeline icon. 
6. On the Pipeline panel, double-click the PM to Server Pipeline icon. 

SiteManager displays the PM to Server Pipeline window. 
7. On the toolbar, click the Open button. 
8. In the Contract ID list box, scroll to and double-click Contract CNB022N. 
9. Click the DWR Select folder tab.  

Shift-tab if user 
ID not 
highlighted. 
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Selecting Daily Work Reports 

When the User clicks the DWR Select folder tab on the PM to Server Pipeline 
panel, the panel displays a list of Daily Work Reports that have not been 
uploaded to the server. The User selects the Daily Work Reports to upload.  

 

The DWR Select Folder Tab 

Figure 6-3 

 
In TDOT, completed Daily Work Reports should be pipelined from 
Standalone mode to Server mode as soon as possible or as needed for an 
Estimate.  It is required that the Daily Work Report Data be pipelined to 
Server mode a minimum of  twice a week to ensure that the Server 
database has the most current contract information. 
Diaries will always be created in Server mode and do not need to be 
pipelined. 
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 Exercise 6-2 

In the following exercise, you will upload data from Contract CNB022N to the 
server.  

User ID: jj05751 Group: INSP  Mode: Server  Contract: CNB022N 
1. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/18/05.  
2. Click the Add button. 
3. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/19/05. 
4. Click the Add button. 
5. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/20/05. 
6. Click the Add button. 
7. Click the Pipeline Summary folder tab. Note that you have selected 

3 DWRs. 
8. Click the Services menu. 
9. Click the Pipeline Data choice. The SiteManager training 

application displays an SQL error. In the error message, click the 
Continue button. 

10. The Check In Status field message confirms that check-in is 
complete. Note that the DWRs field now shows 0. This confirms that 
the DWRs have been pipelined. 

11. Click the Close button. 

This is due to 
the training 
database. 
This does not 
occur in 
production. 
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Viewing Pipeline Information 

The Pipeline Information panel lets the User view Pipeline information about 
Daily Work Reports (DWRs). The Pipeline Information panel shows a history of 
Pipeline activity, such as when the data was downloaded and uploaded, and who 
downloaded or uploaded the data.  

The Pipeline Information panel displays information that applies to the selected 
Contract. When the User is connected to the server, the panel shows information 
on data uploaded and downloaded to and from the server. When the User is 
connected to the standalone database, the panel shows information on data 
uploaded and downloaded to and from the workstation. 

 

The Contract Folder Tab 

Figure 6-4 

 

In TDOT, the Pipeline Information panel can be used by the Project 
Supervisor to check the frequency of pipelining activities to ensure 
standalone contract data is pipelined up regularly.  It may also be used to 
verify that checked out DWRs have been pipelined to the server prior to 
generating an estimate. 

 

Check Out Date/Check 
Out Time refers to 
transferring data from 
the Server to PM.  

Check In Date/Check In 
Time refers to 
transferring data from 
PM to Server.  
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 Exercise 6-3 

In the following exercise, you will view a history of Pipeline activity on Contract 
CNB022N.  

User ID: jj05751 Group: INSP  Mode: Server  Contract: CNB022N 
1. On the Pipeline panel, double-click the Pipeline Information icon. 
2. Click the Contract folder tab. 
3. When was Contract CNB022N checked out by User jj05751? 

_______________________________________________________ 
4. Click the DWRs folder tab. 
5. How many DWRs has jj05751 (Jackie Warren) checked in? 

_______________________________________________________ 
6. Click the Close button. 

04/08/05 

3 

Project 
Supervisors 
will use this 
to see how 
often 
Inspectors 
are 
uploading. 
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Daily Work Report Applicability 

Daily Work Report data is transferred using the Pipeline function. To begin 
working on a Contract, the User must first download Basic Contract Data from 
the Server. ‘Basic Contract Data’ includes all of the Contract data required to 
process the Daily Work Reports, including Change Orders, Subcontracts, and 
Master Lists. Daily Work Reports can be downloaded from the Server and edited 
only if they are unauthorized and not included on a paid Estimate.  

Pipeline is used to: 

• Download Basic Contract Data, which includes Change Orders and Subcontracts, from the Server at 
least twice a week 

• Upload Daily Work Reports to the Server at least twice a week 

• Upload the Contract when work is done 
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Review for Section 6 
To upload data to the server: 

1. When logging on to SiteManager, connect 
to the server database. 

2. On the SiteManager main panel, double-
click the Pipeline icon. 

3. On the Pipeline panel, double-click the PM 
to Server Pipeline icon. The Pipeline 
Summary folder tab is displayed. 

4. To select a Contract, click the Open button. 
5. In the Contract ID list box, scroll to and 

double-click the Contract. 
6. To release the Contract, click the Basic 

Contract Data check box (ON). 
7. To select Daily Work Reports, click the 

DWR Select folder tab. 
8. In the DWR list box, shift-click each Daily 

Work Report to be uploaded. 
9. Click the Add button. The selected Daily 

Work Reports are added to the Selected 
DWRs list. 

10. Click the Pipeline Summary folder tab. 
The panel displays the total number of 
Diaries, Daily Work Reports, and Samples 
selected. 

11. To upload the selected data to the Server, 
click the Services menu and click the 
Pipeline Data choice. 

To view a history of Pipeline  activity: 

1. When logging on to SiteManager, to view 
information on data transferred to and from 
the server, connect to the server database. 
To view information on data transferred to 
and from the workstation, connect to the 
standalone database. 

2. On the SiteManager main panel, double-
click the Pipeline icon. 

3. On the Pipeline panel, double-click the 
Pipeline Information icon. The Samples 
folder tab is displayed. 

4. To select a Contract, click the Open button. 
5. In the Contract ID list box, scroll to and 

double-click the Contract. 
6. To view Pipeline information for the 

selected Contract, click the Contract folder 
tab. 

7. To view Pipeline information on Daily 
Work Reports for the selected Contract, 
click the DWRs folder tab. 

8. To view Pipeline information on Change 
Orders for the selected Contract, click the 
Change Orders folder tab. 
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Summary Exercise for Section 6 

In the following exercise, you will pipeline data to the Server on Contract CNB022N.  

User ID: jj05751         Group: INSP           Mode: Server           Contract: CNB022N 

1. For Contract ID CNB022N, upload the following DWRs for Warren, Jackie to the Server: 
DWR Dates:  

• 04/12/05 
• 04/13/05 
• 04/14/05 
• 04/15/05 
• 04/16/05 
• 04/17/05. 

2. Navigate to the Pipeline Information window. 

3. What date/time/user is shown as checking out the DWR created by jj05751 on 4/12/05 on 
Contract CNB022N? 
_________________________________________________________________________ 

4. What date/time/user is shown as checking in the DWR created by jj05751 on 4/12/05 on 
Contract CNB022N? 
_________________________________________________________________________ 

5. Exit SiteManager. 

NONE 

jj05751 - just now 
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Learning Module 

 Section 7  Diary 
for Field and Office Documentation 

 

By the end of this module, you will be able to: 

• Create a new Diary 

• Preview a Daily Work Report 

• Authorize a Daily Work Report 

• Create a Charge Day 

• View the Unauthorized DWR Report 

• View the Installed Work Report 

• Unauthorize and Correct a DWR Work Item Entry 

• View the History of Daily Work Reports 

• View the Installed Work Items Report 

• View the Item Quantity Report 
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Diary Overview 

Each Diary is a daily collection of the authorized Daily Work Reports submitted 
by all personnel working on the Contract.  Only one Diary can be created per day 
per Contract.  Diaries can also be created for days when no Daily Work Reports 
are collected.  The Diary panel has two folder tabs:  

• Authorize (approving for payment) 

• Charge 

The User uses the Diary window to perform five functions: 

• Create a new or open an existing Diary for a specific contract 
and day 

• Preview Daily Work Reports for a specific contract and day 

• Authorize Daily Work Reports (or not) 

• Apply Time Charges for a specific contract and day (as well as 
milestones, if applicable) 

• Make Remarks 

The Authorize Folder Tab of the Diary Window 
Figure 7-1 

 

In TDOT, the Lead Inspector or Project Supervisor will create a Diary for 
each day during the life of a contract, including weekends and holidays.  
The Lead Inspector or Project Supervisor will review and authorize all 
applicable DWRs associated with the Diary. 

Diaries will only be created in Server Mode. 
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 Exercise 7-1 
In the following exercise, you will view the Diary window.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. Double-click the SiteManager Training program icon on the 

desktop. 
2. In the User ID field, type jj05753. 
3. In the Password field, type pass. 
4. Click the Logon button.  
5. On the Main Panel, double-click the Daily Work Reports icon. 
6. On the Daily Work Reports panel, double-click the Diary icon. 

Shift-tab if user 
ID not 
highlighted. 
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Creating a New Diary 

The Diary Authorize folder tab lets the User create a Diary.  The User can create 
a Diary with or without Daily Work Reports.  Typically, the User creates a Diary 
from the Daily Work Reports that have been submitted by the Inspectors.  To 
create a Diary, the User selects a Contract first, and then enters the Diary’s date 
on the Diary Authorize panel.  By entering the date, the User is also selecting the 
Daily Work Reports with this date and creating a Diary with this date.  The User 
can enter a date by selecting it from a calendar.  If the User double-clicks the 
Diary Date field, a calendar is displayed on which the User can select the date. 

 
The Calendar 

Figure 7-2 

Tip: The User cannot enter a date that is after the current system data. 

After the User selects a date, the Diary Authorize folder tab lists the Daily Work 
Reports submitted for the selected date.  The reports are listed alphabetically by 
the name of the Inspector who submitted the report. 

If Diary already 
exists for entered 
date, it will 
automatically 
open. 
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 Exercise 7-2 
In the following exercise, you will create a new Diary on April 18, 2005 for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the Diary window, click the Services menu and click Choose 

Keys. 
2. In the Contract ID list box, scroll to and double-click Contract 

CNB022M. 
3. In the Diary Date field, type 041805.  
4. Press the Enter key. The Diary window displays the list of DWRs 

submitted for the current date. 
5. Click the Save button. 

Have 
students type 
the date. 
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Previewing Daily Work Reports 

The Preview option on the Diary panel lets the User view and print a summary of 
a Daily Work Report without leaving the Diary panel. 

The Preview button option may be accessed by either the Preview DWR button 
on the toolbar or through the Services menu. 

 
The Preview DWR Button 

Figure 7-3 

 

The Daily Work Report Preview 

Figure 7-4 

In TDOT, before authorizing a DWR, the Lead Inspector or Project 
Supervisor should review the DWR for any errors or omissions.  
Additionally, the Lead Inspector or Project Supervisor should document 
remarks as necessary within the appropriate Remark Type field. 

It is important for the Project Supervisor to look at the DWRs since the 
Inspectors can approve their own DWRs.  Project Supervisors are still 
accountable for DWRs in their office. 
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 Exercise 7-3 
In the following exercise, you will preview a DWR on April 18, 2005 for contract 
CNB022M from the Diary window.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. In the Inspector list box, click the DWR for Warren, Jackie. 
2. Click the Preview DWR button.  Review the DWR. 
3. Did the contractor drive test piles that day?    ______ 
4. What was the location of the line item placement?   

 ____________________________________________________ 
5. Click the Close button.  

YES 

Abutment #1, Column B, Footing A 
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Authorizing Daily Work Reports 

The Diary Authorize folder tab lets the User authorize or unauthorize Daily Work 
Reports.  A Daily Work Report with a check in the Authorized check box is 
considered authorized.  When a Daily Work Report is marked as authorized, the 
system enters the current date in the Authorized Date field.  The User can remove 
authorization (and the authorized date) by removing the check from the 
Authorized check box, unless an estimate has been generated or approved. 

By authorizing a Daily Work Report, the User is flagging that DWR for use by 
the Contractor Payments component of SiteManager in the Estimate Generation 
process.  Authorization approves the installed work reported by the DWR to be 
included in the next Estimate for payment. 

Once an authorized Daily Work Report has been uploaded to the server and has 
been used in an approved Estimate to pay a Contractor for the installed work 
reported by it, it cannot be unauthorized or changed in any way. 

In TDOT, DWRS should be authorized if all of the Placed Quantities 
reported in the DWR are accurate.  If payment for the items installed needs 
to be adjusted due to test reports, this will be done by the Office Staff during 
estimate preparation using plug-in programs designed for this purpose. 

 

 Exercise 7-4 
In the following exercise, you will authorize the DWR for April 18, 2005 on Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. In the Inspector list box, click the DWR for Warren, Jackie. 
2. Click the Authorized check box (ON).  
3. Click the Save button. 
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Creating Charge Days and No Charge Days 

The Diary Charge folder tab lets the User record charge or credit information for 
the day and enter remarks. The User reviews the Daily Work Reports in the 
Diary to determine if work was performed on the Contract. If work was 
performed, a Full Day charge can be applied to the Contract end date. A No 
Charge (credit) day is a day on which no work was performed on the Contract. 
For No Charge days, no time is applied towards the Contract end date.  For No 
Charge days, the User must enter a credit reason to explain why a credit was 
given.  The User can also apply charge or credit information to milestones for the 
Contract.  For No Charge days applied to a milestone, the User must also enter a 
credit reason. 

The Charge Folder Tab 

Figure 7-5 

In TDOT, the majority of contracts will have a Fixed Completion Date and 
therefore it will not be necessary to indicate a charge day on the Charge 
folder tab. Consequently, the Charge Day folder tab has no impact on 
Fixed Completion Date contracts. 

Charging of days will only be done for working day milestones for phased 
construction and mowing contracts. Charge days for milestones must be 
entered for each charge day for each milestone. 

TDOT will not use half-day charges. 
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 Exercise 7-5 
In the following exercise, you will review the Diary Charge Days folder tab for 
Contract CNB022M on April 18, 2005.   

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the Diary window, click the Charge folder tab. 
2. To apply the charge to a milestone, click the Milestone field and click the New 

button. An empty row is inserted. 
3. In the Milestone drop-down list, select Milestone 01, Bridge over Little Owl 

Creek Reopen for Traffic. 
4. In the Charge Amount drop-down list, click the expand arrow and click Full 

Day. 
5. Click the Save button. 
6. Click the Close button. 

The Charge Days 
folder tab has no 
impact on Fixed 
Completion Date 
contracts. 

Select 
Milestones 
when the 
Milestones are 
not set up with 
Completion 
Date type time 
charges. 
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Viewing the Unauthorized DWR Report 

The unauthorized DWR report is a TDOT custom report that shows all the 
DWRs for a project that remain Unauthorized. 

 

Unauthorized DWR Report - Parameters window 

Figure 7-6 

We cannot view 
TDOT custom 
reports in the 
training 
environment. 
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Unauthorized DWR Report 

Figure 7-7 

 

In TDOT, the Unauthorized DWR Report is used to print a list of all DWR 
reports on the server that are unauthorized for the time period.  This will 
allow staff to ensure unauthorized DWRs can be included in the estimate, 
as appropriate. 

Installed Work 
Report (next topic) 
is also a tool for 
Identifying 
Unauthorized 
DWRs. 
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Viewing the Installed Work Report 

The Installed Work Report displays all the items of work recorded on Daily 
Work Reports that have not been included on an estimate.  There is an indicator 
for each item entry to indicate whether the displayed Installed Quantity has been 
authorized for payment on a Diary. 

The Installed Work Report 

Figure 7-8 

In TDOT, the Installed Work Report may be used to review quantities 
recorded in DWRs that have not yet been included in an estimate.  
Discrepancies in placed quantity totals may be apparent and therefore 
addressed prior to estimate generation. 

Any “Auth” box that shows an “X” is authorized for payment and will be 
included in the next estimate. 

 

Report may be 
sorted using the 
Item Code, 
Description, and 
Installed Quantity 
column headings. 

Once the estimate 
is generated, 
authorized DWRs 
will not be 
included in the 
report. 
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Yes 

 Exercise 7-6 
In the following exercise, you will view the Installed Work Report for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. Click the Main Panel folder tab. 
2. On the Main Panel, double-click the Contractor Payments icon. 
3. On the Contractor Payments panel, double-click the Reports icon. 
4. On the Reports panel, double-click the Installed Work icon. 
5. On the Report Criteria selection panel, double-click Contract 

CNB022M. 
6. What is the Quantity Reported to Date for Category Nbr 0500, LIN 

0500, Item Code 606-09.01?   ___________________ 
7. Is that quantity authorized for payment on the next estimate?   
8. Click the Close button. 

55.00
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Unauthorizing and Correcting a DWR Work Item Error 

A Daily Work Report may be unauthorized on the Diary window if the DWR has 
not been included in a generated estimate.  A User with the appropriate security 
rights may access the Diary window, and deselect the Authorize indicator (OFF).  
Once unauthorized, the Daily Work Report will no longer be locked for 
modification and the author of the DWR can update the record with the necessary 
changes.  Once the record has been modified, a User with the appropriate 
security rights can access the Diary window, preview the DWR to verify the 
changes, and select the Authorize indicator (ON).  The authorized DWR will be 
included in the next estimate generated. 

Note: A DWR that has been included on a generated estimate that has not been 
approved at the final approval level can still be modified if necessary.  The 
estimate may be deleted from the application and the outlined process for 
correcting a DWR may be executed. 

The Diary window with the DWR Authorized 

Figure 7-9 

In TDOT, if an inaccuracy is discovered for a DWR that has been 
authorized on a Diary but not included on an estimate, the DWR should be 
unauthorized and the creator of the DWR notified of the necessary 
changes.  If the DWR author is an Inspector, the DWR should be pipelined 
to standalone mode, modified as appropriate, and pipelined back to the 
server. The Project Supervisor or Lead Inspector will then re-authorize the 
updated DWR in the Diary window. 

Office Staff will create and correct DWRs in server mode. 

Every attempt should be made to uncover inaccuracies PRIOR to 
generating an estimate. 

Note: Diaries are managed in server mode only. 

TDOT policy is 
to correct 
Inspector DWRs 
in standalone to 
keep standalone 
and server in 
sync. 
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 Exercise 7-7 
In the following exercise, you will unauthorize a DWR on the Diary for 4/17/2005; 
adjust the placed quantity on the DWR and then re-authorize the DWR for payment 
for Contract CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server    Contract: CNB022M 
1. Click the Main Panel folder tab. 
2. On the Main panel, double-click the Daily Work Reports icon. 
3. On the Daily Work Reports panel, double-click the Diary icon. 
4. Click the Open button. SiteManager displays the Contract ID 

window. 

Now, let’s choose a contract and Diary. 
5. From the Date selection list, double-click 04/17/2005.  
6. In the Inspector list box, click to select the DWR for Warren, 

Jackie. 

Now, let’s unauthorize a DWR. 
7. Click the Authorized check box (OFF).  
8. Click the Save button. 
9. Click the Close button. 
10. Exit SiteManager. 

Now, let’s log on as an Inspector to pipeline the DWR to standalone mode 
11. On the desktop, double-click the SiteManager Training program 

icon. 
12. In the User ID field, type jj05751. 
13. In the Password field, type pass. 
14. Click the Logon button. 
15. On the Main Panel, double-click the Pipeline icon. 
16. On the Pipeline panel, double-click the Server to PM Pipeline icon. 

SiteManager displays the Server to PM Pipeline window. 
17. Click the Open button.  
18. In the Contract list box, scroll to and double-click Contract 

CNB022M. 
19. Click the DWR Select tab. 
20. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/17/05. 
21. Click the Add button. 
22. Click the Pipeline Summary tab. 

In server mode 
to pipeline the 
DWR to 
standalone so 
that you may 
correct it.  
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23. On the Pipeline Summary tab, click the Basic Contract Data check 
box (ON). 

24. Click the Services menu and click Pipeline Data. The progress of 
the download is shown in the Pipeline Status field. A message 
confirms that the data is downloaded. 

25. Click the Exit button. 

Now, let’s log on as an Inspector to correct the DWR in standalone mode.  
26. On the desktop, double-click the SiteManager Training program 

icon. 
27. In the User ID field, type jj05751. 
28. In the Password field, type pass. 
29. In the Connect To drop-down list, click the expand arrow to the 

right of the current selection and click Training Standalone. 
30. Click the Logon button. 

Now, let’s open the DWR that we are correcting. 
31. On the Main Panel, double-click the Daily Work Reports icon. 
32. On the Daily Work Reports panel, double-click the Daily Work 

Reports icon. 
33. Click the Open button. SiteManager displays the Contract ID 

window. 
34. From the Contract ID selection list, double-click Contract 

CNB022M. 
35. In the Inspector list box, double-click User ID for Warren, Jackie 
36. From the Date list box, double-click 04/17/05. SiteManager displays 

the info for that DWR in Daily Work Reports window. 

Now, let’s select the work item to correct. 
37. Click the Work Items folder tab. 
38. Scroll to and select Project 55021-3214-94, Line Item Number 0643, 

Category Number 0100, Item Code 204-07, Description BEDDING 
MATERIAL (PIPE) CLASS B. 

39. On the toolbar, click the Record Work Item button. 

Now, let’s choose a template to use for the correction. 
40. On the toolbar, click the DWR Template button. SiteManager 

displays the DWR Template window. 
41. From the Template ID column, double-click Template ID SM10E. 
42. In the Length (ft) field, type 50.00. Press Tab to calculate. 
43. On the template, click the Save button. 
44. On the Item Recording window, click the Close button. 
45. On the toolbar, click the Save button. 
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46. Click the Close button. 
47. Exit SiteManager. 

Now, let’s log on as an Inspector to pipeline the DWR to server mode. 
48. On the desktop, double-click the SiteManager Training program 

icon. 
49. In the User ID field, type jj05751. 
50. In the Password field, type pass. 
51. Click the Logon button. 
52. On the Main Panel, double-click the Pipeline icon. 
53. On the Pipeline panel, double-click the PM to Server Pipeline icon. 

SiteManager displays the PM to Server Pipeline window. 
54. Click the Open button.  
55. In the Contract list box, scroll to and double-click Contract 

CNB022M. 
56. Click the DWR Select tab. 
57. In the DWRs list box, click the DWR created by Warren, Jackie on 

04/17/05. 
58. Click the Add button. 
59. Click the Pipeline Summary tab. 
60. Click the Services menu and click Pipeline Data. The progress of 

the download is shown in the Pipeline Status field. A message 
confirms that the data is downloaded. 

61. Click the Exit button. 

Now let’s log on again as the Project Supervisor or the Lead Inspector. 
62. Double-click the SiteManager Training program icon on the 

desktop. 
63. In the User ID field, type jj05753. 
64. In the Password field, type pass. 
65. Click the Logon button. 

Now, let’s authorize the DWR in the Diary. 
66. On the Main Panel, double-click the Daily Work Reports icon. 
67. On the Daily Work Reports panel, double-click the Diary icon. 
68. On the toolbar, click the Open button. SiteManager displays the 

Contract ID window. 
69. From the Contract ID selection list, double-click Contract 

CNB022M. 
70. From the Date selection list, double-click 04/17/2005. 
71. In the Inspector list box, click the DWR for Warren, Jackie. 
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72. Click the Preview DWR button. 
73. Review the DWR. 
74. Click the Close button to close the DWR Preview. 
75. Click the Authorized check box (ON). 
76. Click the Save button. 
77. Click the Close button. 
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Viewing the History of Daily Work Reports 

The Daily Work Reports History window displays Daily Work Report records 
for the selected Contract.  To run history reports, the User must select a Contract 
when the History panel first opens and displays a selection list of contracts.  The 
history reports display all Daily Work Report records for the selected Contract. 
The User can view the reports on-line or print the reports.  The History panel has 
the following folder tabs: 

• DWR History 

• Work Item History 

• Contractor History 

DWR History 

The DWR History folder tab displays a history of all of the Daily Work Reports 
available to the current User.  This report groups all the Daily Work Reports by 
date and inspector, in ascending order.  Weather conditions, temperatures, and 
work suspended times are examples of the information shown on this report.  The 
User can view the report on-line or print the report. 

The DWR History Folder Tab 

Figure 7-10 

Reports are 
sorted by DWR 
“Dates” only. 
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 Exercise 7-8 
In the following exercise, you will view the History of the DWRs for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the Daily Work Reports panel, double-click the History icon.  
2. Click the Down Arrow button to view the DWRs for Contract 

CNB022M. 
3. What were the high temperature and morning weather conditions as 

recorded by jj05751 on 04/20/05? 
_______________________________________________________ 71 DEGREES AND SUNNY 
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Work Item History 

The Work Item History report displays a history of all work items recorded in the 
Daily Work Reports for the selected Contract.  The contract must be selected 
from the contract selection list that appears when the History icon is clicked. The 
User can view the report on-line or print it. 

The Work Item History Folder Tab 

Figure 7-11 

 Exercise 7-9 
In the following exercise, you will view the history of work items for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the History window, click the Work Item History folder tab. 
2. Click the Down Arrow button to view the work items for Contract 

CNB022M. 
3. What quantity reported to date did jj05751 record for Line Item 

Number 0520 on 04/20/05? 
_______________________________________________________ 114.0 
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Contractor History 

The Contractor History folder tab displays three separate reports:  

• Equipment History 

• Supervisor History 

• Variable Labor History 

Each type of report can be selected using the appropriate toolbar button or by 
choices under the Services menu. 

 
Equipment History, Supervisor History, and Variable Labor History Buttons 

The Contractor History Toolbar Buttons 

Figure 7-12 
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Equipment History Report 

 

The Contractor Equipment History Report 

Figure 7-13 

 

Supervisor History Report 

 

The Contractor Supervisor History Report 

Figure 7-14 
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Variable Labor History Report 

 

The Contractor Variable Labor History Report 

Figure 7-15 

 Exercise 7-10 
In the following exercise, you will select and view Contractor History Reports for 
Contact CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. On the History window, click the Contractor History folder tab. 
2. The Equipment History report displays automatically. 
3. What piece(s) of equipment and the number used did jj05752 record 

for WMC CONTRACTING CO., INC. on the DWR Date of 
04/20/05?        ______ 

4. Click the Variable Labor History button.  
5. What Personnel Types did jj05752 record onsite for WMC 

CONTRACTING CO., INC. on 04/20/05?     
          

6. Click the Close button.   

One Farm Tractor, One Haul Truck, and Two Pickup Trucks 

Class “D” Operators, Foreman,  
Truck Driver (2 axels), and Unskilled Laborer 
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Viewing the Inspector’s Report of Installed Work Items 
The Inspector’s Report of Installed Work Items is a TDOT custom report that 
shows the Dates Locations, and Quantities for work items installed on a contract.  

 
Inspectors Report of Installed Work Items – Parameters window 

Figure 7-16 

 

 
Inspectors Report of Installed Work Items 

 Figure 7-17  

We cannot view 
TDOT custom 
reports in the 
training 
environment. 
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Viewing the DWR Template Report 

The DWR Template Report is a TDOT custom report that shows all of the DWR 
Templates used for a contract. In TDOT, the DWR Template Report is used to 
print a list of all DWR Templates for the items and time period chosen.  This will 
allow staff to view the DWR template entries for multiple items and time periods 
at the same time. 

 
DWR Template Report – Parameters window 

Figure 7-18 

 
DWR Template Report 

Figure 7-19 

Under the 
report line 
after the DWR 
information, 
the DWR 
Template data 
is listed in 
standard 
columns from 
left to right 
regardless of 
how it is laid 
out on the real 
DWR 
Template.  This 
standard layout 
allows all DWR 
Templates to be 
displayed on 
the same 
report. 

Accessed from 
the SM-Inspector 
folder. 
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Viewing the Item Quantity Report 

The Item Quantity Report lists all Contract Item quantities that are found in the 
database based on user-selected criteria.  This report can be generated on all 
Contract Items (this is, Original, Change Order, Current, Installed, Paid, and 
Final).  The Items are grouped by Item Code and Project Number.  An Item cost 
summary is displayed for each group.  The User can view the report on-line or 
print the report. 

The Item Quantity Report 

Figure 7-20 

 

This report is 
sortable by most 
of the column 
headings. 
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 Exercise 7-11 
In the following exercise, you will view the Item Quantity Report for Contract 
CNB022M.  

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022M 
1. Click the Main Panel folder tab. 
2. On the Main Panel, double-click the Contract Administration 

icon. 
3. On the Contract Administration panel, double-click the Reports 

(CA+) icon.  
4. On the Reports (CA+) panel, double-click the Item Quantity icon.  
5. Using the right mouse button, click the Contract ID field 
6. In the object menu, click Search. 
7. In the list box, scroll to and double-click CNB022M. 
8. Click the All Item Status check box (ON). 
9. Click the OK button. 
10. Click the Close button. 
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Review for Section 7 
To create a new Diary: 

1. On the Daily Work Reports panel, double-
click the Diary icon.  

2. Click the Services menu and click the 
Choose Keys choice. 

3. In the Contract list box, scroll to and click 
the desired Contract. 

4. Click Ok.  The Diary Authorize folder tab 
lists the Daily Work Reports submitted for 
the current date.   

5. To change the date, double-click the Diary 
Date field.  This opens a calendar on which 
a date prior to the current date can be 
selected.  To select a prior month, click the 
left arrow.  To enter the selected date, click 
Ok.   

6. To enter a remark, in the Remark Type list 
box, scroll to and click the remark type. 
Then, type the remark in the Remarks field. 

7. Click the Save button. 
8. Click Ok. 

To preview a Daily Work Report: 

1. On the Daily Work Reports panel, double-
click the Diary icon.   

2. Click the Open button. 
3. In the Contract list box, scroll to and 

double-click the desired Contract. 
4. In the Diary list box, scroll to and click the 

DWR Date of the Diary. (The DWR Date 
represents both the Daily Work Report Date 
and the Diary Date.) 

5. Click Ok.     
6. In the Inspector list box, scroll to and click 

the Inspector who submitted the Daily Work 
Report to be previewed. 

7. Click the Preview DWR button.     
8. To close the print preview window, click the 

Close button. 

To authorize a Daily Work Report: 

1. On the Daily Work Reports panel, double-
click the Diary icon.  

2. Create a new Diary or open an existing 
Diary. 

3. In the Inspector list box, scroll to the Daily 
Work Report to be authorized. 

4. Click the Authorized check box (ON).   
5. Click the Save button. 

To unauthorize a Daily Work Report: 

1. On the Daily Work Reports panel, double-
click the Diary icon.  

2. Open an existing Diary. 
3. In the Inspector list box, scroll to the Daily 

Work Report to be authorized. 
4. Click the Authorized check box (O).   
5. Click the Save button. 

To create charge or no charge day: 

1. On the Daily Work Reports panel, double-
click the Diary icon. 

2. Create a new Diary or open an existing 
Diary. 

3. Click the Charge folder tab. 
4. In the Charge Type field, click the radio 

button of the charge type to apply to the day 
for the Contract. 

5. If the charge type is No Charge, in the 
Credit Reason drop-down list, click the 
expand arrow and click the reason for not 
charging all or part of the day. 

6. To apply all or part of the charge or credit to 
a milestone, click the Milestone field and 
click the New button. An empty row is 
inserted. 

7. In the Milestone drop-down list, click the 
expand arrow and click the milestone to 
apply the charge or credit to. 

8. In the Charge Amount drop-down list, 
click the expand arrow and click Full Day or 
No Charge. 

9. If No Charge is entered as the Charge 
Amount for the milestone, in the Credit 
Reason drop-down list, click the expand 
arrow and click the reason for a credit. 

10. Click the Save button.  
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To access TDOT custom reports: 

1. Launch Internet Explorer.  
2. Access web address 

http://boe.tdot.state.tn.us/businessobjects/
Enterprise115/InfoView/  

3. Click the plus sign next to Public Folders.  
4. Click the plus sign next to SiteManager.  
5. Click the desired group name.  
6. Click the desired report name.  
7. Enter the desired prompt values.  
8. Click the OK button.  
9. Print or Save the report as appropriate.  

To view the History of Daily Work Reports: 

1. On the Daily Work Reports panel, double-
click the History icon. The Select Contract 
panel opens.   

2. In the Contract list box, scroll to and click 
the Contract ID. 

3. Click Ok.  The DWR History folder tab is 
displayed.   

4. Click the Down Arrow button to view the 
DWRs. 

To run the Installed Work Report: 

1. On the Main Panel, double-click the 
Contractor Payments icon. 

2. On the Contractor Payments panel, 
double-click the Reports icon. 

3. On the Reports panel, double-click the 
Installed Work icon. 

4. In the list box, select the appropriate 
contract. 

5. Click the OK button. 
6. To close the report, click the Close button. 

To view Item Quantity Report: 

1. On the Contract Administration panel, 
double-click the Reports icon.  

2. On the Reports panel, double-click the 
Item Quantity icon.  

3. Using the right mouse button, click the 
Contract ID field. In the object menu, click 
Search. 

4. In the list box, scroll to and double-click 
desired contract. 

5. In the Item Status drop-down list, click the 
All item status checkbox. 

6. Click the OK button to generate the 
contract.  
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Summary Exercise for Section 7 

In the following exercise, you will create a Diary and review activities on Contracts CNB022L. 

User ID: jj05753 Group: PJSUPS Mode: Server  Contract: CNB022L 

1. Create a new Diary for Contract CNB022L on 04/18/05. 

2. Preview Jackie Warren’s Daily Work Report for 04/18/05. 

3. Authorize Jackie Warren’s Daily Work Report for 04/18/05. 

4. Open the Diary Date 11/15/05 for Contract CNB022L.  Unauthorize the DWR created by User 
ID jj05752 (Gutierrez, Sandy). 

5. Log on in Server mode as jj05752. 

6. Pipeline DWR date 11/15/05 on Contract CNB022L for jj05752 (Gutierrez, Sandy) to 
Standalone mode. 

7. Exit SiteManager. 

8. Log on in Standalone mode as jj05752. 

9. Correct the reporting error for Contract CNB022L on DWR Date 11/15/05 for Item Code 712-
06, SIGNS (CONSTRUCTION), Project Number 55019-3220-94, Line Item Nbr 0310 on 
template SM22A.  Change the # of Signs value to 4. 

10. Exit SiteManager. 

11. Log on in Server mode as jj05752. 

12. Pipeline DWR date 11/15/05 for jj05752 back to Server mode. 

13. Exit SiteManager. 

14. Log on in Server mode as User ID jj05753. 

15. Authorize the corrected DWR. 

16. Preview the DWR History, Work Item History, and Contractor History for CNB022L. 

17. View the Item Quantity Report for CNB022L. 

18. View the Installed Work Report for CNB022L. 

19. Exit SiteManager.  
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Learning Module 

 Section 8  Estimate Basics & 
Progress Estimates 

for Field Documentation 
  

By the end of this module, you will be able to: 

• View the Estimate Summary  

• View Estimate Discrepancies 

• View the Estimate Item Detail 

• View the Estimate Item Paybook 

• Generate the Summary To Contractor Report 
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SiteManager Estimates Overview 

The Estimate Generation process manages the Estimate functionality from the generation of 
an Estimate through the creation of the extract file for the transportation agency’s financial 
system. The functionality is divided into the following areas: 

• Generation of the Estimate 

• Review of Estimate information 

• Resolution of Estimate discrepancies 

• Review of Estimate item details 

• Approve Estimate 

• Tracking of Estimate status 

 
The Estimate Panel 

Figure 8-1 
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The Estimate generation process allows the user to generate an Estimate for the Contract. 
The user selects to generate a progress or a final Estimate from the Contractor Payments 
component. The system then performs a background process which performs the following 
activities: 

• Delete pending Estimate. This activity deletes any previous pending 
Estimate which has been calculated but not approved. The deletion will 
remove only details tied to the previous pending Estimate. 

• Determine quantities for payment. This activity will determine the 
quantity to be paid for each line item on the Contract which has items 
installed for the Estimate period. 

• Calculate stockpiled materials. This activity will determine if an 
installed item has stockpiled materials. If it does, the process will use a 
stockpiled materials conversion factor to add a new line item adjustment 
to adjust the amount of payment which is to be made for the line item. 

• Identify discrepancies. This activity checks for and reports 
'discrepancies' for the work being performed by defined rules and 
conditions, e.g., physical completion dates for milestones with projected 
end dates during the Estimate period. This activity provides a window 
with discrepancy details for the Project Supervisor so that proactive steps 
can be taken for various project issues. The edits performed during the 
progress Estimate are a subset of the edits performed during the final 
Estimate. 

• Determine Funding Amounts. This activity will calculate the funding 
amount for the different funding sources based upon the funding given 
for the Contract, project, category or item. 
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TDOT Estimate Generation Schedule 

In TDOT, all Progress Estimates are generated by the Office Staff of the Unit assigned the 
contract.  Before the Estimate Generation and Reconciliation Cycle can begin, the 
Inspection staff must pipeline all DWR’s through the DWR Ending Date for their region.  
The following table outlines the Estimate Generation schedule for each of the Regions. 

 
Region 

 
First DWR Date 

Ending DWR Date (Estimate End 
Date) 

First Day Office Staff Can 
Generate Estimate 

Region 1 21st day of the previous 
month 

Through 20th day of the current 
month 

21st day of the current 
month 

Region 2 1st day of the previous 
month 

Through the last day of the 
previous month 

1st day of the current 
month 

Region 3 1st day of the previous 
month 

Through the last day of the 
previous month 

1st day of the current 
month 

Region 4 16th day of the previous 
month 

Through the 15th day of the 
current month 

16th day of the current 
month 

The TDOT Progress Estimate Generation Schedule 

Table 8-1 
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TDOT Progress Estimate Generation Workflow 
INSPECTION STAFF 

The Inspection staff will complete the following pre-estimate planning and verification 
tasks prior to estimate generation: 

Progress Estimate Planning & Verification Tasks Functional Navigation 

Lead Inspector/Inspector will check-in (Pipeline) all DWRs to the 
server through the ending DWR date as outlined in the PM to Server 
chapter. 

Pipeline > PM to Server 
Pipeline 

If the contract is a Maintenance Contract the inspector will access the 
Adjustments Plug-In to see if there are any missing MMS Templates.   

Contract Administration > 
Contract Records > 
Contracts > Plug-In > Adj. 
Plug-In 

Lead Inspector will run the Unauthorized DWR Report to find the 
applicable DWRs that have not been authorized. 

TDOT Custom SM Report  

Accessories > System 
Attachments 

As needed, Lead Inspector will run and review the Installed Work 
Report to help determine which unauthorized DWRs should be 
authorized for the estimate.  Lead Inspector may also need to review 
the DWRs and other reports to help with this determination. 

Contractor Payments > 
Reports > Installed Work 

As needed, Lead Inspector will create any missing Diaries for the 
estimate period and authorize all applicable DWRs that have not been 
authorized to date.  In TDOT, a Diary is to be created for each day of 
the period covered by the estimate for the life of the Contract. 

Daily Work Reports > 
Daily Work Reports or 
Diary 

Lead Inspector notifies Office Staff that all DWRs have been checked 
in and are ready to be included in an estimate. 

External 

TDOT Estimate Planning & Verification Task 

Table 8-2 
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TDOT Progress Estimate Correction Workflow 
If a discrepancy is displaying due to an error recorded on a DWR, the Office staff will not 
override the discrepancy.  Instead, the Office Staff and Inspection Staff will complete the 
following tasks as part of the estimate correction process to update the DWR error: 

Estimate DWR Correction Workflow Tasks Functional Navigation 

1. Office Staff will delete the pending estimate if a 
correction must be made to a DWR/Diary for the 
estimate period.  If an adjustment has been made to 
the estimate, the adjustment plug-in must be used 
to place the estimate back in pending status prior to 
deleting the estimate. 

Contractor Payments 
> Estimate > 
Estimate History 

2. Office Staff / Lead Inspector will unauthorize the 
DWRs that need to be corrected.  Note: DWRs 
created by Office Staff should be unauthorized by 
the Office Staff; DWRs created by Inspection Staff 
should be unauthorized by the Lead Inspector. 

Daily Work Reports 
> Diary 

3. DWR Creator (Inspectors only) will pipeline the 
DWR to standalone mode to correct the DWR. 
Note: Office Staff DWRs are created and corrected 
in Server mode.  Inspection Staff DWRs are 
created and corrected in Standalone mode. 

Pipeline > Server to 
PM 

4. DWR Creator corrects the DWR. Daily Work Reports 
> DWR 

5. DWR Creator (Inspectors only) will pipeline the 
DWR to server mode after correcting the DWR 

Pipeline > PM to 
Server  

6. Office Staff / Lead Inspector will authorize the 
corrected DWR.  Note: DWRs corrected by Office 
Staff should be authorized by the Office Staff; 
DWRs corrected by Inspection staff should be 
authorized by the Lead Inspector. 

Daily Work Reports 
> Diary 

7. Office Staff will generate the Estimate and repeat 
the Progress Estimate Generation Workflow. 

Contractor Payments 
> Estimates > 
Generate Estimate 

The TDOT Progress Estimate Correction Workflow 
Table 8-3 

 

In TDOT, every effort should be made to correct the estimate prior to 
running the adjustment plug-ins following the workflow above.  Only after 
being satisfied that the item quantities are correct should the Office Staff 
run the adjustment plug ins to adjust the pay amount of the estimate. 
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 Exercise 8-1 
In the following exercise, you will navigate to the Estimates panel.  

User ID: jj05751 Group: INSP  
1. Double-click the SiteManager Training program icon on your desktop. 
2. In the User ID field, type jj05751. 
3. Press the Tab key. 
4. In the Password field, type pass.  
5. Press the Enter key. 
6. Double-click the Contractor Payments icon. 
7. On the Contractor Payments icon, double-click the Estimate icon. 

 
 

Shift-tab if user 
ID not 
highlighted. 
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Viewing the Estimate Summary 

The Estimate Summary window allows the User to view calculated Estimate summary 
information. It may be accessed from the Estimate panel or from the In-Box. The window 
shows three sets of totals:  

• Previous Estimate(s) - Combined totals for previous Estimate(s) 

• This Estimate – totals for the current Estimate 

• Totals to Date – combined totals for all Estimates 

The Estimate Summary Window 

Figure 8-2 
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 Exercise 8-2 
In the following exercise, you will view the Estimate Summary window for contract 
CNB022Q.  

User ID: jj05751 Group: INSP Contract: CNB022Q 
1. On the Contractor Payments panel, double-click the Estimate icon. 
2. On the Estimate panel, double-click the Estimate Summary icon. 
3. In the Contract ID list box, scroll to and double-click Contract 

CNB022Q. 
4. In the Estimate list box, double-click estimate number 0001. 
5. What is the amount paid to the contractor on this estimate? 

_______________________________________________________ 
6. Are there discrepancies on this estimate? ______________________ 
7. Click the Close button. 

$1,801.15 

YES – Item  



Trns•port SiteManager® Learning Guide Viewing Estimate Discrepancies 
Section 8  Estimate Basics & Progress Estimates Post-Field Reporting for Inspector / Lead Inspector Staff 

 

 

200  

Viewing Estimate Discrepancies 

SiteManager identifies the discrepancies associated with an Estimate and displays them in 
the Estimate Discrepancy window. The discrepancies are of two levels: discrepancies at the 
Estimate level and discrepancies at the item level. For instance, if a Checklist Event Date is 
not met, the discrepancy is associated to the Estimate. If an item overrun is displayed, the 
discrepancy is associated with the specific line item.  

Estimate discrepancies are listed at the top of the Estimate Discrepancy window, and the 
item discrepancies are listed after them. The Status field values are either ‘Unresolved’ or 
‘Override.’ When the Recalculate Discrepancies function is selected from the Services 
menu, or if the Estimate is regenerated, the discrepancies are re-determined. 

 

The Estimate Discrepancy Window 

Figure 8-3 

 

 
The Navigate Button 

Figure 8-4 

 

Two options with 
discrepancies: 

• Override with 
comment 

• Resolve and 
recalculate 
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Change order to increase quantity is Pending. 

Change order to increase quantity is Pending. 

TDOT Discrepancy Types 

There are four types of discrepancies utilized at TDOT. Each are identified using different 
criteria.  

Overrun Discrepancy – Occurs if a major item is overrun by 10% or more and a minor 
item overrun by 999.99% or more. 

Milestone Completion Date Missed Discrepancy – Occurs if a milestone has not been 
completed within the time frame specified on the Milestones window. 

Contract Completion Date Missed Discrepancy – Occurs if work is recorded on a DWR 
beyond the Contract Completion Date specified on the Contracts window/Critical Dates 
folder tab. 

Checklist Event Completion Date Missed Discrepancy – Occurs if the Actual Date of the 
Checklist Event has not been entered on the Checklist Event Dates window within the time 
frame specified on the Checklist Scheduled Events window. 

 

In TDOT, if an estimate discrepancy on a Progress Estimate cannot be 
resolved, the discrepancy must be overridden with an explanation with the 
exception of a Checklist Event. 

 Exercise 8-3 
In the following exercise, you will view the Estimate Summary window for contract 
CNB022Q.  

User ID: jj05751 Group: INSP Contract: CNB022Q 
1. On the Estimate panel, double-click the Estimate Discrepancy 

icon. 
2. Click the discrepancy that says Major Item 55019-3220-94/0120 

exceeds Overrun Limits. 
3. Click the Remarks button. 
4. What is the reason for this Override? 

_______________________________________________________ 
5. Click the Remarks button. 
6. Click the discrepancy that says Major Item 55019-3220-94/0110 

exceeds Overrun Limits. 
7. Click the Remarks button. 
8. What is the reason for this Override? 

_______________________________________________________ 
9. Click the Remarks button. 
10. Click the Close button. 
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Viewing the Estimate Item Detail 

The Estimate Item Detail window displays the Item quantities from approved Daily Work 
Reports.  

 
The Estimate Item Detail Window 

Figure 8-5 

 

In TDOT, the Office Staff and Project Supervisor may view the Estimate 
Item Detail window to verify the item quantities for payment on the 
Estimate. 

Note: If there is no Pending or Rejected estimate for the Contract, you will 
see cumulative totals for all items on estimates 

These 
Discrepancy 
indicators only 
display when 
viewing ONE  
PENDING 
estimate, rather 
than All. 
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 Exercise 8-4 
In the following exercise, you will view the Estimate Item Detail for all items on 
contract CNB022Q.  

User ID: jj05751 Group: INSP Contract: CNB022Q 
1. On the Estimate panel, double-click the Estimate Item Detail icon. 
2. Click Yes to the message “There is no Pending or Rejected estimate 

for this contract.  Do you want to see items for all estimates?” 
3. In the list box, scroll to and click the record for Project Nbr 55021-

3214-94, Line Item Number 0643, Item Code 204-07, BEDDING 
MATERIAL.  

4. Has this item been included on an estimate? ___________________ 
5. What quantity was installed to date for this item? 

_______________________________________________________ 
6. What amount was paid to date for this item? 

_______________________________________________________ 
7. In the list box, scroll to and click the record for Project Nbr 55019-

3220-94, Line Item Number 0310, Item Code 712-06, SIGNS 
(CONSTRUCTION). 

8. What quantity was installed to date for this item? 
_______________________________________________________ 

9. What amount was paid on this estimate for this item? 
_______________________________________________________ 

10. In the list box, scroll to and click the record for Project Nbr 55021-
3220-94, Line Item Number 0110, Item Code 307-01.01, ASPHALT 
CONCRETE MIX. 

11. What quantity was installed to date for this item? 
_______________________________________________________ 

12. What amount was paid to date for this item? 
_______________________________________________________ 

13. Browse the items to see what work has been done on this contract. 
14. Click the Close button. 

1413 

$55,107.00 

Currently, 
there is 
only one 
estimate for 
this 
contract. 

19.000 

$380.00  

$228.00 

24.0 

Yes
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Viewing the Estimate Item Paybook 

The Estimate Item Paybook is an inquiry only window showing the payment history for a 
Contract Item. The Item payment history displays in reverse chronological order meaning 
the current Estimate Item displays on the first row.  Thus, it is possible that the first row is 
not yet paid.  Whether the first row is paid or not can be determined by the Approver User 
ID.  If the Approver User ID is the final reviewer (HQ Finance), then the item has been 
paid. 

 
The Estimate Item Paybook Window 

Figure 8-6 

 

In TDOT, the Estimate Item Paybook may be used to check amounts paid 
on each Estimate for a particular item. 
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 Exercise 8-5 
In the following exercise, you will view the Estimate Item Paybook for Estimate 
0001 for contract CNB022Q.  

User ID: jj05751 Group: INSP Contract: CNB022Q 
1. On the Estimate panel, double-click the Estimate Item Paybook 

icon. 
2. In the Contract list box, scroll to and double-click Contract ID 

CNB022Q. 
3. In the Line Item list box, scroll to and double-click Prj Nbr 55019-

3220-94, Ln Itm Nbr 0130, Item Cd 303-01, Desc MINERAL 
AGGREGATE, TYPE A BASE, GRADING D. 

4. Has this item been included on an estimate? ___________________ 
5. Click the Open button. 
6. In the Line Item list box, scroll to and double-click Prj Nbr 55019-

3220-94, Ln Itm Nbr 0500, Item Cd 606-09.01, Desc TEST PILES 
(PRECAST CONCRETE, SIZE 1). 

7. Has an adjustment been applied to this item? ___________________ 
8. Click the Open button. 
9. In the Line Item list box, scroll to and double-click Prj Nbr 55019-

3220-94, Ln Itm Nbr 0310, Item Cd 712-06, Desc SIGNS 
(CONSTRUCTION). 

10. Has an adjustment been applied to this item? __________________ 
11. Click the Open button. 
12. In the Line Item list box, scroll to and double-click Prj Nbr 55019-

3220-94, Ln Itm Nbr 0110, Item Cd 307-01.01, Desc ASPHALT 
CONCRETE MIX. 

13. Has an adjustment been applied to this item? __________________ 
14. Click the Close button. 
15. Click the Contractor Payments folder tab. 

NO 

YES 

YES 

YES 
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Generating the Summary to Contractor Report 

The Summary to Contractor report displays the amounts to be paid to the Contractor based 
on the estimate.  The report summarizes previous payments made to the Contractor and the 
current status of the Contract when the estimate is generated. An itemized description of 
quantities and amounts on all items in every project contained in the estimate is also given. 

The report consists of two pages. The first page summarizes the Contract information.  The 
second page lists the quantities and amounts of all the items for each project in the 
Contract. 

 
 

The Estimate Summary to Contractor Report 
Figure 8-7 

 

In TDOT, staff will review the Summary to Contractor report to ensure 
that the line item payment is correct.  If changes are required, the Office 
Staff will follow the Estimate Correction Procedure.  

The Summary to Contractor Report should be printed in Landscape with 
the smallest font size. Refer to the Review in this section for steps to modify 
the font and print preference. 

 

Report needs 
to be printed 
in Landscape. 
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 Exercise 8-6 
In the following exercise, you will generate the Summary to Contractor Report for 
Estimate 0001 for contract CNB022Q.  

User ID: jj05751 Group: INSP Contract: CNB022Q 
1. On the Contractor Payments panel, double-click the Process List 

icon. 
2. In the Process List, click the Summary to Contractor.  
3. Click the Run Process button. 

STOP. Do not submit the process in SiteManager Training.  
4. Click the Cancel Button 
5. Click the Close Button. 

A copy of the report is saved at C:\SMTRAINS\SMFILES to view 
during training.  

6. Right-click the Start button at the bottom left of the screen. 
7. Click the Explore choice. 
8. Navigate to the C:\SMTRAINS\SMFILES folder. 
9. Double-click Estimate Summary to Contractor CNB022P.htm. 
10. After viewing report, click the Close button to close the browser 

window. 
 

See the Review 
for steps to run in 
Production. 
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Review for Section 8 
To access Contractor Payment Reports: 

1. On the Contractor Payments panel, 
double-click the Reports icon. 

2. Double-click the icon for the desired report. 

To open an Estimate summary: 

1. On the Contractor Payments panel, 
double-click the Estimate icon. 

2. Double-click the Estimate Summary icon. 

3. Click the Open button. 

4. In the Contract list box, scroll to and click 
the desired Contract. 

5. Click Ok.  

6. When through, click the Close button. 

To open an Estimate discrepancy: 

1. On the Estimate panel, double-click the 
Estimate Discrepancy icon. 

2. In the list box, scroll to and double-click the 
desired Contract. 

3. In the list box, scroll to and click the desired 
Estimate. 

4. Click Ok. 

To view an Estimate item: 

1. On the Estimate panel, double-click the 
Estimate Item Detail icon. 

2. In the list box, scroll to and click the desired 
Contract. 

3. Click Ok.  

4. Click the Service menu and click the View 
Estimate choice. 

5. When complete, click the Save button. 

To view the Estimate Item Paybook: 

1. On the Contractor Payments panel, 
double-click the Estimate icon. 

1. On the Estimate panel, double-click the 
Estimate Item Paybook icon. 

2. In the list box, scroll to and double-click the 
desired Contract. 

3. In the list box, scroll to and click the desired 
Line Item. 

4. When complete, click the Close button. 

To generate the Summary to Contractor Report: 

1. On the Contractor Payments panel, 
double-click the Process List icon. 

2. In the Process List, click the Summary to 
Contractor. 

3. Click the Run Process button. 

4. Double-click the desired contract ID.  

5. Double-click the desired estimate number.  

6. Click the Submit button. 

7. Click the OK button. 

8. Click the OK button. 

9. Click the Services menu.  

10. Double-click the desired process name.  

11. Double-click Output.html. 

12. Click the Page button.  

13. Click Text Size, and then click Smallest. 

14. Click the Page Setup button.  

15. Click the Landscape radio button.  

16. Click the Ok button.  

17. Once the report displays, close the browser 
window. 

18. Click the Close button. 
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Summary Exercise for Section 8 

In the following exercise, you will review Estimate 001 for contract CNB022G. 

User ID: jj05751 Group: INSP Contract: CNB022G 

1. Navigate to the Estimate Summary window.  Open the summary for Contract 
CNB022G, Estimate 0001. 

2. What are the Item Earnings for Estimate Nbr. 0001? ________________________ 

3. Are there discrepancies on Estimate Nbr. 0001? ____________________________ 

4. Navigate to the Estimate Discrepancy window.  What discrepancies exist for 
Contract CNB022G, Est Nbr 0001, Period End Date 05/15/05? 
______________________________________________________________________ 
______________________________________________________________________ 

5. What window is used to correct these discrepancies? 
______________________________________________________________________ 

6. View Estimate Item Details for Line Item Number 0330. What quantity was 
paid on this estimate? ___________________________________________________ 

7. What is the purpose of the Summary to Contractor Report? 
______________________________________________________________________ 

8. Navigate back to the Main Panel.  

$21,454.05 

YES 

120 

SEND COPY OF ESTIMATE TO THE CONTRACTOR 

Event Traffic Control Checklist and  

Main Panel > Contract Administration .> Contract Records > Checklist Event Dates. 

Storm Water Inspection Report Checklist Events 
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Learning Module 

 Section 9  Contract Midlife 
Activities 

for Field Documentation 
 

By the end of this module, you will be able to: 

• View the Actual Date of a Checklist Event 

• View a Key Date 

• Correct Quantities for Approved Progress Estimates 

• View QTY ADJ DWRs 
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Dates in SiteManager 

Since dates are very important in the life of a highway construction contract, they are 
important in SiteManager.  Four of the most important types of dates in SiteManager are: 

• Critical Dates (of the Contract window) 

• Key Dates 

• Checklist Event Dates 

• Milestone Dates  

The first three, Critical Dates, Key Dates, and Checklist Events are very powerful 
because they can send SiteManager Inbox messages as reminders to an individual 
Recipient or to a Distribution List of recipients. 

 

The Standard Date Addressing and Message Objects of SiteManager 

Figure 9-1 

TDOT uses Recipients only and not Distribution Lists. 
 

Date Type 
When the Message Is 
Sent Who the Message Is Sent To Message Text 

Critical Dates 
(Single 
Occurrence) 

When a value is entered 
in the Actual Date Field 
by a Headquarters User. 

In-box of either the Recipient or the 
Distribution List indicated. 

The text defined in 
the Message Text 
field. 

Key Date 
(Single 
Occurrence) 

When the Projected Date 
of the Key Date is 
reached before the Actual 
Date is entered. 

In-box of the user whose User ID is 
identified in the Project Manager 
field on the Primary Personnel 
folder tab of the Contract window. 

The projected date 
was missed. 

When a value is entered 
in the Actual Date Field 
by a User. 

In-box of either the Recipient or the 
Distribution List indicated. 

The text defined in 
the Message Text 
field. 

Checklist 
Event Dates 
(May be used 
for multiple 
occurrences) 

When the Projected Date 
of the Checklist Event is 
reached before the Actual 
Date is entered. 

In-box of either the Recipient or the 
Distribution List indicated. 

The text defined in 
the Message Text 
field. 

Milestone When the Scheduled 
Completion Date is 
reached before the Actual 
Completion Date entered. 

Message appears in the Estimate 
Discrepancy window after estimate 
is generated for the period in which 
the milestone was missed. 

Milestone XXX is 
not reached 

SiteManager Dates 

Table 9-1 

Critical Dates are 
not updated by 
field personnel. 
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Viewing Checklist Event Dates 

The Checklist Event Dates panel lists the scheduled events for the selected 
contract. The data for the event selected in the top datawindow is displayed in the 
bottom datawindow. The data shows a chronological history of each occurrence 
of a repetitive scheduled event and the Actual Date recorded by the Office Staff 
for each occurrence. This panel lets the Office Staff  record the actual dates of the 
Checklist Scheduled Events and add or delete Checklist Event Date records. 

 
The Checklist Event Dates Window 

Figure 9-2 

 

 

Recipients are 
notified when a 
Scheduled Event does 
not occur on time. 
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 Exercise 9-1 

In the following exercise, you will view the Actual Date of Checklist Events for 
contract CNB022E.  

User ID: jj05751  Group: INSP  Contract: CNB022E 

1. On the Mail Panel, double-click the Contract Administration icon.  
2. On the Contract Administration panel, double-click the Contract 

Records icon.  
3. On the Contract Records panel, double-click the Checklist Event 

Dates icon. 
4. Click the Open button. 
5. In the Contract ID list, select Contract CNB022E. 
6. In the Event Type column, scroll to and click Storm Water. In the 

lower pane, the actual date recorded by the Office Staff will be 
shown. 

7. In the Event Type column, scroll to and click Traffic Control 
Checklist. In the lower pane, the actual date recorded by the Office 
Staff will be shown. 

8. Click the Close button. 

 

 

This version of the 
training database 
does not show the 
actual dates that the 
Office Staff records.  
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Viewing a Key Date 

Key Dates are dates that are important when they occur. Therefore, either a single 
recipient or the members of a distribution list are notified when a Key Date is 
accomplished. The Project Manager is notified when a Key Date is not 
accomplished by the projected date. A Key Date can be set up to be required 
either when the Contract is activated or when it is finalized. The User creates the 
Key Date schedule and records the actual occurrences of Key Dates on the Key 
Dates panel. 

The Key Dates panel lists the Key Dates for the selected Contract in the top 
window. The data for the selected Key Date is displayed in the bottom window. 
The Key Date Types are pre-defined in the system code tables. SiteManager adds 
a set of default Key Dates automatically to each new Contract. The User creates 
the Key Date schedule and records the actual occurrence of Key Dates on this 
panel. The User can add, modify, and delete the Key Dates.  

The Key Dates Window 

Figure 9-3 

 

In TDOT, the Notice to Proceed Date is updated by the Headquarters 
Finance Office upon receipt of the Starting Notice Report. 

Until the Notice to Proceed Date is entered, field data collection can begin, 
but estimates cannot be generated. 

 

Notified when 
entered and if not 
entered. 
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Key Date Recipient Fed/ 
State 

Enters Date Comment 

Starting Notice Project 
Supervisor 
designee 

Both Office Staff Projected Date = Effective Date. Used to 
generate the Starting Notice report which 
notifies HQ Finance to fill in the Notice to 
Proceed and Work Begin Dates (from 
Critical Dates) 

Final Inspection 
Request 

Regional 
Construction 
Supervisor 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
Contract ready for final inspection. 

Final Inspection Project 
Supervisor 
designee 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
Final Inspection completed this date as 
inspected and Accepted Date. 

CC-3 Project 
Supervisor 
designee 

Fed Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates) 
All CC-3’s have been received. 

Notice of 
Termination 

Project 
Supervisor 
designee 

Both Regional 
Construction 

Projected Date = Adjusted Completion Date 
(from Critical Dates). 
NOT form complete.  
Submit Field Office Completion Notice 
Report. 

Completion 
Notice (Date 
Time Stopped) 

Project 
Supervisor 

Both Regional 
Construction 

Projected Date = Adjusted Completion Date 
(from Critical Dates) 
Time charges have been stopped.  The final 
inspection and all exceptions are complete.  

Final Records 
Submittal 

Project 
Supervisor 
designee 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates) 
Project Records have been submitted to 
Final Records.  

DT1696 
Materials and 
Tests 
Certification 

Project 
Supervisor 
designee 

Both Office Staff Projected Date = Adjusted Completion Date 
(from Critical Dates). 
DT1696 Materials and Tests certification 
submitted to Regional Materials and Tests. 

TDOT Default Key Dates 

Table 9-2 
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 Exercise 9-2 

In the following exercise, you will view the Key Dates for contract CNB022E.  

User ID: jj05751  Group: INSP Contract: CNB022E 

1. On the Contract Records panel, double-click the Key Dates icon. 
2. In the Key Date Type list, click Starting Notice. 
3. Has this date occurred? ___________________________________ 
4. Why is this date important? ________________________________ 
5. Click the Close button. 
6. Click the Main Panel` folder tab. 

 

Yes 

Time starts on that day 
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Correcting Quantities for Approved Progress Estimates 

Use the Quantity Correction plug-in to adjust pay item quantities on Progress 
estimates that have reached final approval.  Note that quantities on Final 
Estimates may not be adjusted after the estimate is approved. 

 

The Quantity Correction Plug-in Window 

Figure 9-4 

The steps to use the Quantity Correction plug-in are as follows and are detailed 
on the following pages.  

1.  Run the Quantity Correction plug-in. (Main Panel > Contract 
Administration > Contracts > select Contract > click Attachments button 
> double-click Quantity Correction) 

2.  Select the DWR Date that included the quantity to be corrected. 

3.  Select the ITEM that included the quantity to be corrected. 

4.  In the Correct Quantity field, type the quantity that should have been 
recorded on the DWR. 

5.  Press the tab key to allow the program to calculate and display the 
quantity for the adjustment (Incorrect Quantity - Correct Quantity). 

6.  In the Remarks/Calculations field, type a remark to explain why the 
correction was needed. 

7.  Click the Save button. 

Only the originator of the DWR can modify any of the quantities on that DWR using the Quantity 
Correction plug-in. 

A DWR Quantity can only be corrected one time using the Quantity Correction Plug-In.  

The Quantity Correction Plug-In creates a system generated DWR.  This DWR must be authorized for 
before the correction is included on an estimate. 
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 Exercise 9-3 
In the following exercise, you will adjust an incorrect quantity on an approved DWR 
in the Quantity Correction plug-in for contract CNB022R.  

User ID: jj05751 Group: INSP Contract: CNB022R 
1. On the Main Panel, double-click the Contract Administration icon. 
2. On the Contract Administration panel, double-click the Contract 

Records icon. 
3. On the Contract Records panel, double-click the Contracts icon. 

SiteManager displays the Contracts window. 
4. In the Select Contract list box, scroll to and double-click CNB022R. 
5. Click the Attachments icon. 

 

The remaining steps cannot be completed in the training environment.  The following 
steps and screen shots demonstrate the process steps. 

6. Double-click the Qty Correction plug-in. SiteManager displays the 
Quantity Correction plug-in window.  The Contract and Inspector are 
automatically selected. 

 
 

7. In the DWR Date of Incorrect Qty field, select DWR Date 04/19/2005.  
The work items recorded on the DWR for the selected date are 
displayed. 

 

Shift-tab if user 
ID not 
highlighted. 
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8. Click to select the row for the DWR Item with the incorrect placed 
quantity: Project Number 55021-3214-94, Category Number 0100, 
Line Item Number 0643, Item Code 204-07, Description BEDDING 
MATERIAL (PIPE) CLASS B, Location Station16_75 RT. 
The Quantity Correction program displays an area to make the 
correction. 
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9. In the Correct Quantity field, type 29.000. 
10. Press the Tab key. The Quantity Correction plug-in shows the 

calculated adjustment in the Adjustment field. 
11. In the Remarks/Calculations field, type Corrected typo that 

resulted in an incorrect quantity being recorded. 

 
 
 

12. Click the Save button. The Quantity Correction program displays a 
message to inform you that a quantity has been adjusted for that line 
item number. 

 
13. In the message, click the OK button. 
14. On the toolbar, click the Exit Application button. 
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Viewing QTY ADJ DWRs 

The Quantity Correction plug-in creates QTYADJ DWRs to adjust paid 
quantities on progress estimates that have already reached final approval.  These 
may be viewed in the DWR window.  

The auto created QTY ADJ DWRs are not authorized and will need to be 
authorized in the Diary window to be included in the next progress estimate. 

 

The Daily Work Reports Window 

Figure 9-5 
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 Exercise 9-4 
In the following exercise, you will view the DWR resulting from the Qty Correction 
plug-in. 

User ID: jj05751 Group: INSP Contract: CNB022R 
1. Click the Close button to close the Contracts window.  
2. Click the Main Panel folder tab.  
3. On the Main Panel, double-click the Daily Work Reports icon. 
4. On the Daily Work Reports panel, double-click the Daily Work Reports icon. 

SiteManager displays the Daily Work Reports window. 
5. On the toolbar, click the Open button. SiteManager displays the Contract ID 

window. 
6. Click No to the save changes message. 
7. In the User ID list box, scroll to and double-click QTYADJ01. 
8. In the Date area, double-click 04/19/05. SiteManager displays a message to 

inform you that the DWR will be opened in a read-only format. 
9. In the message, click the OK button. SiteManager displays the Daily Work 

Reports window. 
Now, let’s view the installed work item. 

10. Click the Work Items tab. 
11. Double-click the row for Project Number 55021-3214-94, Line Item Number 

0643, Category Number 0100, Item Code 204-07, Description BEDDING 
MATERIAL (PIPE) CLASS B. 

12. What is the placed quantity? ____________ 
13. Click the Close button on the toolbar. 

10.000 
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Review for Section 9 
To record the Actual Date of a Checklist Scheduled 
Event: 

1. On the Contract Records panel, double-
click the Checklist Event Dates icon. 

2. In the Checklist Event Dates list box, scroll 
to and click the Checklist Event. 

3. In the Actual Date field, type the actual 
date for the Checklist Event. 

4. Click the Save button. 

To view a Key Date: 

1. On the Contract Records panel, double-
click the Key Dates icon. 

2. In the Key Date Type list, select the desired 
Key Date. 

To correct the quantity of an item on a paid estimate 
with the Quantity Correct Plug In: 

1. On the Contract Records panel, double-
click the Contracts icon. The Contracts 
panel opens. 

2. Click the Open button. The Select Contract 
list is displayed. 

3. In the Select Contract list box, scroll to and 
double-click the Contract ID or perform a 
Find. The Select Contract list closes and the 
Description folder tab is displayed. 

4. Click the Attachments button. 
5. Double-click the Qty Correction plug-in. 
6. In the DWR Date of Incorrect Qty field, 

select the DWR Date for the DWR to be 
corrected.  Note: this must be a DWR 
included on a paid estimate, and must be a 
DWR you created.  

7. Click to select the row for the DWR with 
the incorrect placed quantity. The Quantity 
Correction program displays an area to 
make the correction. 

8. In the Correct Quantity field, type the 
correct quantity to report for this item on 
this day. 

9. In the Remarks/Calculations field, type the 
reason for the correction. 

10. Click the Save button. The Quantity 
Correction program displays a message to 
inform you that a quantity has been adjusted 
for that line item number. 

11. In the message, click the OK button. 
12. On the toolbar, click the Exit Application 

button. 

To view the DWR of an item modified with the 
Quantity Correct Plug In: 

1. On the SiteManager main panel, double-
click the Daily Work Reports icon. 

2. On the Daily Work Reports panel, double-
click the Daily Work Reports icon. 

3. Select the Contract, Inspector, and Date of 
the DWR that was corrected. 

4. Click the Work Items folder tab. 
5. Double-click the Item that was corrected. 
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Summary Exercise for Section 9 

In the following summary exercise, you will perform SiteManager Contract Midlife activities.  

User ID: jj05751  Group: INSP Contract: CNB022F 

1. Navigate to the Checklist Event Dates window for Contract CNB022F. 

2. What is the frequency for the Storm Water Inspection Report Event Type? _____________  

3.  Record the actual date of the Storm Water Inspection Report Event Type. Enter today’s date 
as the Actual Date of one occurrence of this event.  

4. Navigate to the Key Dates window for Contract CNB022F. 

5. What is the actual date for the Starting Notice? _____________________________________  

6. If an error is made on a DWR that needs to be corrected, and the estimate has been generated but 
not paid, what should be done?  
_____________________________________________________________________________ 
_____________________________________________________________________________ 
_____________________________________________________________________________ 
_____________________________________________________________________________ 
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________
______________________________________________________________________________ 

7. What window is used to run the Quantity Adjustments plug-in to adjust the quantity on a DWR 
included in a paid estimate? ______________________________________________________ 

8. Navigate to the Main Panel. 

 

Contracts, Adjustments Plug-in 

4/15/05 

See page 192, Table 8-3, Estimate Correction Workflow 

Quarterly 
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Learning Module 

 

 

 

 

 Section 10  Change Order Basics 
for Field Documentation 

 

By the end of this module, you will be able to: 

• Understand the rules and life cycle of Change Orders 

• View the Item Summary Window 

• Track Change Orders 

• View the Change Order Report 
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Change Order General Concepts 

The change order process allows legal changes to be made to a Contract by 
creating, approving, and tracking changes.   

Contract Change Orders may include: 

• Quantity adjustments for existing items 

• Adding new items of work to the contract 

• Time Extensions on milestones or revisions to Contract time or 
Contract completion date 

• Additions to the Contract not affecting time or item quantities 

Except for zero dollar change orders, users can specify more than one function to 
make up a change order.   

Before the User can select a specific window in the Change Order (CO) function, 
a specific Contract must be selected from a pick list containing valid Contracts, 
and associated, existing COs.  A specific Contract must be selected from the pick 
list to create a new change order. 

 

The Change Order Maintenance Panel  

Figure 10-1 

Each CO must be 
associated with one 
Contract. 
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 Exercise 10-1 
In the following exercise, you will navigate to the Change Order Maintenance Panel.   

User ID: jj05751  Group: INSP Contract: CNB022I 

1. On the Main Panel, double-click the Change Orders icon. 
2. On the Change Orders panel, double-click the Change Order Maintenance 

icon. 
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Change Order Life Cycle 

The life cycle of contract change orders is reflected in the change order functions 
in SiteManager. 

1. Creation of a New Change Order  

A CO can only be created by a User with specific authority to create new change 
orders.  A change order must be associated with an existing active Contract.  
Specific information about the change order must be recorded using the Change 
Order Header window, the Change Order Items window, the Time Adjustments 
window, and/or the Change Order Explanations window. 

2. Maintaining Change Orders 

Once a CO has been created, updates to the CO information may be required.  
Change Order header information, items, time frames, and explanations may be 
modified in update mode on the appropriate windows. 

3. Review and Approval of Change Orders 

After it is created, a draft CO can be forwarded via In-box notification for 
parallel review.  Parallel review is concurrent review by more than one reviewer 
at a time.   

The writer of the CO can also place the change order into Pending status and 
submit it for a hierarchical approval, skipping the review process.  

Users involved in reviewing a draft CO or approving a pending CO can record 
their decisions about proposed changes to the Contract on-line, using the 
Review/Approve window.  Reviewers/Approvers receive an In-Box message 
from the author requesting an action, review or approval for the CO.  The In-Box 
message specifies the Contract and change order number. 

All change orders on a contract must be either Approved or Denied in order for 
the Physical Work Complete Date to be entered by Headquarters Finance as part 
of the Contract completion process.  (Change Orders may not be in a Draft or 
Pending status for the Contract completion process.)   

A CO can be kept in 
Draft and sent for 
review only or changed 
to Pending and sent for 
approval without a 
review. 

All COs must be 
approved or denied 
before Contract 
Completion can occur. 

A CO must be 
approved to report 
CO items installed 
in DWRs. 
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4. Tracking the Change Order 

At any time, the writer of the CO may view the status of a change order in the 
review or approval cycle by opening the Tracking window.  The Tracking 
window for a CO is a view-only window and displays: 

• The date a request for recommendation was sent to a reviewer or 
approver 

• The reviewer or approver’s name 

• The action requested - review or approve 

• The date the reviewer or approver makes a recommendation 

• The recommendation - Approved or Denied 

• Any Remarks the reviewer or approver has made 

Authorized users may also display details about current and historic Contract 
items on-line using the Item Summary window. 

5. Reports 

Once approved, change order data may be analyzed to help manage the change 
order process.  The Change Order Reports function allows users to produce 
reports that gather information about trends in Contract changes.   

In TDOT, a paper copy of the change order is still required for physical 
signatures.  SiteManager reflects electronic version. 

When an approver physically signs the Change Order, that approver 
should also indicate their approval of the Change Order in SiteManager. 
The Headquarters Finance Office will indicate approval of the Change 
Order on behalf of all applicable Headquarters approvers. 
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Change Order Conditions 

There are three conditions that affect how the Change Order process in 
SiteManager works.  These are the: 

• Type of Contract 

• Function(s) associated with the change order 

• Status of the change order 

Change Order Functions 

There are six types of change orders: 

• Overrun/Underrun 

• Extra Work 

• Time Adjustment 

• Zero Dollar 
• Force Account – TDOT will not use this function.  Force Account COs 

are “Extra Work” in TDOT. 

A change order may be a combination of types except for a Final Quantity CO, a 
singular change order required for contract completion, or a Zero Dollar. 

Users define the purpose of the change order by selecting among the different 
functions.  Except for Final Quantity and Zero Dollar, users can specify more 
than one function to make up a change order.  The functions available on a 
change order are: 

Overruns or Underruns:  Used when the quantities associated with the Contract 
items are either exceeded or not needed to complete the Contract or work item. 
Extra Work:  Used when additional work items are required to complete the 
Contract. 
Time Adjustments:  Used when the time frames need to be adjusted to reflect 
the completion period for a milestone or Contract. 
Zero Dollar:  Used only for contract adjustments that will not affect the dollar 
amount of the Contract (for example, changing the location of a project). 
Force Account:  TDOT will not use this function. Force Account COs will 
require the “Extra Work” function to be selected. 
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Change Order Status  

The CO Status field displays the current status of the change order in the creation, 
review, and approval process.  The change order Status types are: 

Draft:  A change order is Draft status while it is being created, edited, or 
forwarded for review. 

Pending:  A change order is changed to Pending status when it needs to be 
submitted for the approval process.  While in Pending status, the change order 
cannot be modified except for its status. 

Denied:  Changing the status to Denied causes it to become inquiry-only for the 
life of the contract.  The Denied status is not available until the Change Order has 
been placed in Pending status. 

A change order in Pending status (under review) that received a recommendation of 
‘Denied’ may have its status changed back to Draft. With a Draft status, the change 
order may be edited (revised), have its status changed to Pending, and be resent 
through the approval process. 

Approved:  A change order is automatically placed in Approved status when the 
last approver completes the approval process – it is not a manual selection. When a 
change order has been approved by its final approval level, it cannot be altered.  
Adjustments can only be made by creating a new change order.   

All change orders must be in either Approved or Denied status for the contract 
completion process. 

In TDOT, if an approver selects “deny” in the review/approve window, the 
creator should change the status back to draft, make corrections, and 
change it to Pending in the Header window to submit it again. 

If an approver selects “denied” in the review/approve window and provides 
a remark indicating that the Change Order will never be approved and 
provides a reason, the creator should change the status of the Change Order 
to Denied in Header window. 

BEWARE:  A Change Order in Denied Status may not be changed to Draft. 

 

 

When the CO is 
approved it 
becomes read-
only and the 
items become 
available on 
DWRs.
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The TDOT Change Order Process  

In TDOT, all change orders will typically be created and maintained by the Office 
Staff.  There are three phases in the TDOT CO Process. They are as follows: 

Creation of a Change Order 
• Prepare any applicable paperwork  

• Create the change order on the Change Order Header window in SiteManager 

• Add item adjustments and/or new items to the change order on the Change 
Order Items window in SiteManager 

• Add time adjustments to the change order on the Change Order Time 
Adjustments window in SiteManager. 

• Add explanations to the change order on the Change Order Explanations 
window 

Maintaining & Reviewing a Change Order 
• Forward the change order for parallel review  

• Track the change order 

• Revise the change order as necessary 

• Generate applicable change order reports 

Change Order Approval Process 
• Change status to Pending 

• Forward the change order for approval 

• Track the change order 

• Change the Status to Draft to revise the change order as necessary 

• Generate applicable change order reports 

• Change the Status to Denied if an approver selects Denied on the Change 
Order review/approve window, provides a remark indicating that the Change 
Order will never be approved, and provides a reason for the never approving 
it. 
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Viewing the Item Summary Window 

The Contract Change Order Item Summary window allows users to view the 
details of an item on a change order, regardless of the status of the change order.  
The Item Summary window is a display-only window with two data windows.  
The top data window displays the selected change order item’s description as 
well as bid, current and pending contract item quantities and corresponding 
amounts.  The lower data window displays a list of the change orders associated 
with the selected change order item, including the quantity, dollar amount and the 
status of each change order. 

 
The Item Summary Window 

Figure 10-2 



Trns•port SiteManager® Learning Guide Viewing the Item Summary Window 
Section 10  Change Order Basics Post-Field Reporting for Inspector / Lead Inspector Staff 

 

 

236  

 Exercise 10-2 
In the following exercise, you will view the Item Summary window for Contract 
CNB022I.   

User ID: jj05751  Group: INSP Contract: CNB022I 

1. On the Change Order Maintenance panel, double-click the Item Summary 
icon. The Change Order Items Select list box appears. 

2. Click the Contract ID button.  
3. In the Contract ID list box, select Contract CNB022I. 
4. In the Change Order Items list box, double-click Item Nbr 0100. 
5. What is the adjustment to the item quantity for this change order? ________ 
6. Has this item been adjusted on any change orders for this contract? _______ 
7. Click the Open button. 
8. In the Change Order Items Select list box, double-click Item Nbr 9500. 
9. What is the adjustment to the item quantity for this item?   
10. To close the Item Summary window, click the Close button. 

 

-2888 

Yes 

2888 

Point out one 
item is being 
added to the 
contract to 
replace another. 
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Tracking Change Orders 

The status of a Change Order in the review or approval cycle can be monitored 
by opening the Tracking window at any time. The Tracking window for a CO is 
a view-only window and displays the following information: 

• The date a request for recommendation was sent to a reviewer or approver 

• The reviewer or approver’s name 

• The action requested - review or approve 

• The date the reviewer or approver made a recommendation 

• Τhe recommendation - Approved or Denied 

• Any Remarks the reviewer or approver has made 

Authorized users may also view details about current and historic contract items 
on-line using the Item Summary window. 

 

The Change Order Tracking Window 

Figure 10-3 
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 Exercise 10-3 
In the following exercise, you will view the tracking window for Change Order 002 
for Contract CNB022I.   

User ID: jj05751  Group: INSP Contract: CNB022I 

1. On the Change Order Maintenance panel, double-click the Tracking icon. 
2. Click the CO Tracking List folder tab. 
3. Who is the next person to approve the change order?    
4. To close the Tracking window, click the Close button. 

 

Jacobs, Lindsey 
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Viewing the Custom Change Order  

The custom Change Order is a custom TDOT document. 

 
The Change Order Parameters Window  

Figure 10-4 

 
The Change Order Window  

Figure 10-5 
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In TDOT, the custom Change Order will be used to gather signatures on a 
Change Order. 

When an approver physically signs the custom Change Order the approver 
should also indicate their approval of the Change Order in SiteManager.  
The Headquarter Finance Office will indicate approval of the Change Order 
in SiteManager on behalf of all applicable Headquarter approvers. 
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Viewing the Change Order Report 

The Change Order Report window can be utilized as a source of information for 
the review and/or approver of a change order.  This is a two-page report window 
that displays all other date included on a change order.  The second page displays 
only if there are Time Extensions associated with the change order selected for 
this report. 

 

The Change Order Report 

Figure 10-6 

 

The Standard Change Order Report is available in Standalone mode.  
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 Exercise 10-4 

In the following exercise, you will access and view the Change Order Report for 
Change Order 002 for Contract CNB022I.   

User ID: jj05751  Group: INSP Contract: CNB022I 

1. Click the Change Orders folder tab. 
2. On the Change Orders panel, double-click the Reports icon. 
3. Double-click the Change Order Report icon. 
4. Click OK to generate the report. 
5. What is the description for this change order? 

  
   

6. What is the Total Value of Change Order 002?  
   

7. To close the Change Order Report window, click the Close button. 

 

Substitution of a better material at same unit price

$0.00 
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Review for Section 10 

Contract Change Orders may include: 

• Quantity adjustments for existing items 

• Adding new items of work to the contract 

• Extra Work 

• Time Extension on milestones or revisions to a 
contract completion date   

To view the Item Summary window: 

1. On the Main Panel, double-click the 
Change Orders icon. 

2. On the Change Orders panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Item Summary icon. 

4. Open a Contract to view the change order 
item summary. 

5. When complete, click the Close button. 

To track the status of a change order: 

1. On the Main Panel, double-click the 
Change Orders icon. 

2. On the Change Orders panel, double-click 
the Change Order Maintenance icon. 

3. On the Change Order Maintenance panel, 
double-click the Tracking icon. 

4. Open a Change Order. 

5. When complete, click the Close button 

To view the change order report: 

1. Click the Change Orders folder tab. 

2. On the Change Orders panel, double-click 
the Reports icon. 

3. Double-click the Change Order Report 
icon. 

4. Using the right mouse button, click the 
Change Order field. 

5. In the Object menu, click Search. 

6. Click OK to generate the report. 
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Summary Exercise for Section 10 
In the following exercise, you will review a Change Order for Contract CNB022I. 

User ID: jj05751  Group: INSP Contract: CNB022I 

1. Navigate to the Change Order Report window. 

2. Generate the Change Order Report for Contract CNB022I, Change Order 001. 

3. What is the Change Order Type for this Change Order?    _________ 

4. Navigate to the Tracking window and view the approvers for Contract CNB022I, Change Order 
001. 

5. Who is the next approver for this Change Order?     _________ 

6. Exit SiteManager. 

Lindsey Jacobs 

Category 3 

Congratulations! You have completed the course. 


